# Contents

## Introduction

In this Guide

Accessing Products and Installation Instructions

Products Included with StarTeam Enterprise Licenses

Products Included with StarTeam Enterprise Advantage Licenses

Compilation Versions

Accessing Product Updates

Documentation

Contacting Micro Focus

## Installation Roadmap

Roadmap for Upgrading

Roadmap for StarTeam Cross-Platform Client

Roadmap for Server Administrators

## StarTeam Server for Microsoft Windows Installation

About StarTeam Server

StarTeam Server System Requirements

Operating Systems

Databases

Web Browsers

Third Party Software

StarTeam Server and Microsoft SQL Server Express on the Same Computer

StarTeam Server and Database on Different Computers

Database Server System Requirements

Large Memory Support

Unicode Character Sets

System Requirements for Linux

Pre-installation Requirements for a New Installation

Upgrading StarTeam

Preparing for an Upgrade

Overview of the Upgrade Process

Requirements for an Upgrade

Database Requirements for Upgrading

Upgrading Server Configurations

Changes to Server Files

Installing StarTeam Server

Post-Installation Tasks for a New Installation

Loading Server Configuration Sample Data

Post-Installation Tasks for an Upgrade

Apache Tomcat and Search

Evaluating StarTeam Server

Licensing StarTeam Server

Understanding Licensing

Using StarTeam Licensing

Using a License Server

Uninstalling StarTeam Server on Microsoft Windows

## StarTeam Server for Linux Installation

System Requirements for Linux

Pre-Installation Setup

Installing StarTeam Server on Linux

Server Administration for Linux
StarTeam Web Server Installation and Configuration ...................................56
  MPX for Microsoft Windows Installation ..........................................................37
  About MPX ...........................................................................................................37
  MPX Components ................................................................................................37
  Generating Transmitter XML Files ......................................................................38
  MPX System Requirements ..................................................................................39
  MPX Message Broker and MPX Cache Agent Installation ..................................40
  MPX for Linux Installation ..................................................................................44
  Installing Message Broker on Linux ....................................................................44
  Installing an MPX Cache Agent on Linux ..............................................................45
  Dependencies - Startup Order for MPX Components ..........................................46
  Requirements When Using StarTeamMPX and ActiveMQ MPX Together ................47
  Requirements When Using ActiveMQ MPX Only ....................................................47
  Configuring MPX to use ActiveMQ MPX ..............................................................47
  Configure MPX to use StarTeamMPX .................................................................48

StarTeam Cross-Platform Client Installation ......................................................50
  StarTeam Cross-Platform Client System Requirements .......................................50
  Before Installing the StarTeam Cross-Platform Client ...........................................51
  Setting up Default Personal Options .....................................................................51
  Installing the StarTeam Cross-Platform Client ......................................................51
  Installing the StarTeam Cross-Platform Client on Microsoft Windows .................52
  Installing the StarTeam Cross-Platform Client on Linux or Solaris ......................52
  Automating Client Installations ............................................................................53
  Performing a Silent Install ....................................................................................53
  Additional Customization .....................................................................................54
  Uninstalling the StarTeam Cross-Platform Client on Microsoft Windows ..............54
  Installing StarTeam Integrations ..........................................................................54

StarTeam Web Server Installation and Configuration ..........................................56
  StarTeam Web Server System Requirements .........................................................56
  StarTeam Web Client System Requirements ........................................................56
  Performance and Scalability ..................................................................................56
  Dependencies - Startup Order for MPX Components ............................................57
  Installing the StarTeam Web Server .......................................................................57
  Logging on to the StarTeam Web Server ...............................................................58
  Changing the StarTeam Web Server Administrator User Name and Password .........58
  Configuring Component Access ..........................................................................59
  Adding a StarTeam Server Configuration to the StarTeam Web Server ..................59
  Removing a StarTeam Server Configuration from the StarTeam Web Server ..........60
  Setting Up the StarTeam Web Server as a Microsoft Windows Service ..................60
  setenv.bat ...........................................................................................................61
  StarTeamService.bat ..........................................................................................62
  service.bat .........................................................................................................62
  Tomcat5w.exe ....................................................................................................63
  Tomcat5.exe .....................................................................................................63
  Enabling SSL Using a Valid Certificate .................................................................66
  Changing the Memory Allocated to the StarTeam Web Server ..............................67
  Setting the Log Output Level ...............................................................................67
  Running Apache Tomcat Native ..........................................................................67
  Specifying Item Details for the StarTeam Web Client .........................................68
  Creating a Custom Details Template .....................................................................68
  Accessing the StarTeam Web Client ....................................................................69

StarTeam Layout Designer Installation ...............................................................70
  StarTeam Layout Designer System Requirements ...............................................70
Introduction

Provides an overview of the StarTeam product installation.

Included in this Guide

This release provides updates to the StarTeam Cross-Platform Client, StarTeam Web Client, StarTeam Server, and Command Lines, and many other components. Refer to the appropriate release notes for details on What's New for each component.

Although in some cases, you may be installing products from a previous release, this document provides installation instructions for the following components:

- StarTeam Server (for Windows and Linux).
- (for Windows and Linux) including:
  - Event and File Transmitters (installed with the Server).
  - Message Broker.
  - Cache Agent.
- StarTeam Cross-Platform Client.
- StarTeam Web Server.
- Layout Designer.
- Workflow Extensions including:
  - Extensions.
  - Workflow Designer.
  - Notification Agent.

In addition, this manual covers:

- Database configuration for Microsoft SQL Server and Oracle.
- Upgrading server configurations.
- Supporting software installation and configuration.
- Data locations.

Accessing Products and Installation Instructions

The following sections provide a summary of StarTeam products, where you can get them, and where you can find the installation instructions for them.

Products Included with StarTeam Enterprise Licenses

The following provides a summary of StarTeam products that come with the StarTeam Enterprise license. The installation instructions for some products are not in this consolidated installation guide, but are located in the respective guide of that product and are noted.

**StarTeam Server**

A StarTeam Server stores artifacts (files, change requests/defects, tasks, and topics) for StarTeam clients. A server can support one or more server configurations on the same computer. Install StarTeam Server on a computer that is accessible to all users.
MPX Message Broker

Pushes information from the StarTeam Server to its clients. Usually an administrator sets up a cloud of Message Brokers to improve server performance for users in diverse geographic locations. One (sometimes two) root Message Brokers are set up for the server, usually on the same computer or in a network-near location. For Express, MPX is probably not needed.

StarTeam Cross-Platform Client

The StarTeam Cross-Platform Client is the most used client and provides users with access to all of the artifacts on the server. The Cross-Platform Client is a pure Java client that provides support of operating systems where a compatible JRE or JDK are available. As such, Cross-Platform Client is available for the Microsoft Windows, Solaris, and Linux operating systems.

For version 13.0, this is translated into English, French, German, Portuguese, Japanese, and simplified Chinese.

StarTeam Visual Studio Plugin

The StarTeam Visual Studio Plugin provides the StarTeam software configuration management capabilities tightly integrated with the Microsoft Visual Studio development environment. Using this integration makes it possible for you to develop applications in the Microsoft Visual Studio environment while simultaneously using the version control, change request, topic, task, and requirement component assets of StarTeam. The integration brings StarTeam main menu commands, context menu commands, and an embedded StarTeam client (providing much of the same look-and-feel as the full-featured Cross-Platform Client) to the Microsoft Visual Studio development environment.

StarTeam Eclipse Plugin

StarTeam Edition for Eclipse allows you to share projects on StarTeam Server and projects in the Eclipse workspace, but it is much more than just a version control plug-in. This integration offers project teams a customizable solution providing requirements, task, and change management, defect tracking and threaded discussions tightly integrated within the Eclipse platform.

StarTeam Web Server and StarTeam Web Client

The StarTeam Web Server makes it possible for users to access the server from their browsers using the StarTeam Web Client. The StarTeam Web Client is an intuitive web-based interface that many simultaneous users can use to connect to one or more StarTeam Servers to access projects and manage items. This product contains a core feature set designed to meet the needs of users responsible for viewing, creating, and editing StarTeam change requests, requirements, tasks, and topics. Browsing files and a limited set of file operations are also available.

Note: You must have a StarTeam user license to use the Web Client.

LDAP Quickstart Manager

The StarTeam Server can provide password authentication via a directory service, such as LDAP Quickstart Manager (QSM) to add users to the server, along with their distinguished names (DN) (needed for authentication) and other user information.

Layout Designer

Use Layout Designer to create forms for artifacts, such as change requests. This allows you to put the most important properties on the first tab, etc. With the web client and an Enterprise Advantage server, a Layout Designer form works with workflow. This is not true of the StarTeam Cross-Platform Client where Layout Designer's use is only for form building.

This product is translated into English, French, German, and Japanese.

StarTeam SDK

The StarTeam SDK is cross-compiled so that it can be offered both as Java and .NET applications. The full SDK is used by developers to create additional applications that use the StarTeam Server.
Usually, the StarTeam SDK runtime is installed with clients automatically so it can be used by them to access the StarTeam Server. Occasionally, you may need to install the runtime.

For version 13.0, this is translated into English, French, German, Portuguese, Japanese, and simplified Chinese.

**StarTeam SCC Integration**

The StarTeam SCC Integration works with any application that uses the Microsoft Source Code Control (SCC) Application Programming Interface (API). This API, originally designed by Microsoft to allow applications to work with Microsoft Visual SourceSafe, enables you to perform version control operations, such as checking files in and out, using StarTeam as the SCC provider.

**StarTeam Quality Center Synchronizer**

This product is available with all licenses.

StarTeam Quality Center Synchronizer can ensure that the same data appears in Quality Center and a database used by StarTeam Server. The goal of the synchronization is to provide access to the latest information about defects, whether the defects are being processed from Quality Center or from StarTeam. You can use Quality Center to add defects, and you can use StarTeam to indicate that those defects have been fixed and vice versa. Team members do not need to be aware of where the defect was last processed. The latest data is available at all times, as long as the databases are synchronized frequently.

**StarTeam Microsoft Project Integration**

Available with all licenses.

The interaction of the StarTeam Microsoft Project Integration and Microsoft Project make the jobs of both project planners and team members easier. Project planners use Microsoft Project to list the tasks that workers must perform. After exporting the tasks to StarTeam, they can gather information about the work accomplished by each team member in StarTeam, rather than communicating individually with each team member.

**StarTeam Toolbar Utility**

The StarTeam Toolbar Utility (Toolbar) is a component of the StarTeam designed to make it easier for you to log on to multiple servers and to launch different programs. It automatically caches the user name and password used to log on to each StarTeam or Caliber server, reducing the number of times that you must enter your logon information. The Toolbar is initially populated with shortcuts for the tools of the StarTeam and Caliber products that are installed on your workstation. Because the Toolbar uses the standard Microsoft Windows program shortcut feature, you can easily add any other program as a tool.

**File Compare/Merge**

File Compare/Merge is a graphical compare/merge tool delivered with the StarTeam Cross-Platform Client. It enables you to compare a file dynamically with the file in the repository, and manually or automatically merge the content of the two files. File differences are highlighted in the File Compare/Merge panes using a configurable color scheme, and action buttons display in the highlighted areas to simplify the merging process.

**View Compare/Merge**

View Compare/Merge is a comprehensive tool for comparing and merging views available with the StarTeam Cross-Platform Client. There are two versions of View Compare/Merge:

- **Graphical** Provides interactive comparison and merging with per-item and per-folder interaction, allowing you to carefully control which items are compared and how each difference is resolved
- **Command-line** Enables batch/shell-directed sessions.
Products Included with StarTeam Enterprise Advantage Licenses

In addition to the products included with StarTeam Enterprise licenses, StarTeam Enterprise Advantage licenses also include the products listed below. The installation instructions for some products are not in this consolidated installation guide, but are located in the respective guide of that product.

**MPX Cache Agent**
A root MPX Cache Agent monitors the server's repository for file content and object properties. Via Message Broker, the data is pushed to remove MPX Cache Agents that are network-near to members of dispersed teams, improving the speed with which users access the data they need.

**StarTeam Extensions**
StarTeam Extensions enables clients to take advantage of workflow and custom toolbar applications. The StarTeam Extensions files must be checked into the StarFlow Extensions project on each server configuration. If there is no StarFlow Extensions project, you need to create one.

StarTeam Extensions also provides API documentation and samples.

**StarTeam Workflow Designer**
Use the StarTeam Workflow Designer to create workflows for specific artifact types (such as change requests/defects) per project or even per view.

**StarTeam Notification Agent**
The StarTeam Notification Agent runs on the same computer as the StarTeam Server (or on a network-near computer) so that it can monitor the server and send notifications set up in your workflow.

**Search**
Search allows users to perform ad hoc queries across servers and projects. The query results reflect the access rights of the user logged on to Search so information is shared across the organization without compromising security.

**Micro Focus Connect**
Micro Focus Connect synchronizes data between StarTeam Server and other repositories or clients.

**StarTeam Agile**
StarTeam Agile is an Agile project tracking tool allowing you to plan and track all of your releases and sprints. StarTeam Agile is “embedded” into StarTeam, so all of your Agile assets created in StarTeam Agile are within the same repository as all of your other development assets. This makes the agile developer very efficient as they are able to access their agile work items, defects, and source code for one consolidated view while providing project stakeholders with consistent reports and baselines detailing the status of all development activities.

**Datamart**
StarTeam Datamart is a complementary product to the StarTeam Server. StarTeam Datamart uses the StarTeam SDK to communicate with the StarTeam Server to create a reporting database that you can use with popular third party reporting applications such as Crystal Reports and Business Objects (reporting applications are not included with StarTeam Datamart). StarTeam Datamart extracts data from a StarTeam Server and places the data into a relational database, where reporting tools can access it. StarTeam Datamart can extract information from every project, every view in each project, every folder in each view, and every item in each folder, and labels, links, and history for each item. You can restrict extraction of data to a particular project and view or only extract certain tables.

Datamart stores the data in any StarTeam supported database. The product comes with both an Extractor (for an initial retrieval) and with a Synchronizer to update existing data sets.
TeamInspector* TeamInspector is a continuous integration build server and build inspection tool. It works with StarTeam, Subversion, Perforce, and ClearCase. It requires the use of a database: Microsoft SQL Server 2005 SP3, Oracle 10g Release 2 version 10.2.0.4, or Apache Derby 10.4.2.0 or later.

* Can be purchased separately and added to the Enterprise package.

Compilation Versions

The following table lists how the StarTeam executables can run. See each component's System Requirements to see what operating systems are supported.

Note: 32-bit StarTeam applications can also be installed and run on a 64-bit operating system.

<table>
<thead>
<tr>
<th>Application</th>
<th>32-bit</th>
<th>64-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>StarTeam Server</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MPX Message Broker</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MPX Cache Agent</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>StarTeam Cross-Platform Client</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>StarTeam Web Server</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>StarTeam Web Client</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>StarTeam LDAP Quickstart Manager</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>StarTeam Layout Designer</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>StarTeam SDK</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>StarTeam Workflow Designer</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>StarTeam Notification Agent</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Datamart</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>TeamInspector</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>StarTeam Visual Studio Plugin</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>StarTeam Eclipse Plugin</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Micro Focus Connect</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Accessing Product Updates

Product update patches are available for download from: http://supportline.microfocus.com.

Documentation

The documentation is your guide to using the product suite. StarTeam documentation is provided in several formats: online help, HTML, and Adobe PDF. Documentation is available from the Help menu within the product.

If you are using a Microsoft Windows system, you can locate documentation for the products by clicking Start > Programs > StarTeam > <Product> > Documentation. The Documentation menu lists all of the available documentation for the selected product.

You can also download documentation directly from: http://supportline.microfocus.com/productdoc.aspx.
HTML Documentation

Readme files can be found directly under the root installation directory (or on the root of the installation CD). For documentation available in other languages (Japanese, French, or German), the language-specific versions of the release notes are indicated with an appropriate _countrycode in the filename. For example, readme_ja.html contains release note information for the Japanese language. PDF manuals are located in the Documentation subfolder on the product CDs.

Adobe PDF Manuals

The following documentation is provided in Adobe PDF format. All manuals distributed in Adobe Acrobat (.PDF) format require Adobe Acrobat Reader to display them. The installation program for Adobe Acrobat Reader is available from the Adobe web site at: www.adobe.com.

<table>
<thead>
<tr>
<th>Release Notes</th>
<th>Contains system requirements and supported platforms for the products.</th>
</tr>
</thead>
<tbody>
<tr>
<td>StarTeam Installation Guide</td>
<td>The StarTeam Installation Guide contains detailed instructions for installing and configuring the core StarTeam products.</td>
</tr>
<tr>
<td>StarTeam Server Help</td>
<td>This manual is identical to the online help version.</td>
</tr>
<tr>
<td>StarTeam Cross-Platform Client Help</td>
<td>This manual is identical to the online help version.</td>
</tr>
<tr>
<td>StarTeam Command Line Tools Help</td>
<td>Explains how to use the command-line tools and provides a reference for the various commands.</td>
</tr>
<tr>
<td>StarTeam File Compare/Merge Help</td>
<td>This manual is identical to the online help version of the StarTeam File Compare/Merge help.</td>
</tr>
<tr>
<td>StarTeam Workflow Extensions User’s Guide</td>
<td>Explains how to design and manage StarTeam Extensions such as alternate property editors (APEs). It also covers the StarTeam Workflow Designer and StarTeam Notification Agent.</td>
</tr>
<tr>
<td>StarTeamMPX Administrator’s Guide</td>
<td>Explains the basic operation and architecture of the system, and presents instructions on installing and configuring the components.</td>
</tr>
<tr>
<td>ActiveMQ MPX Administrator’s Guide</td>
<td>Explains the basic operation and architecture of the system, and presents instructions on installing and configuring the components.</td>
</tr>
</tbody>
</table>

Note: Depending upon which products you purchased and installed, not all of the application manuals will be on your system.

Contacting Micro Focus

Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus provides worldwide support, delivering timely, reliable service to ensure every customer’s business success.

All customers who are under a maintenance and support contract, as well as prospective customers who are evaluating products, are eligible for customer support. Our highly trained staff respond to your requests as quickly and professionally as possible.

Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus SupportLine to resolve your issues, or email supportline@microfocus.com.

Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access to other support information. First time users may be required to register to the site.
Installation Roadmap

Depending on your role, experience with the product, and what products you are installing, use the appropriate section below as a guide for the installation process you need to follow.

Roadmap for Upgrading

If you are an existing user, please note that some products have special upgrade considerations and instructions:

- StarTeam Server.
- MPX, specifically the MPX Cache Agent.

For these products, go to the various chapters in this manual for each product to review upgrading instructions:

<table>
<thead>
<tr>
<th>Product</th>
<th>Install on System</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>StarTeam Server</td>
<td>The computer to be used as the server. This computer must be accessible to all clients.</td>
<td>StarTeam Server for Windows Installation</td>
</tr>
<tr>
<td>MPX Cache Agent</td>
<td>See Installing a Cache Agent.</td>
<td></td>
</tr>
</tbody>
</table>

Roadmap for StarTeam Cross-Platform Client

For information about installing the StarTeam Cross-Platform Client, see StarTeam Cross-Platform Client Installation.

Roadmap for Server Administrators

If you are the administrator for StarTeam or perhaps the IT Administrator, you install these products on the systems indicated below:

<table>
<thead>
<tr>
<th>Product</th>
<th>Install on System</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>StarTeam Server</td>
<td>The computer to be used as the server. This computer must be accessible to all clients.</td>
<td>StarTeam Server for Windows Installation</td>
</tr>
<tr>
<td>ActiveMQ MPX or StarTeamMPX</td>
<td>One Message Broker serves as the root Message Broker on the same computer as the StarTeam Server or on a computer network near to it. Some user use dual root Message Brokers. Also, remote Message Brokers are installed on computers in various locations.</td>
<td>Installing the Message Broker.</td>
</tr>
</tbody>
</table>

Note: Starting with version 15, you can choose to use either the ActiveMQ MPX or StarTeamMPX Message Broker.
<table>
<thead>
<tr>
<th>Product</th>
<th>Install on System</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPX Cache Agent</td>
<td>One MPX Cache Agent serves as the root MPX Cache Agent on the same computer as the StarTeam Server or on a computer network near to it. Also, MPX Cache Agent Brokers are installed on computers in various locations, usually in each major geographic location and on the same computer as the Message Broker.</td>
<td>Installing a Cache Agent.</td>
</tr>
<tr>
<td>StarTeam Notification Agent</td>
<td>Usually on the same computer as the StarTeam Server.</td>
<td>Installing the Notification Agent.</td>
</tr>
<tr>
<td>StarTeam Workflow Designer</td>
<td>StarTeam administrator's computer.</td>
<td>Installing Extensions.</td>
</tr>
<tr>
<td>StarTeam Extensions</td>
<td>StarTeam administrator's computer.</td>
<td>Installing the Layout Designer.</td>
</tr>
<tr>
<td>LDAP Quickstart Manager</td>
<td>StarTeam administrator’s computer.</td>
<td></td>
</tr>
</tbody>
</table>

You can download the latest patches to these products from [http://supportline.microfocus.com](http://supportline.microfocus.com).
StarTeam Server for Microsoft Windows Installation

This chapter explains how to install the StarTeam Server. It also covers the preparations that should be made before the installation and the steps you need to take after the installation, particularly if you are upgrading from an earlier release of StarTeam Server.

• If you are evaluating the product for adoption or installing the product for first use on site, you should read **Pre-installation Requirements for a New Installation**.

• If you are upgrading from an earlier version of the product to a new release, you need to read all of this chapter. After the installation, you must upgrade each server configuration. See **Upgrading StarTeam**.

About StarTeam Server

StarTeam Server is a powerful tool that supports distributed development teams and mobile team members. It supports data in all languages that can be encoded in UTF-8. You can access the data managed by the StarTeam Server using a variety of clients. The primary client is the StarTeam Cross-Platform Client which can be installed on a variety of platforms.

Other clients use other means to access the server. For example, the StarTeam Web Client can access the server through supported browsers.

Access to the StarTeam Server can be local or remote—by way of the Internet, intranet, WAN, or a dial-up connection. Built-in encryption enables you to work securely over public networks such as the Internet. Normally, you install the StarTeam Server on a computer accessible to all team members. You then install StarTeam clients on team members’ workstations. To learn to use the StarTeam Server, refer to the extensive online help.

StarTeam Server System Requirements

We recommend installing the StarTeam Server on a dedicated application server and installing the database on a separate server unless you are using a supported version of Microsoft SQL Server Express as your database.

**Important**: You must uninstall the previous version before installing the current version of the software. You should also delete the following folders if they exist:

```
<Server Installation folder>\Apache Webserver Installation Folder>\webapps\search
<Server Installation folder>\Apache Webserver Installation Folder>\apache-tomcat-7.0.47\webapps\ConnectWeb
<Server Installation folder>\Apache Webserver Installation Folder>\webapps\borland
```

There should be a dedicated connection between the computers running the StarTeam Server and the database management system. For optimal performance, both machines should be on the same physical switch.

The following shows the minimum and recommended hardware for the computer on which you deploy the Server application and database. Although specific processor speeds are listed, you should always use the fastest available CPU to maximum performance.

**Note**: The StarTeam Cross-Platform Client only supports StarTeam Server versions 12.0+. 


**Important:** If you are upgrading from a previous version of StarTeam Server, you must review the upgrade instructions in the *StarTeam Installation Guide*. There are some steps that you must complete in order for the upgrade to complete successfully. Failure to complete these steps can cause the upgrade to fail.

**Operating Systems**

- Microsoft Windows Server 2012 R2 (64-bit)
- Microsoft Windows Server 2012 (64-bit)
- Microsoft Windows Server 2008 (32- and 64-bit)
- Microsoft Windows Server 2008 R2 (64-bit)
- Red Hat Enterprise Linux 6.7 (32- and 64-bit)
- Red Hat Enterprise Linux 5.5 (32-bit)
- SUSE Linux 11.3 (32- and 64-bit)

**Note:** You cannot install a 64-bit Microsoft Windows StarTeam component on a 32-bit Microsoft Windows system. The installer will return an error.

**StarTeam Server for 32-bit Microsoft Windows Operating Systems**

Due to the memory limitation on the 32-bit Microsoft Windows operating system, it is recommended that ActiveMQ MPX Message Broker be installed on a different server than the StarTeam Server with Search. We also recommend that the database engine used by the StarTeam Server is on a different computer than the StarTeam Server.

**StarTeam Server for 64-bit Microsoft Windows Operating Systems**

The minimum memory requirement for StarTeam Server and ActiveMQ MPX Message Broker is 8 GB without the database engine installed on same server. The minimum requirement for StarTeam Server with ActiveMQ MPX Message Broker and database engine installed on the same computer is 16 GB.

**Databases**

StarTeam Server supports both 32-bit and 64-bit databases. The following databases have been tested and are supported:

- Microsoft SQL Server 2014
- Microsoft SQL Server 2012 Express
- Microsoft SQL Server 2012 SP1
- Microsoft SQL Server 2008 Express R2
- Microsoft SQL Server 2008 Express
- Microsoft SQL Server 2008 R2 SP2
- Microsoft SQL Server 2008 SP3
- Oracle Database 12c version 12.1.0.2.0
- Oracle Database 11g R2
- Oracle Database 11g version 11.1.0.6 (32-bit)
- Oracle Database 10g R2 version 10.2.0.4 (32-bit)
- PostgreSQL 9.3

**Note:** You can install PostgreSQL as part of the StarTeam Server installation. You must purchase the other database products from the appropriate vendor. Refer to the *StarTeam Installation Guide* for more information about recommended system configurations for running StarTeam and your database on the same computer and for running StarTeam Server and its associated database on separate computers.
Important: Never modify database contents or vault files other than through a StarTeam client or the Server Administration Tool. Direct database manipulation is unsupported.

Database User and Password
The PostgreSQL database server installed by default with StarTeam Server has two default users created:

- Admin user = postgres
- Superuser = Borland_Login

The password for both is Borland_123.

When you use the default PostgreSQL database, you will be asked for a System Password. It is the same as the Admin user password, Borland_123.

Web Browsers
- Internet Explorer 8 or later
- Firefox 4 or later

Third Party Software
Please ensure these other software requirements are met:

JRE
The StarTeam Server uses the Java Runtime Environment (JRE) 1.8.0_51 which is automatically installed at C:\Program Files\Micro Focus\StarTeam Server <version>\jre.

Adobe Acrobat
Required for viewing the documentation in PDF format.

Virus Scanning Utilities
Every StarTeam Server computer should be equipped with a virus protection utility that has up-to-date virus definition files. All StarTeam Servers should also be equipped with up-to-date virus protection and the settings should be set to alert only the administrator. The StarTeam administrator should halt the StarTeam Server immediately upon virus detection, perform a full backup, and then follow the instructions provided by the virus protection vendor for cleaning the virus from the infected file. If the infected file cannot be cleaned or if problems exist, contact http://supportline.microfocus.com before restarting the StarTeam Server. Some viruses can be immediately destructive to the repository and in rare cases data loss will be inevitable. We strongly recommend that you perform regular backups.

A virus that might be a nuisance to a file system can be far more destructive when checked into the repository. For example, many virus protection utilities are set by default or can be set to delete infected files. If an archive file is deleted by the virus protection utility, data may be lost.

Another example is that a virus may not be detected in the archive and may sit dormant waiting to infect the computers of all project users. Your network will rapidly spread the virus and a data loss could occur.

Note: If any process or program such as anti-virus software alters files under StarTeam control the system could behave erratically. It is highly recommended that these processes not be allowed to modify system or data files under StarTeam control.
StarTeam Server and Microsoft SQL Server Express on the Same Computer

When Microsoft SQL Server Express is used, the database typically resides on the same computer as the corresponding StarTeam Server application. The following hardware recommendations for a joint StarTeam Server/Microsoft SQL Server Express computer are based on the number of seats (registered users). However, your situation might vary depending on the size of your StarTeam projects and the number of projects managed by the StarTeam Server configuration.

The following lists suggested system configuration requirements if you are using Microsoft SQL Server Express and the StarTeam Server on the same computer:

<table>
<thead>
<tr>
<th>Less than 50 Seats</th>
<th>32-bit dual core machine with 4 GB of RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>50-100 Seats</td>
<td>32-bit quad core machine with 4-8 GB of RAM</td>
</tr>
</tbody>
</table>

*Note: Microsoft SQL Server Express is not recommended for configurations serving more than 100 registered users.*

StarTeam Server and Database on Different Computers

The following hardware recommendations apply when the StarTeam Server application is executing on a different computer than the database server. They are based on the number of peak users (maximum concurrent users during peak periods). However, your situation might vary depending on the size of your StarTeam projects and the number of projects managed by the server configuration.

**Number of Peak Users**

| Less than 100 | 32-bit, dual-core systems with 4 GB of memory |
| 100 - 200     | 32-bit, quad-core systems with 4-8 GB of memory |
| More than 200 | 64-bit, quad-core systems with 8-16 GB of memory |

Database Server System Requirements

The following recommendations apply to the database server when it is not on the same computer as the StarTeam Server. The number of peak users is the maximum number of concurrent users during peak usage periods.

**Number of Peak Users**

| Less than 100 | Computer with a dual core processor and 4 GB of RAM |
| 100-200       | Minimum Computer with quad processors and 4 GB of RAM  |
|               | Recommended Minimum configuration plus RAID system |
| More than 200 | Minimum Any high-performance Enterprise Server with quad processors and 4-8 GB of RAM |
|               | Recommended Minimum configuration plus RAID system |

Large Memory Support

On 32-bit Microsoft Windows systems, you can use 4 GB RAM tuning to enable the StarTeam Server application to utilize 3 GB of memory. To enable this feature, you must add the /3GB switch to the

On 32-bit Microsoft Windows, you should also be aware of the maximum page file size, which can affect memory allocation when multiple applications are run on the same computer. See: [http://support.microsoft.com/kb/237740](http://support.microsoft.com/kb/237740).

You should also be aware of **Page Table Entry (PTE)** limitations when the /3GB switch is used. Refer to [http://support.microsoft.com/default.aspx?scid=kb;EN-US;311901](http://support.microsoft.com/default.aspx?scid=kb;EN-US;311901).

### Unicode Character Sets

While StarTeam Server supports data in all languages that can be encoded in UTF-8, it only uses ASCII characters (0-127) as it expands keywords. Keyword expansion and EOL conversion should work for all “ASCII-based” encodings, which include UTF-8, Cp1252, and so on. For the various UTF-16 encodings, StarTeam Server currently performs EOL conversion, but does not expand keywords.

The internal names of custom fields must be ASCII, but the display names can be in non-English character sets.

### System Requirements for Linux

- Red Hat Enterprise Linux 5.5 (32-bit)
  - **Note:** Advanced platform storage, virtualization, and high availability features (Red Hat Global File System & Cluster Suite) are not supported.
- Linux Suse 11.3 (32-bit)
- JDK or Java Runtime Environment (JRE) 1.8.0_51+
- Oracle Client 11g R2
- Oracle Client 11g version 11.1.0.6 (32-bit)
- Oracle Client 10g R2 version 10.2.0.4 (32-bit)
- PostgreSQL version 9.3
  - **Note:** The Oracle database does not have to reside on the same machine as the StarTeam Server.

### Pre-installation Requirements for a New Installation

Before you install StarTeam Server:

1. Make sure your computer system meets the minimum requirements. See the **System Requirements** section.
2. You must be a local administrator on the target computer to install StarTeam Server and other StarTeam products. Also, the local settings for the administrator account performing the install must be stored on the target computer. StarTeam Server and StarTeam clients will not operate correctly if the local settings are stored on a network drive.
3. You must set video settings on the computer on which you install StarTeam Server to 256 colors or higher.
4. Unless you plan to use only PostgreSQL, which is the default database for server configurations, you must install the database management system you plan to use with StarTeam Server. It is normal to install the database server on another computer. Make sure your computer system meets the minimum requirements for the database product. Refer to the documentation supplied with your database management system for more information. See **Database Server System Requirements** for more information about supported databases.
**Note:** There should be a dedicated connection between the computers running StarTeam Server and the database management system. For optimal performance, both computers should be on the same physical switch.

5. Install the database client on the same computer as StarTeam Server.

6. Because StarTeam Server can be used with any UTF-8 character set, the code page settings for the databases can be very important. Information about this can be found in the chapter on creating a server configuration for your database type:
   - For Microsoft SQL Server and Microsoft SQL Server Express databases, see *Using StarTeam with Microsoft SQL Server and SQL Server Express Databases*.
   - For Oracle databases, see *Database Character Set and StarTeam Server*.
   - For PostgreSQL, see *Using StarTeam with PostgreSQL*.

### Upgrading StarTeam

If you have used previous releases of StarTeam Server, you must upgrade each of your server configurations after installing the new release. The upgrade process varies depending upon:

- Which database you are using.
- Which previous release of StarTeam Server you are using.

To determine if a patch is required before you upgrade, contact Micro Focus Technical Support at: [http://support.microfocus.com](http://support.microfocus.com).

### Preparing for an Upgrade

Before upgrading, you should do the following:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perform test upgrades</strong></td>
<td>We strongly recommend running test upgrades against copies of current production databases.</td>
</tr>
<tr>
<td><strong>Create an upgrade schedule.</strong></td>
<td>Plan your StarTeam Server upgrade when it will inconvenience the smallest number of users. A StarTeam Server configuration cannot be running during some of the steps you take before and during the upgrade. You may want to plan the StarTeam Server upgrade at the end of the workday or perhaps on a weekend. If you have a large repository or a slow system, the upgrade process could be time consuming. Depending on the size of your database, you might need to schedule a couple of down-times for the upgrade. For example, you might schedule one weekend for upgrading the StarTeam Server and another for upgrading the database. Make backups before and after each of these steps to prevent loss of data.</td>
</tr>
<tr>
<td><strong>Backup the server configuration</strong></td>
<td>Advise your team ahead of time that you plan to make this transition during a specified period of time, and advise them when they will need to have the latest version of a StarTeam client installed. Unless specifically stated, StarTeam clients for a given release work with that StarTeam Server release, one release back, and one release forward. When an older client works with a newer StarTeam Server, the client cannot access new features. For example, the older client cannot display any new menu commands.</td>
</tr>
</tbody>
</table>

### Overview of the Upgrade Process

You can upgrade to the latest version of StarTeam Server only from StarTeam Server 2009 R2+. If you are on an earlier release, take the steps necessary to upgrade from that release to StarTeam Server 2009 R2.
1. Back up your StarTeam repositories and other server files.
2. If necessary, upgrade or migrate your database to a version supported by StarTeam Server <latest version>.
3. Install StarTeam Server <latest version>.

Requirements for an Upgrade

This section describes the steps that you follow to upgrade to the latest version of StarTeam Server, elaborating on the table provided in Overview of the Upgrade Process and providing references to related sections for more detailed information.

Before upgrading to the latest version of StarTeam Server, you need to:

1. Review the pre-installation issues for a new installation to determine whether any of them apply to you.
2. You can upgrade to the latest version of StarTeam Server only from StarTeam Server 2009 R2+. If you are on an earlier release, take the steps necessary to upgrade from that release to StarTeam Server 2009 R2. See the appropriate installation guides for details. Be sure to also install the latest patches. You can find information about the latest patches at http://supportline.microfocus.com.
3. Back up your StarTeam repositories and other server files. See the documentation for the release of StarTeam Server that you currently have installed for information about what to back up.
4. You cannot install StarTeam Server while server configurations are running. Therefore, you must perform one of the following procedures.
   
   **To shut down a StarTeam Server configuration that is not running as a Microsoft Windows service:**
   1. Open the Server Administration tool, by selecting Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
   2. Select the server configuration, and choose Actions > Shut Down Server. After you confirm that you want to shut down the server, the Status icon changes from Running to Stopping to Ready.

   **If your StarTeam Server configurations run as Microsoft Windows services, you must stop those services and change the StarTeam execution mode:**
   2. Locate the Server configuration and click Stop.
   3. After the service stops, close the Services dialog box and the Control Panel.
   4. Stop the server configuration from being run as a service. For example, in Server 2009 R2, start the Server Administration tool by selecting Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
   5. Select the server configuration, and choose Actions > Set to Run as Service. This menu command changes from checked to unchecked, indicating that the server configuration is no longer running as a service. The server configuration’s icon also changes.

5. Install StarTeam Server <latest version> on the same computer as the version of Server that you are upgrading from.
6. If necessary, upgrade or migrate your database to a version supported by Server latest version. For more information, see Database Requirements for Upgrading.

**Note:** Performing the StarTeam Server installation and the database upgrade in different sessions, such as different weekends, allows you to isolate any problems to one step or the other. If your database version is not one that is supported by the latest version of StarTeam Server, perform the database migration prior to installing the latest version of StarTeam Server. If performing an
upgrade of both the StarTeam Server and the database, upgrade the database, install StarTeam Server, then upgrade or migrate your database to another database version.

7. Upgrade your server configurations. For more information, see Upgrading Server Configurations.

Database Requirements for Upgrading

If necessary, you must upgrade or migrate your database to a version supported by the new version of the StarTeam Server.

For more information about which databases are supported by StarTeam Server, see System Requirements for the Server.

Microsoft SQL Server Database Upgrade Paths

You should follow one of the upgrade paths listed below to upgrade your Microsoft SQL Server database. These are steps at a high level and you should familiarize yourself with the remaining upgrade and database requirements provided in this Installation Guide. You can also find more information about migrating server configurations and Microsoft SQL Server database backups in the Administration Tool Help.

Important: We strongly recommend that you perform a full backup of your database before upgrading or migrating to the new database. A full database backup creates a duplicate of the data that is in your existing database.

Migrating a Server Configuration

Use the Server Administration tool to migrate from a database to any other database support by the Server.

1. Open the Server Administration tool by clicking Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server.
2. In the list of servers, select the server you want to migrate.
3. Select Actions > Migrate from the main menu.
   - This migrates the repository to the database running a supported version of Microsoft SQL Server.
4. Start the Server by selecting Actions > Start Server from the main menu.
5. Click Server > Configuration Properties from the main menu to verify the server configuration database connection settings.
6. Upgrade to the new release of StarTeam.

Backing Up and Restoring a Database

1. Back up the database running on the old Microsoft SQL Server version and restore the copy onto the database running the new version of Microsoft SQL Server.
2. Open the Server Administration tool by clicking Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server.
3. In the list of servers, select the server you want to upgrade.
4. Click Server > Configuration Properties from the main menu and update the configuration settings to point to the new database connection on the server.
5. Start the Server by selecting Actions > Start Server from the main menu.
6. Upgrade to the new release of StarTeam.

Orphaned Users

When a database user for a corresponding Microsoft SQL Server Login is undefined or incorrectly defined, Microsoft SQL Server does not allow the user to log on to that instance. Such a user is said to be an orphaned user of the database instance. A database user can become orphaned if the corresponding Microsoft SQL Server user name is dropped. Most likely, a database user becomes orphaned after a
database is restored or attached to a different instance of Microsoft SQL Server. Orphans occur if the
database user is mapped to a security ID that is not present in the new server instance.

Use Microsoft SQL Server Management Studio or any other tool that executes SQL statements to address
all orphaned users before you start or upgrade the StarTeam Server configuration.

**Addressing Orphaned Users**

Use Microsoft SQL Server Management Studio or any other tool that executes SQL statements to address
all orphaned users before starting or upgrading the StarTeam Server configuration. Use either the system
administrator user name (sa) or windows authentication (under an administrative user account) to connect
to the database and change the database context for the SQL console to the StarTeam database.

To address all orphaned users:

1. Open a SQL console such as Microsoft SQL Server Management Studio or Enterprise Manager.
2. Open a new query.
3. Enter the following command to display the user names of all orphaned users:
   ```sql
   sp_change_users_login 'REPORT'.
   ```
4. Enter the following to address the orphaned database owner (dbo). The database user is always
   orphaned when changing servers:
   ```sql
   sp_addlogin User Name , Password
   go
   sp_changedbowner User Name
   go
   sp_defaultdb User Name , Database Name
   ```
   
   User Name is the appropriate user name, Password is the appropriate password for the StarTeam
   Server, and Database Name is the StarTeam Server Database.
5. For all other users who are returned as orphans, repeat the following commands for each of the
   orphaned users:
   ```sql
   sp_addlogin User Name, Password
   go
   EXEC sp_change_users_login 'Update_One', 'Orphaned User Name', 'New User
   Name'
   ```
   
   Where the Orphaned User Name is the orphaned user from the previous server and the New User
   Name is the new login created in the previous step.
6. Enter the following command: `sp_change_users_login 'REPORT'.` This command should not
   return any rows.

For more information, refer to the *Troubleshooting Orphaned Users* section in the Microsoft SQL Server
documentation.

**Granting Oracle Privileges**

If your StarTeam Server configuration uses an Oracle schema user that was not created automatically by
StarTeam Server, you should check it for all the privileges listed below. These privileges ensure that
StarTeam Server can create labels and perform other operations successfully and should be explicitly
defined rather than relegated to a role.

- Create procedure
- Create sequence
- Create session
- Create table
- Create trigger
- Create type
• Create view
• Unlimited tablespace
• Create any context
• Drop any context

The following procedure explains how to explicitly define Oracle privileges, using the Create type privilege as an example.

To explicitly define the Create type privilege:

1. Log on to the database as system user.
2. Execute the following SQL statement: 
   grant create type to schema_user, where
   schema_user is the name of the Oracle schema user.

### Setting Database Compatibility Level for Microsoft SQL Server 2008

Change the database compatibility level to 100 for all existing databases that will be upgraded from an earlier version of Microsoft SQL Server. All new configurations created against Microsoft SQL Server 2008 databases will have the correct value.

To set the database compatibility level:

1. Log on to the database instance.
2. Execute the command:
   
   ```
   sp_dbcmptlevel @dbname = name,@new_cmptlevel = version
   ```

   - `@dbname=name` Database name for which you are changing the compatibility level. Database names must conform to the identifier rules.
   - `@new_cmptlevel=version` Microsoft SQL Server version with which to make the database compatible. The value must be set to 100.

### Upgrading Server Configurations

After you install StarTeam Server, every existing server configuration must be upgraded.

1. Open the Server Administration tool by clicking Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server
2. Select the server configuration to be upgraded. Even if the status for the server configuration indicates Ready, the server configuration will not start successfully until you run the upgrade procedure.
3. Click the Upgrade Database toolbar button. A series of dialog boxes may open and close. At the completion of the process, a message indicates a successful upgrade operation. If an error occurs, a message displays the error information. The upgrade process creates a log file named DBUpgrade.locale.log in the server configuration's repository folder. For example, if the locale is the United States, the name of the file is DBUpgrade.en-US.log.

   **Note:** The upgrade process requires one database connection to run. If the upgrade process is unable to acquire a connection, it will fail.

Check the database connection information on the StarTeam Server computer. From the computer on which the server is installed:

1. Open the Server Administration tool.
2. Select the server configuration.
3. Click Server > Configuration Properties.
4. From the Properties dialog box, select the Database Connections tab.
5. Click Verify.

   Ensure that the database is running.
Changes to Server Files

The old `starteam-server-configs.xml` file is copied from the old StarTeam Server release's installation folder to the new release's installation folder. This ensures that all configurations running on the previous StarTeam Server release can access the new StarTeam Server release.

Installing StarTeam Server

Before you install the StarTeam Server, make sure you read *Pre-installation Requirements for a New Installation*. If you are upgrading from a previous release of StarTeam Server, make sure that you also read *Upgrading StarTeam*.

**Note**: StarTeam Server comes bundled with a root Message Broker and Micro Focus Connect. When installing the StarTeam Server, these tools will automatically be installed and configured.

1. Close all applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Select a language from the list, and then click **OK**.
5. On the **Introduction** page, read the information, and click **Next**.
6. On the **License Agreement** page, read the agreement. If you agree with the license agreement, click **I accept...**. If you do not accept the license agreement, you cannot install the product.
7. Click **Next**.
8. On the **Choose Install Set** page, choose either **Typical**, **Full**, or **Custom**.
   - **Typical** Installs StarTeam Server with the most common options. Recommended for most users.
   - **Full** Installs StarTeam Server with all required options.
   - **Custom** Enables you to choose the options you want to install.
9. For a custom installation only, select the options you want:
   - **StarTeam Server**
     If you use the custom installation to install something that was not installed during a previous installation of StarTeam Server, you may choose to uncheck this check box. For example, suppose that in a previous custom installation, you elected to bypass the installation of PostgreSQL. To add that database now without reinstalling all of the server program files, you would clear the **Server** check box.
   - **PostgreSQL**
     PostgreSQL is an open source relational database and is the default database.
   - **StarTeam Toolbar**
     Installs the StarTeam Toolbar which remembers passwords so that logging on is easier.
10. Click **Next**.
11. On the **Choose Install Folder** page, browse for the location to be used as the installation folder. The default location is `C:\Program Files\Micro Focus\StarTeam Server <version>`.
12. If you chose the PostgreSQL option, you will see the **PostgreSQL Configuration** page. Enter the **Database superuser password** and the **Port Number** and then click **Next**. The **Message Brokers** page opens.
13. Select which Message Broker that you want to install:
   - **Install ActiveMQ Message Broker**
   - **Install legacy Smart Sockets Message Broker**
   - Click **Next**.
The **Message Broker Options** page opens.

14. If this is the first time that the MPX Event Transmitter and MPX File Transmitter have been installed on this computer, use this page to make changes to the MPX profiles used by your StarTeam Server configurations. During the first install, the installer creates both MPX Event Transmitter and MPX File Transmitter template files using information about the message broker on this page. These files are stored in a subfolder of the installation folder named `EventServices`. The local host name and IP address are provided at the top of this page for reference purposes. By default, the Message Broker connection address uses your local computer's IP address.

To specify a different Message Broker for MPX Event Transmitter (and any clients that will use the default profile), change the proposed Message Broker connection address.

**Host name** The host name on which the Message Broker operates.

**IP address** The IP address on which the Message Broker operates.

**Port** The TCP/IP port number (endpoint) with which the Message Broker accepts connections:

- Default for ActiveMQ MPX is **61616**.
- Default for StarTeamMPX is **5101**.

**Important:** When installing to a computer that has more than one NIC or multiple IP addresses, do not accept the default server address settings. You must manually enter the correct server IP address. When the installer detects multiple network addresses on the host computer, it sets up default profiles that contain a `server-address` property whose syntax is invalid because it contains multiple addresses.

**Note:** You can enter the connection information for more than one Message Broker. In the event that the MPX Event Transmitter (or a client using the default profile) is unable to connect with the first Message Broker in the list, it will attempt to connect with the next Message Broker listed. Separate the address for each Message Broker with a comma (,). For example: tcp:HostA:61616,tcp:HostB:61616

15. Click **Next**.

16. On the **Choose Shortcut Folder** page, use the default setting (that is, keep the Other option button set to `C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus\StarTeam Server <version>`).

17. On the **Pre-installation Summary** page, review the settings and click **Previous** one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click **Next** or **Install**.

18. On the **Install Complete** page, click **Done**.

19. After you finish installing StarTeam Server, ensure that the permissions on the StarTeam Server installation folder and files are set correctly. The Microsoft Windows account for the StarTeam administrator must have full permissions on the installation folder and files. Set the Microsoft Windows permissions for all other StarTeam users in accordance with your company policy. See your network administrator if you need assistance. If you use the default location, installing StarTeam Server places files in the following folders under your `Program Files` folder:

- **Micro Focus\Server\<version>** This folder and its subfolders contains the executables, DLLs, and utilities used to run StarTeam Server. This folder also contains the `StarTeam_Server_<version>_InstallLog.log` file, which documents what happened during the installation process.

- **Micro Focus\Server\<version>\EventServices** This folder contains the MPX Event Transmitter and MPX File Transmitter template files. It has a subfolder for each existing server configuration. Inside those subfolders are the `MPXEventTransmitter.xml` and `FileTransmitter.xml` files that will be used by the server configurations. If you have an Enterprise server, you may want to delete the `FileTransmitterTemplate.xml` and
FileTransmitter.xml files. The file transmitter is part of Enterprise Advantage only.

Post-Installation Tasks for a New Installation

If you have not installed StarTeam Server previously, you must perform the following tasks before team members can begin using StarTeam.

1. Create a server configuration using the **Server Administration** tool. For details about creating a server configuration, see the chapter about your database type:
   - Using StarTeam with Microsoft SQL Server and SQL Server Express Databases.
   - Using StarTeam with Oracle Databases.
   - Using StarTeam with PostgreSQL.

   When you create a StarTeam Server configuration, you set values for the configuration’s session options, which are stored in the `starteam-server-configs.xml` file. Session options specify the core information that StarTeam Server requires to start a server configuration.

   **Note:** See [Loading Server Configuration Sample Data](#) to create a new sample configuration.

2. Log on to that configuration using the **Server Administration** tool. StarTeam Server comes with a free administrative user, named StarTeam Server Administrator. That user has the default logon name Administrator and the default password Administrator.

3. Configure the server using the **Server Administration** tool and, for some options, by editing the file `starteam-server-configs.xml`.

   After StarTeam Server configuration is created, you can set configuration options, which are stored in the database for the StarTeam Server configuration. Configuration options enable you to fine-tune StarTeam Server configuration performance and enable the use of several features, such as:
   - Email and audit features
   - Compression and encrypting of data that is transferred between the server and client workstations

4. Add users and groups using the **Server Administration** tool.

5. Create projects and views using the StarTeam Cross-Platform Client.

6. Set the appropriate access rights for the server configuration, projects, and views using the **Server Administration** tool and the StarTeam Cross-Platform Client.

7. If desired, you can run the server configuration as a Microsoft Windows service using the **Server Administration** tool.

Refer to the StarTeam Server Help for more information about creating and configuring a server configuration.

Loading Server Configuration Sample Data

1. Create a new server configuration.

2. To start the StarTeam Server, select the newly created configuration from the list of servers and click Actions > Start Server.

   **Tip:** The server configuration must be empty (no existing projects) in order to load the samples.

3. After the StarTeam Server has started and is running, select the server in the list of servers and click Actions > Load Samples.

4. Click Yes to load the sample data. You may be prompted to log on to the server. The Loading Samples dialog box displays showing the progress of the download. The download may take several minutes.
5. Users can now connect to this new server and access the sample data from within the StarTeam Cross-Platform Client. The sample data is installed in C:\Program Files\Micro Focus\StarTeam Server <version>\Samples.

Post-Installation Tasks for an Upgrade

If you are upgrading from a previous release of StarTeam Server, be aware of the following:

- You must upgrade all existing StarTeam Server configurations to use the latest release of StarTeam Server. For more information about upgrading server configurations, see Upgrading Server Configurations.
- If you use StarTeamMPX or ActiveMQ MPX, be sure to install the latest Message Broker and MPX Cache Agents. For more information, see MPX for Windows Installation.
- For more information about installation and upgrade instructions for StarTeam Workflow Extensions, see StarTeam Workflow Extensions Installation.

Apache Tomcat and Search

During the installation of the StarTeam Server, Apache Tomcat is installed. The default port number is 9090. If you need to change this value, you will also have to change a few configuration files to keep the services synchronized.

1. Open the Microsoft Windows Component Services window.
2. Stop the Starteam Search Web Service 15 service.
3. Navigate to the conf folder in the Apache Tomcat installation directory (C:\Program Files\Micro Focus\StarTeam Server <version #>\WebServer\conf).
4. Open server.xml for editing. Look for the following element:
   ```xml
   <Connector connectionTimeout="20000" port="9090" protocol="HTTP/1.1"
   redirectPort="8443"/>
   ```
5. Change port="9090" to the new value.
6. Save and close the file.
7. Open the starteam-server-configs.xml file found in C:\Program Files\Micro Focus\StarTeam Server <version #>.
8. For each configuration that uses search, locate the following item: RESTServicePort. If the option is not there, add it: <option name="RESTServicePort" value="9090"/>
9. Change the value from 9090 to the new value that will match the Apache Tomcat value.
10. Save the starteam-server-configs.xml.
11. Restart each server configuration.

Evaluating StarTeam Server

The first time you run StarTeam Server, an evaluation license is created for StarTeam Enterprise Advantage, which is StarTeam the edition of StarTeam with the largest feature set. Before the 30-day product review period expires, you can extend the evaluation period by contacting Micro Focus Sales for an extended evaluation key.

Be sure to register the product or extend the evaluation period before it expires. Otherwise, when clients access a server configuration managed by StarTeam Server, no components (such as the file or change request component) are available. For example, in the StarTeam Cross-Platform Client, the upper and lower panes have no tabs.
To extend the evaluation period for the StarTeam Server:

1. After you obtain an extended evaluation key, click **Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server**. The **Server Administration** tool opens.
2. Click **Help > About** from the menu bar. The **About StarTeam Server** dialog box opens.
3. Select **License** in the left pane of the dialog box.
4. Click **Extend Evaluation**. The **Extend Evaluation** dialog box opens.
5. Enter the evaluation key, and click **OK**.
6. Close the **About StarTeam Server** dialog box.

**Licensing StarTeam Server**

StarTeam Server can be run as an Express, Enterprise, or Enterprise Advantage server. Which server edition you have (or more explicitly, what features a client can access on that StarTeam Server) is determined by the product license.

**Understanding Licensing**

Licenses determine how many users can access StarTeam Server. Users can have either named user or concurrent licenses. A named user license can be used only by the user who has been assigned that license. For example, if you have 5 named user licenses, the 5 users who are assigned the named user licenses are guaranteed access to the StarTeam Server. No one else can use their licenses.

A concurrent license can be used by any user who does not have a named user license. For example, users without named user licenses receive concurrent licenses on a first-come, first-served basis. After all the concurrent licenses are in use, users attempting to log on are notified that there are no more licenses available at this time. They can try again later.

You can add as many users as you choose, but access to the server is granted only to users with named user licenses or to users who receive concurrent licenses as they log on.

💡 **Tip:** You can import user information from Active Directory or OpenLDAP and assign users to StarTeam license types or license server slips using LDAP QuickStart Manager. Refer to the **LDAP QuickStart Manager Administrator Guide** for more information.

The Server Administrator is automatically assigned a named user license which cannot be removed. This is a “free” license that is not counted against the number of named user licenses you have available.

⚠️ **Note:** The Server Administrator should not have a password that is verified by a directory service because, if you change the service, the administrator will be locked out.

StarTeam Server can be licensed in either of two ways:

- StarTeam licensing, also referred to as native licensing, which is internal to the product.
- License Server licensing (using either BLS or FLEXnet Server).

If you have StarTeam native named user licenses, you must assign them to specific users in the **User Manager** dialog box. Everyone else is assumed to have a StarTeam concurrent license. See the StarTeam Server online help for details.

If you have Borland License Server (BLS) or FLEXnet License Server, users must be assigned to the correct slip in the **User Manager** dialog box, regardless of their named or concurrent user status. An additional status, **Unassigned**, may be used instead of a slip.

**Using StarTeam Licensing**

If StarTeam users attempt to access a StarTeam Server configuration that is managed by an unlicensed version of StarTeam Server, the tabs in the upper and lower panes of their StarTeam clients will not display.
Customers buy named Enterprise, concurrent Enterprise, named Enterprise Advantage, or concurrent Enterprise Advantage licenses for StarTeam Server. Any client can access any StarTeam Server as long as that StarTeam Server recognizes the user and has a license for that user. Customers usually choose just one method of licensing, but combinations can be supported as long as they are all for the same StarTeam edition. Licensing is handled after the installation, either by setting up a licensing server and putting "slip" files in the StarTeam Server’s Licenses folder (a child of the StarTeam Server’s installation folder) or by registering StarTeam native licenses using the Server Administration tool.

Before entering StarTeam native licenses, you must delete the evaluation key. For StarTeam Enterprise and Enterprise Advantage, licenses are stackable as long as they are for the same edition of StarTeam. For example, when you first register your StarTeam Server, you might enter two serial numbers: one for named user licenses and another for concurrent licenses. For more information about licensing, see Understanding Licensing.

You can add more named users or concurrent licenses. StarTeam Server keeps track of the total number by summing the licenses supplied in each serial number or slip. This is referred to as stackable licensing.

Note:
- You cannot license StarTeam Server while any of its server configurations are running as a Microsoft Windows service.
- If you change the registered license while a StarTeam project is open on a user’s workstation, the licensing takes effect for that user by closing and reopening the project window.
- If you license StarTeam Server as Express or Enterprise after using an evaluation license which is for the Enterprise Advantage edition, the feature set changes. For example, if you created requirements during the evaluation and then license the StarTeam Server as anything other than Enterprise Advantage, the requirements tab disappears.

To license StarTeam Server from the Server Administration tool (native licensing):

1. Click Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
3. Select the License node in the left pane of the dialog box.
4. If you have yet to enter a license, you must delete the evaluation key by selecting it from the right pane of the dialog box and clicking Delete.
5. Click Register. The Server Registration dialog box opens.
6. Enter the correct numbers in the Serial Number and Access Key text boxes. Serial numbers are case sensitive; access keys are not.
7. Click OK.
8. Close the About StarTeam Server dialog box.

To license a version of StarTeam Server at the command prompt, enter the following: starteamserver - serial Number -access Key

Using a License Server

You can use Borland License Server (BLS) or FLEXnet License Server with the StarTeam Server. This gives you a choice between using a license server and using the StarTeam native licensing found in this and earlier releases.

Important: BLS should be added to the Microsoft Windows firewall exceptions (on the BLS server machine) when BLS is started as a Microsoft Windows service. Otherwise the StarTeam Server will be unable to connect to the BLS.

Note:
• If you use a license server, users must use their network logon names as their StarTeam user names.
• A single license server can handle licenses for multiple StarTeam releases and for multiple product releases.
• FLEXnet License Server configuration files on Linux are case sensitive.
• When StarTeam Server starts up, it checks for slips and stores information about them in memory. It does not recognize new slips until the next restart.
• When a user logs in from a StarTeam client application, StarTeam Server tells the client application what features are available to its user based on the license assigned to that user.
• If the user is assigned a license from a slip, but that slip is no longer in the license folder, StarTeam Server displays an error message. If the license type for that user is Unassigned, the user is not logged on and StarTeam Server returns an exception.

The administrator does the following to configure the license server:

1. Receives licensing information from Micro Focus distribution through email. If you need this information, contact your sales representative.

2. Installs the license server.
   
   
   Note: Refer to the documentation that is available with the license server.

3. Obtains license slips for the StarTeam Server using the Micro Focus product license activation process. The administrator:
   
   b) Provides the serial number from Micro Focus and an email address where the slips will be sent.
   c) Provides information about the computer where the license server is installed:
      
      • For BLS, provides the IP address, host name, and port number for both the installation computer and a backup computer.
      • For FLEXnet License Server, provides the MAC address, host name, and port number for the installation computer.

4. Saves the slip files.
   
   • For BLS, the email contains two slips: one starting with server_. While BLS is not running, that .slip file is copied into the /conf or /named folder, a subfolder of the BLS installation folder. The file named admin_guide.html, located in the /docs subfolder, provides detailed instructions. The other .slip file, the one starting with concurrent_ or named_ is copied into the /license folder, a subfolder of the Server installation folder.
   • For FLEXnet License Server, the email contains a .dat and a .slip file. The .dat file is copied into the FLEXnet License Server installation folder. The FLEXlm End Users Guide (enduser.pdf) provides detailed instructions. The .slip file is copied into the /License folder, a subfolder of the Server installation folder.

5. Configures the license server for users. For more information, refer to the documentation that is available with the license server.

6. Uses the Server Administration tool to:
   
   • Make sure that StarTeam user names are network logon names.
   • Assign users to specific named_ or concurrent_ slips.
Uninstalling StarTeam Server on Microsoft Windows

The product uses InstallAnywhere for installing and uninstalling. If you encounter one of the following Java VM errors when uninstalling this product on a Microsoft Windows operating system, you may need to install Java Runtime Environment (JRE) 1.8.0_51 or earlier from the Java Web site.

Uninstall errors:

• Can't launch executable. Could not find a suitable Java Virtual machine on your system.
• Windows error 3 occurred while loading the Java VM.
StarTeam Server for Linux Installation

This chapter explains how to install the StarTeam Server on Linux.

Before installing and configuring StarTeam Server and Server components for Linux, the StarTeam administrator must be familiar with the following concepts and procedures:

- Creating and modifying relational databases.
- Working with the features of their operating system, such as creating files, running executables, and managing access rights.
- Basic configuration management concepts.

For more information about installing on Linux, see StarTeamMPX for Linux Installation.

System Requirements for Linux

- Red Hat Enterprise Linux 5.5 (32-bit)
  
  **Note:** Advanced platform storage, virtualization, and high availability features (Red Hat Global File System & Cluster Suite) are not supported.
- Linux Suse 11.3 (32-bit)
- JDK or Java Runtime Environment (JRE) 1.8.0_51+
- Oracle Client 11g R2
- Oracle Client 11g version 11.1.0.6 (32-bit)
- Oracle Client 10g R2 version 10.2.0.4 (32-bit)
- PostgreSQL version 9.3

  **Note:** The Oracle database does not have to reside on the same machine as the StarTeam Server.

Pre-Installation Setup

This section provides information about pre-installation setup considerations for running StarTeam Server on Linux.

Environment Variables

Prior to installing StarTeam Server or StarTeam Server components, set the following environment variables:

- **ipaddress and host name**
  
  For Linux 32- and 64-bit, add one extra line under the /etc/hosts including:
  
  IP-Address Fully-Qualified-Hostname-With.Domain.Name Host-Name

- **JAVA_HOME**
  
  Environment variable to point to JDK or Java Runtime Environment (JRE) 1.8.0_51+.

- **For Oracle**
  
  NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252
  ORACLE_HOME=[Oracle home directory]
  PATH=$ORACLE_HOME/bin:$JAVA_HOME/bin:$PATH:
For PostgreSQL

PATH=C:\Program Files\PostgreSQL\9.3\bin;$PATH

Permissions for Oracle

Run the following command as root to make the StarTeam Server user account a member of the Oracle group used to install the Oracle client:

```
/usr/sbin/usermod -a -G oinstall starteam_user_name
```

where oinstall is the default Oracle group name and starteam_user_name is the StarTeam Server user account.

Installing StarTeam Server on Linux

1. Close all applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer by extracting the tar.gz file.
4. Run the binary file using the command ./server.bin.

**Note:** When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use as a parameter when running the installer. This step is necessary because Java VMs for non-Microsoft Windows operating systems are not bundled with the installers. If you experience any difficulties running the ./server.bin command, add the parameter LAX_VM and specify the path to your VM. For example:

```
./server.bin LAX_VM /usr/java/latest/jre/bin/java
```

5. In the StarTeam Server splash screen, select the appropriate language and click OK.
6. On the Introduction page, read the information, and click Next.
7. If the ORACLE_HOME variable is not set in your environment, the Get Oracle Path dialog box will appear. Browse to or type the path to the Oracle client installation and click Next.
8. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.
9. On the Choose Install Set page, choose either Typical, Full, or Custom.
   - **Typical** Installs StarTeam Server and the StarTeam documentation.
   - **Compact** Installs StarTeam Server with the minimum required options.
   - **Custom** Enables you to choose the options you want to install. Recommended for advanced users.
10. Click Next.
11. For a custom installation only, select the options you want:
   - **StarTeam Server** If you use the custom installation to install something that was not installed during a previous installation of StarTeam Server, you may choose to uncheck this check box. For example, suppose that in a previous custom installation, you elected to bypass the installation of PostgreSQL. To add that database now without reinstalling all of the server program files, you would clear the Server check box.
   - **StarTeam Toolbar** Installs the StarTeam Toolbar which remembers passwords so that logging on is easier.
12. Click Next.
13. On the Choose Install Folder page, browse for the location to be used as the installation folder.
    - The default location is /home/starteam/starteamserver<version>.
14. Click Next.
15. On the **Pre-installation Summary** page, review the settings and click **Previous** one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click **Next** or **Install**.

16. On the **Install Complete** page, click **Done**.

**Server Administration for Linux**

Use the **Server Administration** tool application to configure and manage each StarTeam Server.

To start the **Server Administration** tool, use the `./serveradmin.sh` command from the installation directory. The shell script sets up the shared library path `LD_LIBRARY_PATH` before starting the **Server Administration** tool.

**Migrating from StarTeam 2008 Server for Windows to StarTeam 14.0 Server for Linux**

StarTeam Server 2008 and 2008 R2 for Microsoft Windows support both Oracle and Microsoft SQL Server relational database management systems (RDBMS's), while StarTeam Server 14.0 for Linux supports only Oracle. For more details about supported database platforms, see [System Requirements and Prerequisites](#).

**Important:** The following steps assume that the original Microsoft Windows StarTeam configuration you are migrating uses an Oracle database. If you are migrating a StarTeam 2008/2008R2 for Microsoft Windows configuration that uses Microsoft SQL Server, you must first migrate it to Oracle using the steps specified in the [Migrating Server Configurations to Other Databases](#) topic of the [StarTeam Server 2008/2008 R2 for Windows Help](#). After you successfully migrate your StarTeam Server for Microsoft Windows configuration to an Oracle database, you can proceed with the following Microsoft Windows to Linux migration steps.

1. Back up the current Oracle database (schema used for storing StarTeam Server 2008/2008 R2 for Microsoft Windows metadata).
   - Save this backup copy. Do not recycle it
2. Install the Oracle client on the Linux machine. Verify that the supported Oracle client versions for this release are installed.
3. Create a StarTeam user account on the Linux machine.
4. Establish Oracle connectivity between the Linux machine and the Oracle database currently used for storing StarTeam metadata.
5. Verify the database connectivity using SQL*Plus.
6. Install StarTeam Server 14.0 for Linux on the Linux machine.
7. Copy the Microsoft Windows configuration file and hive index files from StarTeam Server 14.0 to the StarTeam Server for Linux repository folder.
8. Copy the vault, including the attachments (if running Microsoft Windows 2009 R2) from the Microsoft Windows Server to the Linux Server.
9. Open the **Server Tools**, and click **Help > About > License** to verify that the Server is licensed correctly.
10. Select the configuration, and click **Server > Configuration** from the menu.
11. Set the correct log file path in the `starteam-server-configs.xml` file.
12. Select the **Database Connection Information** tab, and click **Verify Connection** to verify the database connectivity.
13. Click **Tools > Administration > Hive Manager** from the **Server Administration** tool to update the hives.

   If there are multiple hives, ensure that all of them are set correctly.
14. Click Help > About > Info from the Server Administration tool to verify that the destination build number is greater than or equal to the source build on Microsoft Windows. If the destination build number is greater than the source build number, choose Actions > Upgrade. This step upgrades the source database to the destination’s build. Upgrade is not required when the source and destination builds are identical.

15. Verify that the upgrade log that gets created in the log file path directory is error free.

16. Back up the current Oracle database. Save this backup copy. Do not recycle it.

17. Verify that the server log that gets created in the log file path directory is clean.

**SELinux**

If SELinux is enabled in your system, you might receive a message like the following one when you start either the StarTeam Server or on a MPX Cache Agent, or when you invoke the `starteamserver` command line:

```
/root/starteamserver2008/libzlib.so: cannot restore segment prot after reloc:
Permission denied
```

To avoid this problem, set the SELinux Enforcement mechanism to permissive. If this approach is not an option for your organization, run the command `chcon -t textrel_shlib_t*.so` from each of the following directories:

- The StarTeam Server installation directory.
- `$ORACLE_HOME/lib`.
- `jrexx/lib/i386/client`, where `jrexx` is the java runtime environment (jre) used by the StarTeam Server installation. If the StarTeam Server installation was performed by a root user, `jrexx` is installed in the directory `/opt/Micro Focus/`. If the StarTeam Server installation was performed by a standard user, `jrexx` is installed in the home directory of the user.
- The StarTeam MPX Cache Agent installation directory.
MPX Installation and Configuration

Contains topics detailing the MPX installation and configuration.

MPX for Microsoft Windows Installation

This chapter provides a brief overview of MPX and explains how to install each of the MPX components on supported Microsoft Windows systems. MPX Event Transmitters and both MPX Message Brokers types are included with the StarTeam Enterprise package. You must license the StarTeam Enterprise Advantage package to use MPX File Transmitter and MPX Cache Agent.

Both of MPX Administrator’s Guides provide comprehensive information about MPX including it’s architecture, configuration, and usage.

Note: MPX and what appears on the screen during its installation are only in English.

About MPX

MPX is a framework for publish/subscribe messaging that improves the performance of the clients and extends the scalability of server configurations. It contains both common and application-specific components that together provide advanced messaging capabilities.

With MPX, changes to the server configuration’s repository are broadcast in an encrypted format to StarTeam clients and MPX Cache Agents through a publish/subscribe channel. For example, the MPX Event Transmitter broadcasts encrypted messages about changes to objects, such as change requests, and the MPX File Transmitter broadcasts archive files. Caching modules automatically capture events that a client subscribes to. This reduces the client’s need to send refresh requests to the server and improves client response times for the user.

MPX Cache Agents can be installed and configured to cache both item properties and file contents. This speeds up data access by placing the data in locations that are network near to the members of globally distributed teams. While MPX Cache Agents rely on messages and data transmitted by the MPX Event Transmitter and the MPX File Transmitter, they also serve other MPX clients, such as the StarTeam Cross-Platform Client, which retrieve data from the MPX Cache Agent instead of StarTeam Server itself. MPX Cache Agents are available only with StarTeam Enterprise Advantage.

ActiveMQ MPX and StarTeamMPX

StarTeam 15 introduces a new technology for messaging, ActiveMQ MPX, using the open source Apache ActiveMQ™. The legacy StarTeamMPX, using SmartSockets technology, is also supported.

By default, StarTeam Server is installed with support for both type of Message Brokers. The custom install option of the StarTeam Server can be used to install Message Brokers separately by checking the desired option: StarTeamMPX Message Broker or ActiveMQ MPX Message Broker.

Important: All MPX components work with either messaging system, but the messaging systems are not compatible with each other, so all MPX components must be configured to use the same type of Message Broker.

MPX Components

Most of the components described below are installed separately. The transmitters are included in the StarTeam Server installation.
MPX Transmitters

There are two types of transmitters that are installed with the server:

**MPX Event Transmitter**
The MPX Event Transmitter receives events of interest to StarTeam clients. The MPX Event Transmitter formats the event information it receives into XML messages, encrypts them, and publishes them to a Message Broker. Messages are assigned topics so that they can be distributed to clients interested in the accompanying content (project/view, item type, event type, etc.).

**MPX File Transmitter**
The MPX File Transmitter broadcasts file contents and item properties to one or more remote MPX Cache Agents by way of a Message Broker.

Message Broker

The Message Broker is a publish/subscribe messaging engine that broadcasts messages to subscriber components on a topic basis. It is a stand-alone process that can run on a separate computer to off load network processing overhead in high-volume environments.

The Message Broker broadcasts messages to each of its recipients using TCP/IP messaging. It receives encrypted XML messages from the MPX Event Transmitter or encrypted data from the MPX File Transmitter, and forwards them to the appropriate clients. Information is sent from a Message Broker directly to clients that have subscribed to that Message Broker by way of a TCP/IP connection profile.

Each MPX-enabled server configuration has one or two root Message Brokers. One or more remote Message Brokers can be distributed throughout the enterprise.

MPX Cache Agent

A MPX Cache Agent adds persistent data caching. Each MPX-enabled server configuration can have one root MPX Cache Agent. One or more remote MPX Cache Agents can be distributed throughout the enterprise. Often remote Message Brokers and Remote MPX Cache Agents are paired. A root MPX Cache Agent operates directly on the server configuration’s vault and cache.

A Root MPX Cache Agent handles requests forwarded from remote MPX Cache Agents for missing files and provides “catch-up” assistance for remote MPX Cache Agents after network or process outages.

Cache Agent-aware StarTeam clients can fetch data from any available MPX Cache Agent. By using “network-near” MPX Cache Agents, clients can improve file check-out performance and reduce their demands on the server. This frees server resources for additional tasks and users.

Generating Transmitter XML Files

When the transmitters are installed as part of a StarTeam Server installation, the transmitter template files (ActiveMQEventTransmitterTemplate.xml, StarTeam MPXEventTransmitterTemplate.xml, and MPXFileTransmitterTemplate.xml) are installed in the EventServices folder, a subfolder of the server's installation folder. The two Event Transmitter templates are configured to use an ActiveMQ MPX Message Broker and StarTeamMPX Message Broker respectively.

When creating a new configuration, you can select which template will be used by selecting the type of message broker.

When existing configurations are in place at the time of the installation, a configuration-specific set of transmitter XML files is created automatically for each existing configuration. The configuration-specific XML files (MPXEventTransmitter.xml and MPXFileTransmitter.xml) are created by copying the XML template files to a configuration-specific subfolder of the EventServices folder.

When a new configuration is defined, a set of configuration-specific XML files may be generated automatically depending on how the configuration is created:
• If you create a new configuration by using the **Server Administration** tool, a configuration-specific `MPXEventTransmitter.xml` and `FileTransmitter.xml` will be created automatically. The utility does this by copying the current XML template files to the appropriate configuration-specific subfolder of the `EventServices` folder and removing `Template` from their names.

• If you create a new configuration by using the StarTeam Server’s command-line interface, no configuration-specific XML files are created. If you want the new configuration to be MPX-enabled, you need to create the configuration-specific subfolder of the `EventServices` folder. The configuration subfolder’s name must be the same as the configuration name. Then manually copy the XML template files to the appropriate configuration-specific subfolder of the `EventServices` folder and remove `Template` from their names.

To edit the new XML files, see the section “Understanding Connection Profiles” in the appropriate *MPX Administrator’s Guide* for more information on configuration-specific and XML template files.

**MPX System Requirements**

⚠️ **Important:** Prior to installing, please read the appropriate *MPX Administrator's Guide* and the *StarTeam Installation Guide* on the [Product Documentation](http://supportline.microfocus.com/productdoc.aspx) page of the Micro Focus web site at http://supportline.microfocus.com/productdoc.aspx. Proper planning is required in order to achieve best results from MPX.

The StarTeam Server must be installed prior to installing the Message Broker and MPX Cache Agent. MPX transmitters have the same system requirements as the StarTeam Server because they are part of that system. The MPX Message Broker is required - it can be the ActiveMQ MPX Message Broker or the StarTeamMPX Message Broker. The MPX Message Broker is a publish/subscribe messaging engine that broadcasts messages to subscriber components on a topic basis. It is a stand-alone process that can run on a separate computer to offload network processing overhead in high-volume environments. For details, see the StarTeam Server *System Requirements* in this document. You can also set up MPX Cache Agents in tiers at a variety of locations so that file contents and objects, transmitted by the file transmitter, can be a local network near any StarTeam user. MPX Cache Agents work with the StarTeam Cross-Platform Client to check out files and fetch objects faster.

**Message Brokers and MPX Cache Agent**

⚠️ **Note:** For the MPX Cache Agent, these requirements should be sufficient for teams that have 50 to 100 members.

**Operating Systems**

- Microsoft Windows Server 2012 R2 (64-bit)
- Microsoft Windows Server 2012 (64-bit)
- Microsoft Windows Server 2008 (32- and 64-bit)
- Microsoft Windows Server 2008 R2 (64-bit)
- Red Hat Enterprise Linux 6.7 (32- and 64-bit)
- Red Hat Enterprise Linux 5.5 (32-bit)
- SUSE Linux 11.3 (32- and 64-bit)

⚠️ **Note:** You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer will return an error.

**Processor/Hardware**

- Disk appropriate for size of cache; fast disk preferable but not mandatory
- 100 Megabit NIC or better
- 1 CPU P4 1Ghz or better

**RAM**

256 MB memory or better

⚠️ **Note:** A MPX Cache Agent supports memory caching, which is important if object caching is enabled. Therefore, additional memory should be available to
support the desired amount of memory caching. The default memory cache size is 100MB.

**Hardware Recommendations**

The following are the recommended system configurations according to the number of peak users:

- **Less than 100**
  - 32-bit, dual-core systems with 4GB of memory

- **100-200**
  - 32-bit, quad-core systems with 4-8GB of memory

- **More than 200**
  - 64-bit, quad-core systems with 8-16GB of memory

For the Message Broker, the number of peak users is typically lower than the number of peak users connected to the StarTeam Server since multiple Message Brokers are used in medium-to-large deployments. The number of peak users connected to a MPX Cache Agent is significantly lower because MPX Cache Agents are only used in short bursts. As a result, less hardware resources are typically required to support the Message Broker and MPX Cache Agent compared to the StarTeam Server. Moreover, for a given geographic location, the Message Broker and MPX Cache Agent are typically deployed on the same machine.

**MPX Message Broker and MPX Cache Agent Installation**

MPX Message Broker and MPX Cache Agent are installed separately from and after the StarTeam Server. Installation instructions for each of these products is included in the following sections.

For more information about MPX, see the appropriate *MPX Administrator’s Guide*.

**Installing MPX Message Brokers**

The root Message Broker can be installed on the same computer where the StarTeam Server is installed, or it can be installed on a network-near computer. At least one Message Broker must be installed in your environment to provide messaging services for an MPX-enabled Server. As described in "Understanding Clouds" in the *StarTeamMPX Administrator’s Guide*, you may want to install more than one Message Broker to meet your needs.

To install the Message Broker on Microsoft Windows:

1. Log on to the computer as the administrator or as a user with administrative privileges.
2. Navigate to the directory that contains the downloaded files.
3. Run the installation file for the ActiveMQ MPX Message Broker or the StarTeamMPX Message Broker.
4. Walk through the installer and select the configuration options specific to your environment. For example, are you upgrading or freshly installing? Are you installing the ActiveMQ MPX Message Broker or the StarTeamMPX Message Broker? Do you want the service to start automatically or manually.

**Upgrading the StarTeamMPX Message Broker to 6.8**

The 6.8 Message Broker that ships has several fixes, making it the only Message Broker that you will want to use with any release mentioned in this section. Install the 6.8 Message Broker over any older version of
the 6.8 Message Broker and upgrade any installation of 6.7 Message Brokers. All Message Broker versions are interoperable; consequently, you can upgrade them one at a time.

1. Install Message Broker 6.8 on the same machine as Message Broker 6.7, letting the installer set it up as an auto-start service.
2. If you have customized the file STMessageBroker67.ini, copy it to the Message Broker 6.8 installation folder with the new name (STMessageBroker68.ini) so that you can reuse that file with Message Broker 6.8.
3. Stop Message Broker 6.7, and set the corresponding service (MPX Message Broker 6.7) to Manual so it does not automatically start again.
5. Determine that everything is working as expected, and then uninstall Message Broker 6.7. Multiple releases of Message Broker can run on the same machine if each uses its own port. You cannot start both the 6.7 and 6.8 Message Brokers at the same time if they are on the same machine and listening on the same port. Doing so causes a race condition, and the second one to start will fail.

MPX Cache Agent Installation

The following sections cover upgrade issues, pre-installation issues, and explain how to install a MPX Cache Agent.

You need to install a MPX Cache Agent only once on any computer that will use one or more MPX Cache Agents. You run as many instances of MPX Cache Agents as you need, each with a different and appropriate XML file.

The default XML file for a root MPX Cache Agent is RootCAConfig.xml. The default XML file for a remote MPX Cache Agent is RemoteCAConfig.xml. As you install a MPX Cache Agent, you also set up an initial MPX Cache Agent configuration file, so you must select either a Root or Remote MPX Cache Agent during the installation. This does not stop you from creating another configuration file for the same or a different type of MPX Cache Agent later on that same computer.

Upgrading the MPX Cache Agent

The MPX Cache Agent can be installed on a machine with a previous release.

Note: The goal is to transition StarTeam Server configurations from the older to the newer release.

The MPX Cache Agent can be run as either an application or a service. You can run multiple MPX Cache Agent instances on the same machine, but each needs its own configuration file.

By default, the installation creates a manual MPX Cache Agent service for your convenience. If the installation detects that a MPX Cache Agent service (for example, HKEY_LOCAL_MACHINES\SYSTEM\ControlSet001\Services\CacheAgentService) already exists and is registered, the installation does not set up a service. A warning advises

• If the existing MPX Cache Agent service is no longer needed, uninstall the previous MPX Cache Agent release or use the previous release to run CacheAgentService -unregister from a console window to unregister the existing MPX Cache Agent. Note that this is optional and the older release can remain, including the services created for it.
• Create an appropriate configuration file for each MPX Cache Agent service desired for the release just installed. You can reuse configuration files from the previous release of MPX Cache Agent by copying them to the new location. You might need to rename them for use with multiple MPX Cache Agent instances.
• Using the release just installed, run CacheAgentService -register from a console window for each MPX Cache Agent service desired. Note that the "-name" parameter is used to define a unique service name for each new service created.
• If an older MPX Cache Agent is installed, you are not asked whether you are installing a root or remote MPX Cache Agent and are not asked for any configuration information. The sample files
(SampleRemoteCacheAgentConfig.xml and SampleRootCacheAgentConfig.xml) are installed (as always), but neither the RootCAConfig.xml nor the RemoteCAConfig.xml file is created.

See the appropriate MPX Administrator's Guide available on the StarTeam > StarTeam Server <version> > Documentation menu for more information about configuring MPX Cache Agents.

Before Installing an MPX Cache Agent

When installing an MPX Cache Agent that will be used as a root MPX Cache Agent, StarTeam Server must be installed first. After you have installed StarTeam Server, you can install the other components in any order.

The following is a recommendation for installing MPX components:

1. Install StarTeam Server. The MPX Event Transmitter and MPX File Transmitter are installed automatically with StarTeam Server.
2. Install either type of MPX Message Broker (ActiveMQ MPX or StarTeamMPX) depending on the desired configuration.
   
   **Important:** You can run multiple instances of the MPX Message Broker, but they must be of the same type. If a single MPX Cache Agent is used for multiple configurations, the configurations and the MPX Cache Agents must be configured to use the same type of MPX Message Broker.
3. Install the root MPX Cache Agent. You need to install it only once per machine, even when that machine has more than one server configuration. You run multiple instances to support multiple StarTeam Server configurations. Each server configuration must have its own root cache agent instance.
4. Install the remote MPX Cache Agent. This is the same installer as the root MPX Cache Agent.

   The remote MPX Cache Agents can use the same Message Broker as the root MPX Cache Agent, but multiple Message Brokers are suggested for distributed teams, especially over distances. In practice, remote MPX Cache Agent usually use remote Message Brokers.

Before you start a root MPX Cache Agent:

a) Start each server configuration that you will use with MPX Cache Agent. Doing this causes the MPX File Transmitter to generate or upgrade a CacheJournal.dat file for each configuration.

b) (Optional) Modify the **MaxJournalAge** parameter's value in the FileTransmitter.xml file to represent the maximum number of days for which records will be kept within the Journal file. The pre-configured value is 180 days. Note that the Journal file is “trimmed” of expired records (those whose age exceeds the MaxJournalAge value) only when the server configuration is started.

Installing an MPX Cache Agent

Whether a MPX Cache Agent operates as a root MPX Cache Agent or a remote MPX Cache Agent is determined solely by its configuration. The installation of the MPX Cache Agent is similar in both cases except for consideration of the computer on which to install it:

- The root MPX Cache Agent requires access to the vault for the server configuration that it services. Consequently, it is usually installed on the same computer as the Server. Alternatively, if it can be installed on a network-near computer to prevent the Root MPX Cache Agent from competing for CPU or network I/O with the corresponding server configuration. However, this requires it to access the vault files and the CacheJournal.dat file by way of a shared network drive, so use this option only when a high-speed network is in place.

- Remote MPX Cache Agents should be installed in each geographic location that can benefit from local data access. One approach is to install a MPX Cache Agent in each network environment that local users can access over a highspeed LAN. (For example: Install two remote MPX Cache Agents at headquarters, one each for engineering and QA; install one at each regional office.) Another beneficial use of the MPX Cache Agent is to install an instance on a computer dedicated to a check-out intensive application such as a build utility. There is no limit on the number of MPX Cache Agents that can be installed throughout an enterprise. However, keep in mind that each MPX Cache Agent requires access
to a Message Broker. For more information about clouds, see “Understanding Clouds” in the appropriate MPX Administrator’s Guide.

To install a root MPX Cache Agent or remote MPX Cache Agent on Microsoft Windows:

1. Log on to the computer as the administrator or as a user with administrative privileges.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Select a language from the list, and then click OK.
5. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.
6. On the Choose Install Folder page, browse for the location to be used as the installation folder.
   The default installation path is C:\Program Files\Micro Focus\MPX Cache Agent <version>.
7. Choose a Root MPX Cache Agent or Remote MPX Cache Agent installation.

   **Root MPX Cache Agent installation**
   - **Message Broker Address**: Enter the host name or address of the Message Broker that the Root MPX Cache Agent will use to communicate with other MPX Cache Agents and clients. This value can optionally include the protocol prefix (tcp:) and port number suffix (:1234). The port number must be provided if the Message Broker is not using the default port (5101 for StarTeamMPX and 61616 for ActiveMQ MPX). For example: tcp:MBServer1:5123
   - **Server Cache folder**: Click Choose to browse to the folder path that contains the vault cache of the server configuration that the MPX Cache Agent will serve. This path must be relative to the computer on which the Root MPX Cache Agent is being installed.

   **Remote Cache Agent installation**
   - **Message Broker Address**: Enter the host name or IP address of the Message Broker that the Remote MPX Cache Agent will use to receive file content messages and to communicate with other MPX Cache Agents and clients. A Remote MPX Cache Agent should be configured to use a Message Broker and the tcp: address.
   - This option is described in more detail in “Configuring a Remote Cache Agent” in the in the MPX Administrator’s Guide.

8. On the Choose Shortcut Folder page, use the default setting (that is, keep the Other option button set to C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus\MPX Cache Agent <version>).
9. On the Pre-installation Summary page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the Pre-installation Summary page, and click Next or Install.
10. On the Install Complete page, click Done.

**After Installing an MPX Cache Agent**

Depending upon your environment, you may have to perform additional steps to use the MPX Cache Agent:

- The MPX Cache Agent installer installs both CacheAgentService.exe and CacheAgentApp.exe so you can run MPX Cache Agent as either a service or a console application.
- CacheAgentService is configured as a Manual start service. You may want to change the start type to Auto so that the MPX Cache Agent will start automatically thereafter. To change the start type to Auto, use the Control Panel Services interface or unregister and re-register the service. See “Running Cache Agent on Windows” in the appropriate MPX Administrator’s Guide for more information.

**Root MPX Cache Agent**

The default configuration file for a Root MPX Cache Agent is RootCAConfig.xml. It may need to some modification. See “Configuring a Root Cache Agent” in the appropriate MPX Administrator’s Guide.

**Remote Cache Agent**

The default configuration file for a Remote MPX Cache Agent is RemoteCAConfig.xml. It needs some modification for your environment. See “Configuring a Remote Cache Agent” in the appropriate MPX Administrator’s Guide.

### Uninstalling Message Broker and MPX Cache Agents

Each time you install a Message Broker or MPX Cache Agent, an uninstall program shortcut is created for that component. The uninstall programs enable you to remove the Message Broker/MPX Cache Agent from your computer. Your StarTeam Server installation, server configurations, and repositories are unaffected.

The uninstall program for StarTeam Server leaves the transmitter template files and each configuration’s transmitter XML files intact. A subsequent installation will not overwrite these files.

The MPX Services Uninstall program leaves the STMessageBroker68.ini file intact. If you later reinstall these services, this file will not be replaced by the new installation.

**Note:** MPX uses InstallAnywhere for installation and uninstallation. If you encounter one of the following Java VM errors when uninstalling this product on Microsoft Windows, you may need to install Java Runtime Environment (JRE) 1.8.0_51 or earlier from the Java Web site.

### Uninstall errors

- Can’t launch executable. Could not find a suitable Java Virtual machine on your system.
- Windows error 3 occurred while loading the Java VM.

### MPX for Linux Installation

This chapter explains how to install MPX on Linux.

For a brief overview about MPX, see MPX for Microsoft Windows Installation.

### Installing Message Broker on Linux

1. Close all applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Run the binary file using the command ./mpxservices.bin.

**Note:** When installing or uninstalling on a non-Microsoft Windows platform, specify the installed Java VM to use as a parameter when running the installer. This step is necessary because Java VMs for non-Microsoft Windows operating systems are not bundled with the installers. If you experience any difficulties when running the command ./mpxservices.bin, add the parameter
LAX_VM and specify the path to your VM. For example: ./mpxservices.bin LAX_VM /usr/java/latest/jre/bin/java.

Note: If the OpenSSL toolkit (openssl097a-0.9.7a-9.1386.rpm) and the Compatibility standard C++ libraries (compat-libstdc++-33-3.2.3-61.1386.rpm) are not installed, the MPX Services installer will prompt you to install them before continuing with the installation of StarTeam Message Broker.

5. On the Introduction page, read the information, and click Next.

6. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.

7. On the Choose Install Folder page, browse for the location to be used as the installation folder.
   The default location is /opt/messagebroker68.

8. Click Next.

9. On the Choose Link Folder page, specify whether to create links in your home folder, to create them in another location, or to not create them at all.

10. Click Next.

11. On the Pre-installation Summary page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the Pre-installation Summary page, and click Next or Install.

12. On the Install Complete page, click Done.

Installing an MPX Cache Agent on Linux

1. Close all applications.

2. Navigate to the directory that contains the downloaded files.

3. Run the downloaded installer.

4. Run the binary file using the command ./ca.bin. When installing or uninstalling on a non-Microsoft Windows platform, specify the installed Java VM to use as a parameter when running the installer. This step is necessary because Java VMs for non-Microsoft Windows operating systems are not bundled with the installers. If you experience any difficulties when running the command ./ca.bin, add the parameter LAX_VM and specify the path to your VM. For example: ./ca.bin LAX_VM /usr/java/latest/jre/bin/java.

5. On the Introduction page, read the information, and click Next.

6. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.

7. On the Choose Install Folder page, browse for the location to be used as the installation folder. The default location is /home/starteam/cacheagent14.0.

8. Click Next.

9. On the Choose Cache Agent Type page, select the MPX Cache Agent type you wish to install and click Next:

   **Root MPX Cache Agent**

   Each StarTeam configuration can have one Root MPX Cache Agent. You can install it on the same machine as StarTeam Server or on a separate machine that has access to the configuration’s vault cache folder.

   Use the Get Root Cache Agent Settings dialog box to perform the following:

   1. Specify the address of the Message Broker to be used.
   2. Browse to or type the path to the repository of the StarTeam Server configuration.
   3. Click Next.
Remote MPX Cache Agent

You can install any number of Remote MPX Cache Agent throughout your organization. Typically, one Remote MPX Cache Agent must be installed in each geographic region. Each Remote MPX Cache Agent is usually chained or tiered to one or more Root MPX Cache Agent.

Use the Get Remote Cache Agent Settings dialog box to perform the following:

1. Specify the address of the Message Broker to be used.
2. Specify the StarTeam Server configuration GUID.
3. Click Next.

10. On the Choose Link Folder page, specify whether to create links in your home folder, to create them in another location, or to not create them at all.

11. Click Next.

12. On the Pre-installation Summary page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the Pre-installation Summary page, and click Next or Install.

13. On the Install Complete page, click Done.

In order to start the MPX Cache Agent, set the environment variable LD_LIBRARY_PATH to point to the lib folder of the Oracle home directory.

Dependencies - Startup Order for MPX Components

The startup order of MPX components is important:

- The Message Broker is core to everything, so you should start it first. There is no particular order to starting root and remote Message Brokers. In general, if the Message Broker used by an MPX component is not running, the MPX component fails to start. For example, if a Root MPX Cache Agent is installed as an auto-start service and uses a Message Broker on the same computer, the Root MPX Cache Agent may start more quickly than the Message Broker. In this case, the Root MPX Cache Agent fails. The fix is to make the Root MPX Cache Agent service depend on the Message Broker service.
- You should start the MPX-enabled StarTeam Server configuration next. You must start it at least once before starting the Root MPX Cache Agent to create the CacheJournal.dat file. The first time you start a StarTeam configuration after a MPX File Transmitter has been activated, it creates the CacheJournal.dat file for that server configuration. If the Message Broker it uses is not running, the server configuration starts in non-MPX mode. This means the server will work, but no MPX messages will be broadcast, and "fixing" it requires restarting the server.
- You should start the Root MPX Cache Agent(s) next. If the Message Broker it uses is not running, or if the CacheJournal.dat file does not exist for the server configuration it is tracking, the Root MPX Cache Agent fails to start. Once the CacheJournal.dat file exists, the root MPX Cache Agent no longer has a start-order dependency with the StarTeam Server configuration. It can start before or after the StarTeam Server configuration has started.
- You can start the Remote MPX Cache Agent(s) at any time. It is independent of all other MPX components except for the Message Broker to which it connects. If that Message Broker is not running, the Remote MPX Cache Agent fails to start. However, if one of the Root MPX Cache Agent or the StarTeam Server configuration it is tracking are not running, it detects them when they are started.
- The MPX-enabled StarTeam Server configuration must be running before the MPX Cache Agents or clients can access it.
- The MPX Cache Agents must be running before the clients can retrieve files from them.
Requirements When Using StarTeamMPX and ActiveMQ MPX Together

Adhere to the following guidelines for system configurations that use both StarTeamMPX with ActiveMQ MPX:

- If a remote MPX Cache Agent is used, install ActiveMQ MPX Message Broker and StarTeamMPX Message Broker on the remote MPX Cache Agent machine.
- MPX Cache Agents (root or remote): An MPX Cache Agent configuration can only connect to one type of Message Broker at a time. As a result:
  - You must setup separate root MPX Cache Agents for all configurations that use the ActiveMQ MPX Message Broker, and for all configurations using StarTeamMPX Broker.
  - You must setup separate remote MPX Cache Agents for all configurations that use an ActiveMQ MPX Message Broker, and for all configurations using a StarTeamMPX Message Broker.
  - You must upgrade to StarTeam Agile 15.0, StarTeam Web Client 15.0, and the latest Micro Focus Connect. These applications will work with both the ActiveMQ MPX and the StarTeamMPX Message Brokers.
  - We recommended that you upgrade to StarTeam Cross-Platform Client 15.0, which can connect with MPX using any of the brokers.

**Important:** If using a version of the StarTeam Cross-Platform Client prior to 15.0, MPX will not work on ActiveMQ MPX configurations.

Requirements When Using ActiveMQ MPX Only

Adhere to the following guidelines for system configurations that use only ActiveMQ MPX:

- If a remote MPX Cache Agent is used, install the ActiveMQ MPX Message Broker on the remote MPX Cache Agent machine.
- All MPX Cache Agents (root or remote) must be upgraded to version 15.0 and configured to use the ActiveMQ MPX Message Broker.
- You must upgrade to StarTeam Agile 15.0, StarTeam Web Client 15.0, and the latest Micro Focus Connect. These applications will work with both ActiveMQ MPX and StarTeamMPX Message Brokers.
- We recommended that users upgrade to StarTeam Cross-Platform Client 15.0, which can connect with MPX using any of the brokers.

**Important:** If you are using a version of the StarTeam Cross-Platform Client prior to 15.0, MPX will not work in this scenario.

Configuring MPX to use ActiveMQ MPX

This chapter explains how to modify your existing MPX Event Transmitter, MPX File Transmitter, and MPX Cache Agent configurations to ActiveMQ MPX (using Apache ActiveMQ technology). By default, new configurations for StarTeam Server and the MPX Cache Agent will be configured to use the ActiveMQ MPX Message Broker. To switch an existing StarTeamMPX configuration to use ActiveMQ MPX Messaging, you will need to update the following configuration files:

- MPXEventTransmitter.xml.
- MPXFileTransmitter.xml.
- The Root MPX Cache Agent configuration file used.
- The Remote MPX Cache Agent configuration files used.
1. **Modify MPXEventTransmitter.xml:**
   a) Make sure the version of the file is 2.0. You should have this tag `<StExternHandlerModule version="2.0">`.
   b) Add/update the Name property in the `<Handler>` section. This indicates what type of messaging will be used with this configuration. Type `ActiveMQ MPX Transmitter`, which designates the use of ActiveMQ MPX-type messaging and brokers.
   c) Update the `server_names` property in all profiles with correct addresses and ports for your MPX Message Brokers.

2. **Modify MPXFileTransmitter.xml:**
   a) Make sure the version of the file is 2.0. You should have this tag `<StExternHandlerModule version="2.0">`.
   b) Add/update the Name property in the `<Handler>` section. This indicates what type of messaging will be used with this configuration. Type `ActiveMQ MPX File Transmitter`, which designates the use of ActiveMQ MPX-type messaging and brokers.

3. **Modify Root Cache Agent and Remote Cache Agent configuration files:**
   a) Make sure the version of the file is 2.0. You should have this tag `<MPXCacheAgent version="2.0">`.
   b) In the `<MessageBroker>` section, add/update the Name property to `ActiveMQ MPX Transmitter`.
   c) Update the `server_names` property in all profiles with correct addresses and ports for your MPX Message Brokers.

### Configure MPX to use StarTeamMPX

This topic explains how to modify your existing MPX Event Transmitter, MPX File Transmitter, and MPX Cache Agent configurations to use legacy StarTeamMPX (*SmartSockets* technology). By default, new configurations for StarTeam Server and the MPX Cache Agent will be configured to use the ActiveMQ MPX Message Broker. To switch back to StarTeamMPX, you will need to update the following configuration files:

- MPXEventTransmitter.xml.
- MPXFileTransmitter.xml.
- The Root MPX Cache Agent configuration file used.
- The Remote MPX Cache Agent configuration files used.

1. **Modify MPXEventTransmitter.xml:**
   a) Make sure the version of the file is 2.0. You should have this tag `<StExternHandlerModule version="2.0">`.
   b) Add/update the Name property in the `<Handler>` section. This indicates what type of messaging will be used with this configuration. Type `StarTeamMPX Transmitter`, which designates the use of StarTeamMPX-type messaging and brokers.
   c) Update the `server_names` property in all profiles with correct addresses and ports for your MPX Message Brokers.

2. **Modify MPXFileTransmitter.xml:**
   a) Make sure the version of the file is 2.0. You should have this tag `<StExternHandlerModule version="2.0">`.
   b) Add/update the Name property in the `<Handler>` section. This indicates what type of messaging will be used with this configuration. Type `StarTeamMPX Transmitter`, which designates the use of StarTeamMPX-type messaging and brokers.

3. **Modify Root Cache Agent and Remote Cache Agent configuration files:**
   a) Make sure the version of the file is 2.0. You should have this tag `<MPXCacheAgent version="2.0">`. 
b) In the <MessageBroker> section, add/update the Name property to StarTeamMPX Transmitter.

c) Update the server_names property in all profiles with correct addresses and ports for your MPX Message Brokers.
StarTeam Cross-Platform Client Installation

This chapter explains how to install the StarTeam Cross-Platform Client on Microsoft Windows and other platforms.

Check Micro Focus SupportLine (http://supportline.microfocus.com) for the latest patches for each client.

StarTeam Cross-Platform Client System Requirements

The StarTeam Cross-Platform Client is implemented in Java and can be installed on Microsoft Windows and any system that supports the Java Runtime Environment (JRE) 1.8.0_51. The StarTeam Cross-Platform Client has been tested on the following systems with the noted hardware and software:

Software

Operating Systems (32- and 64-bit)

- Microsoft Windows 10
- Microsoft Windows 8
- Microsoft Windows 7
- Microsoft Windows XP Professional SP3
- Microsoft Windows Vista SP1
- Solaris Sparc 10
- RedHat Enterprise Linux 6
- Ubuntu 14.04
- SUSE 11.3
- Mac: El Capitan, Yosemite.

Adobe Acrobat

For viewing the PDF manuals

Web browser (for online help)

- Internet Explorer 8 or later (Microsoft Windows only)
- Firefox 4 or later

Hardware

Processor

32-bit dual core

RAM

2 GB minimum

Hard disk space

200 MB to install the application. Also, sufficient disk space is required for your working files. The amount will vary depending on your use of the product.

Display

Required: SVGA, high color mode, 1024x768

Recommended: 1280x1024 or more

Mac Models

- MacBook (Early 2015).
- MacBook (Late 2008 Aluminum, or Early 2009 or newer).
- MacBook Pro (Mid/Late 2007 or newer).
- MacBook Air (Late 2008 or newer).
- Mac mini (Early 2009 or newer).
- iMac (Mid 2007 or newer).
Before Installing the StarTeam Cross-Platform Client

StarTeam supports compatibility between clients and servers which are either one release ahead or behind one another. This support is provided for your convenience in implementing your upgrades to the latest release. Some functionality may only be available in the latest release. You will achieve best performance by upgrading your clients and servers to the same release.

While some flexibility in client-server release combinations is allowed, the StarTeam Server 14.0 will not support connections from clients using an SDK older than the StarTeam 2009 R2 SDK.

⚠️ Important: You must be a local administrator on the target computer to install StarTeam products.

Setting up Default Personal Options

If, during a custom installation of the StarTeam Server for Microsoft Windows, you choose the Client Setup option, the installation files for StarTeam Cross-Platform Client were copied to a location designated by you and accessible to all users. Users can install from that location. One of the benefits of this arrangement is that each new user can be given a set of initial personal options, selected by you, instead of using the usual default StarTeam Cross-Platform Client personal options. For example, if these users use Change Requests more often than any other Micro Focus tab, you can make the Change Requests tab the first, or only, tab that the client displays.

To customize default personal options, create a file named starteam-client-options.xml and place it in the Client Setup folder. During the StarTeam Cross-Platform Client installation, the default personal options file you created is copied to All Users\Application Data\Micro Focus\StarTeam where it becomes a template for the starteam-client-options.xml file created by the StarTeam Cross-Platform Client when a user starts it for the first time. Existing client users can use your personal options before starting the client. The client will not overwrite the existing starteam-client-options.xml.

To provide all new users of the StarTeam Cross-Platform Client with the same initial set of personal options:

1. Perform a custom installation of StarTeam Server while selecting the Client Setup check box, so that the disk image for StarTeam Cross-Platform Client is installed in the Client Setup folder, a child folder of the StarTeam Server installation folder.
2. Make sure that this folder is one that all team members can access.
3. Install the StarTeam Cross-Platform Client on only one computer.
4. Set the personal options. See the StarTeam online help for details.
5. Notice that you now have a file named starteam-client-options.xml in the user profile folder. On Microsoft Windows, this is usually in the C:\Documents and Settings\user\Application Data\Micro Focus\StarTeam folder.
6. Copy this file to the Client Setup folder.
7. Rename this file starteam-client-options.xml.
8. Instruct users to install the StarTeam Cross-Platform Client from the Client Setup folder.

Installing the StarTeam Cross-Platform Client

You can install the StarTeam Cross-Platform Client on Windows or other operating systems such as Solaris and Linux systems.
To learn to use the StarTeam Cross-Platform Client, refer to the online help or the PDF documentation available from the StarTeam Cross-Platform Client <version> > Documentation submenu.

Installing the StarTeam Cross-Platform Client on Microsoft Windows

1. Close all applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Select a language from the list, and then click OK.
5. On the Introduction page, read the information, and click Next.
6. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.
7. On the Choose Install Set page, choose either Typical, Full, or Custom.
   - Typical Installs the StarTeam Cross-Platform Client, its user manuals, its online help, and the StarTeam Toolbar. The StarTeam Toolbar stores logon information making it easier to log on.
   - Compact Installs only the StarTeam Cross-Platform Client, its user manuals, and its online help.
   - Custom Allows you to select what is installed. This is the only way to install the Server Administration tool to use on a client workstation. When installed as part of the client, you can do only remote server administration.
     - If you selected a Custom install set, select or clear the check boxes for the parts you do and do not want to install. The custom options are: Application, StarTeam Toolbar, and Server Administration.

   Click Next.

8. On the Choose Install Folder page, browse for the location to be used as the installation folder. The default location is C:\Program Files\Micro Focus\StarTeam Cross-Platform Client <version>.
9. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button set to C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus \StarTeam Cross-Platform Client <version>).
10. On the Pre-installation Summary page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the Pre-installation Summary page, and click Next or Install.
11. On the Install Complete page, click Done. The StarTeam Cross-Platform Client is installed in the specified folder, and the StarTeam_Cross-Platform_Client_<version>\_InstallLog.log file in that folder documents what happened during the installation process.

Installing the StarTeam Cross-Platform Client on Linux or Solaris

- Note: When using the Universal Installer to install the StarTeam Cross-Platform Client on a non-Microsoft Windows operating system, Java Runtime Environment (JRE) 1.8.0_51+ must be located on the System path in order to properly install using the provided scripts.
1. Extract the downloaded Linux or Solaris installation package.
2. Run the StarTeamCP.bin file with the parameter LAX_VM to invoke the installer. For example, ./StarTeamCP.bin LAX_VM /LAX_VM /usr/java/latest/jre/bin/java.

**Important:** You must specify which Java VM to use when installing on non-Microsoft Windows operating systems since the installers are Java based, and are not bundled with a Java VM. This also applies to StarTeam Server, MPX Event Transmitter, and MPX Cache Agent (for example, server.bin, ca.bin, mpxserver.bin, and mpxservices.bin).

3. Follow the directions on your screen.

4. After installation, run the StarTeamCP executable located in the user_home_directory\StarTeamCP_<version> folder, or use the shortcut with the same name located in the directory selected during installation.

### Automating Client Installations

On Microsoft Windows operating systems, a silent install allows you to do multiple client installations at one time. You can run the client installer in a “silent” mode from the command line by adding the -i parameter to the command. Alternatively, you can point to a text file called Installer.properties which includes the directive INSTALLER_UI=silent.

The Installer.properties file can also specify parameters to pass to the installer, such as the destination client installation folder, the root folder for the SDK installation, which components to install, and whether or not a restart is needed.

### Performing a Silent Install

#### Note: It is important to install the StarTeam Cross-Platform Client using a user that is an administrator on the computer.

You can run the client installer in a “silent” mode from the command line with one of the following:

- The default values for installation options.
- Values that you set for installation options.

To set your own values for installation options:

1. Create a text file named installer.properties to contain the installation options to be set.
2. Add options and their values to the file. Each installer option is represented by a parameter followed by an equal sign followed by the value for the parameter. Each parameter is on a separate line in the file. The first line must be INSTALLER_UI=silent. Any options from the table that are not specified will use their default values. The following provides other possible silent installation options for the installer.properties file.

```ini
USER_INSTALL_DIR= Client installation path. The default is C:\Program Files\Micro Focus\StarTeam Cross-Platform Client <version>.
ST_SDKROOT= SDK installation path. The default is C:\Program Files\Micro Focus.
RESTART_NEEDED=NO Set this value to NO to control reboot after SDK installation.
USER_REQUESTED_RESTART=NO Set this value to NO to control user message about rebooting after StarTeam Cross-Platform Client installation.
CHOSEN_INSTALL_SET= Type of installation (Typical or Compact. Custom is not supported for a silent installation). The default is Typical.
```
Important: Double backslashes are required in path specifications.

3. Run the installer downloaded for Microsoft Windows from the command line in one of the following ways:
   • Followed by -I silent (to use the default installation options with no rebooting).
   • Followed by -f path_to_installer.properties_file.
   • Without a parameter if the installation.properties file exists and is in the same folder as the downloaded installer.

Additional Customization

The Server list and personal option files may be included with silent installations.

These files are located in the local settings of the currently logged on user (for example, C:\Documents and Settings\user_ID\Application Data\Micro Focus\StarTeam). Once these files contain the desired values (use a StarTeam Cross-Platform Client to add the servers and set the personal options), copy these files to the same location as the Installer.properties file. Rename these files as shown in the following table.

<table>
<thead>
<tr>
<th>Original File Name</th>
<th>Description</th>
<th>Installation File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>starteam-servers.xml</td>
<td>StarTeam Servers at a site.</td>
<td>server</td>
</tr>
<tr>
<td>starteam-client-</td>
<td>StarTeam personal options.</td>
<td>starteam-client-default-options.xml</td>
</tr>
<tr>
<td>options.xml</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The starteam-client-options.xml file will be copied to the User local home settings (for example, C:\Documents and Settings\user_home\Application Data\Micro Focus\StarTeam). If the starteam-client-default-options.xml file is included, the installation will overwrite this file if it already exists. This file will be used as a template for future new instances of the starteam-client-options.xml file in the user specific local settings. Existing instances of starteam-client-options.xml will not be overwritten.

The server.xml file will be copied to the installation user’s local settings if the starteamservers.xml does not already exist. The server.xml file will not be overwritten. This will only affect the server settings of the user who was currently logged on to the computer when the installation occurred.

Uninstalling the StarTeam Cross-Platform Client on Microsoft Windows

The product uses InstallAnywhere for installing and uninstalling. If you encounter one of the following Java VM errors when uninstalling this product on a Microsoft Windows operating system, you may need to install Java Runtime Environment (JRE) 1.8.0_51 or earlier from the Java Web site.

Uninstall errors:
• Can't launch executable. Could not find a suitable Java Virtual machine on your system.
• Windows error 3 occurred while loading the Java VM.

Installing StarTeam Integrations

You may receive an email that includes URLs for downloads of all StarTeam components for your StarTeam edition. Among those URLs are download links for starteam-integrations.zip and starteam-
integrations.tar.gz. These files contain the free StarTeam integrations. The StarTeam Synchronizer for HP Quality Center must be purchased separately.
StarTeam Web Server Installation and Configuration

The StarTeam Web Server provides StarTeam Web Client access to one or more StarTeam Servers through supported browsers.

This chapter explains how to install the StarTeam Web Server and specify the StarTeam servers, item types, projects, and views that will be available to StarTeam Web Client users.

StarTeam Web Server System Requirements

**Operating Systems**

- Microsoft Windows Server 2012 R2 (64-bit)
- Microsoft Windows Server 2012
- Microsoft Windows Server 2008 R2 SP1 (64-bit)

**Hardware**

- **Processor**: 64-bit quad core
- **RAM**: 8 GB minimum
- **Hard disk space**: 200 MB to install the application

**Software**

Java and Tomcat are installed with the installation package.

**Note:** You cannot install a 64-bit Microsoft Windows StarTeam component on a 32-bit Microsoft Windows system. The installer will return an error.

StarTeam Web Client System Requirements

**Web Browsers**

- Microsoft Edge
- Internet Explorer 9 or later
- Firefox 4 on Microsoft Windows and Linux
- Chrome

Performance and Scalability

A maximum of 200 active concurrent StarTeam Web Client users can be supported on one instance of the StarTeam Web Server. If no more than 200 users are actively performing operations in the StarTeam Web Client, the number of concurrent users may be higher. To support more than 200 active concurrent users, put them on another instance of the StarTeam Web Server.

An instance of the StarTeam Web Server can provide access to thirty or more StarTeam views. The number of views supported is impacted by the size of the views and the amount of memory provided to the process. To increase the amount of memory made available to the StarTeam Web Server, see Changing the Memory Allocated to the Web Server.
Dependencies - Startup Order for MPX Components

The startup order of MPX components is important:

• The Message Broker is core to everything, so you should start it first. There is no particular order to starting root and remote Message Brokers. In general, if the Message Broker used by an MPX component is not running, the MPX component fails to start. For example, if a Root MPX Cache Agent is installed as an auto-start service and uses a Message Broker on the same computer, the Root MPX Cache Agent may start more quickly than the Message Broker. In this case, the Root MPX Cache Agent fails. The fix is to make the Root MPX Cache Agent service depend on the Message Broker service.

• You should start the MPX-enabled StarTeam Server configuration next. You must start it at least once before starting the Root MPX Cache Agent to create the CacheJournal.dat file. The first time you start a StarTeam configuration after a MPX File Transmitter has been activated, it creates the CacheJournal.dat file for that server configuration. If the Message Broker it uses is not running, the server configuration starts in non-MPX mode. This means the server will work, but no MPX messages will be broadcast, and “fixing” it requires restarting the server.

• You should start the Root MPX Cache Agent(s) next. If the Message Broker it uses is not running, or if the CacheJournal.dat file does not exist for the server configuration it is tracking, the Root MPX Cache Agent fails to start. Once the CacheJournal.dat file exists, the root MPX Cache Agent no longer has a start-order dependency with the StarTeam Server configuration. It can start before or after the StarTeam Server configuration has started.

• You can start the Remote MPX Cache Agent(s) at any time. It is independent of all other MPX components except for the Message Broker to which it connects. If that Message Broker is not running, the Remote MPX Cache Agent fails to start. However, if one of the Root MPX Cache Agent or the StarTeam Server configuration it is tracking are not running, it detects them when they are started.

• The MPX-enabled StarTeam Server configuration must be running before the MPX Cache Agents or clients can access it.

• The MPX Cache Agents must be running before the clients can retrieve files from them.

Installing the StarTeam Web Server

The user installing and running the StarTeam Web Server must have local administrative privileges.

Note: During the StarTeam Web Server installation, you are able to install the StarTeam Server. A new configuration will be created and started automatically after the installation is complete. The new configuration will not automatically be added to your StarTeam Web Server. To learn how to add a StarTeam configuration to the StarTeam Web Server, see Adding a StarTeam Server Configuration to the StarTeam Web Server.

1. Close all applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Select a language from the list, and then click OK.
5. On the Introduction page, read the information, and click Next.
6. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you cannot install the product.
7. On the Choose Install Folder page, browse for the location to be used as the installation folder. The default installation location is C:\Program Files\Micro Focus\StarTeam <version> Web Server.
8. Click Next.
9. On the **Choose Shortcut Folder** page, specify where you would like to create product icons. The default location is `C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Micro Focus\StarTeam <version> Web Server`.

10. Click **Next**.

11. On the **Pre-installation Summary** page, review the settings and click **Previous** one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click **Next** or **Install**.

12. On the **Install Complete** page, click **Done**.

---

**Logging on to the StarTeam Web Server**

1. Click **Start > Programs > Micro Focus > StarTeam <version> Web Server > Start Web Server**. The **Tomcat Console** opens and starts the StarTeam Web Server.

2. Open a supported browser and enter the following URL in the address bar:

   ```
   http://<hostname>:<port>/StarTeam/StarTeamAdmin.jsp
   ```

   - `<hostname>`: Name of the computer where the StarTeam Web Server is running.
   - `<port>`: TCP/IP port number used by the StarTeam Web Server.

   The StarTeam Web Server is localized for several regions. If it does not detect your locale, try one of the following:

   ```
   http://yourserver/StarTeam/StarTeamAdmin_de.jsp
   http://yourserver/StarTeam/StarTeamAdmin_fr.jsp
   http://yourserver/StarTeam/StarTeamAdmin_ja.jsp
   http://yourserver/StarTeam/StarTeamAdmin_pt.jsp
   http://yourserver/StarTeam/StarTeamAdmin_zh.jsp
   ```

   The StarTeam Web Server logon page opens.

3. When logging on for the first time, type **Administrator** in both the **User name** and **Password** fields. The password is case sensitive.

4. Click **OK**.

---

**Changing the StarTeam Web Server Administrator User Name and Password**

The StarTeam Web Server has one user account for web server administration. It is recommended to change the user name and password instead of using the default values for these two properties. Even though the StarTeam Web Server **Administrator** has the same default user name and password as the StarTeam Server **Administrator**, these are unrelated user accounts.

1. In the **Administration** panel, type the new user name in the **User name** field.

2. Type the new password in the **Password** field and again in the **Confirm Password** field.

3. In **Dynamic Cache Timeout**, enter the length of time (in minutes) when a view will remain in memory before being removed. The default value is 15 minutes. The view is removed only if no one accesses it within the timeout period defined.

4. Click **Save**. When changes to the configuration are saved, the changes are applied dynamically. The StarTeam Web Server process monitors the file for changes and applies all changes that are made.
Configuring Component Access

1. Open a supported browser and enter the following URL in the address bar:
   http://<hostname>[:<port>]/StarTeam/StarTeamAdmin.jsp

   `<hostname>` Name of the computer where the StarTeam Web Server is running.
   `<port>` TCP/IP port number used by the StarTeam Web Server.

   The StarTeam Web Server is localized for several regions. If it does not detect your locale, try one of the following:
   http://yourserver/StarTeam/StarTeamAdmin_de.jsp
   http://yourserver/StarTeam/StarTeamAdmin_fr.jsp
   http://yourserver/StarTeam/StarTeamAdmin_ja.jsp
   http://yourserver/StarTeam/StarTeamAdmin_pt.jsp
   http://yourserver/StarTeam/StarTeamAdmin_zh.jsp

   The StarTeam Web Server logon page opens.

2. When logging on for the first time, type Administrator in both the User name and Password fields.
   The password is case sensitive.

3. On the Administration Panel, go to the Selected Servers group.

4. Navigate down into the server that you want to configure and then under Available Types, select the components that you want to make accessible to web client users.

5. Click Save.

Adding a StarTeam Server Configuration to the StarTeam Web Server

The StarTeam Web Server can only connect to a StarTeam Server configuration that supports MPX, and MPX must be running.

Perform the following steps to add a server configuration to the Available Servers folder tree and specify the StarTeam Server's item types, projects, and views that will be available to StarTeam Web Client users.

1. Type a unique, easy-to-remember description in the Description field. It is not case-sensitive and can contain colons (::).

   **Note:** This description is the name used in the StarTeam Web Client.

2. Type the server configuration's computer name or IP address in the Address field.

3. Type the endpoint (TCP/IP port number) associated with the protocol in the Port field.

4. Type your User name and Password in the appropriate fields.

   **Note:** The specified user must have administrative rights on the server configuration.

5. Click Add Server to Selected Servers.

   The server configuration will be added to the Available Servers folder tree with its check box checked by default, as only checked entries can be made available to StarTeam Web Client users.

   **Note:** StarTeam Web Server Administrators can make a server configuration unavailable to StarTeam Web Client users by clearing its check box.

6. Under the server configuration's Available Types, check the item types to be made available to StarTeam Web Client users.
7. Under the server configuration’s Available Projects, select the StarTeam projects to be made available to StarTeam Web Client users using one of the following options for each project:
   - Select Allow All Views under a project in the server tree. When selected, all views for the project are allowed to be used and cached and the other view node options are disabled.
   - Under a project’s Available Views, select the views to be made available to StarTeam Web Client users.

   Note: The number of available views affects the amount of memory needed for the StarTeam Web Server process. If the StarTeam Web Server is running out of memory, set the disable_sdk_sessions value to true in the file located in \apache-tomcat-7.0.47\shared\StarTeam in the installation folder. This will enable the StarTeam Web Server to start without loading the available views, and you can then decrease the configuration size.

8. Optionally: To make all views for a server available, select a server in the server tree and click Allow all Views for Selected Server. All projects for the server will have the Allow all Views check box selected. This is a quick and efficient way to include all project views at once for the selected server.

9. Click Save, click OK on the confirmation dialog box, then restart the StarTeam Web Server. When changes to the configuration are saved, the changes are applied dynamically. The StarTeam Web Server process monitors the file for changes and applies all changes that are made.

Removing a StarTeam Server Configuration from the StarTeam Web Server

1. In the Available Servers folder tree, highlight the server configuration you want to remove.
2. Click Remove Selected Server.
3. Click Save.
4. Click OK on the confirmation dialog box, then restart the StarTeam Web Server.

Setting Up the StarTeam Web Server as a Microsoft Windows Service

If running the StarTeam Web Server as a Microsoft Windows service, change the following parameters in the file StarTeamService32.bat for 32-bit installations or StarTeamService64.bat for 64-bit installation first:

1. JvmMx - The maximum memory provided to the StarTeam Web Server. The value should be specified in MB; the default value is 4096.
2. Startup - Determines if the Microsoft Windows service will start up automatically or manually. The default value is auto and can be changed to manual.
3. Prior to running StarTeamService.bat, set the CATALINA_HOME environment variable on Microsoft Windows to point to <Install Directory>.
4. To set up the StarTeam Web Server as a Microsoft Windows service, run <Install Directory>/StarTeamService32.bat or <Install Directory>/StarTeamService64.bat.

To remove the StarTeam Web Server as a Microsoft Windows service, run <Install Directory>/service.bat remove located in the installation folder.

See http://tomcat.apache.org/tomcat-5.5-doc/windows-service-howto.html for documentation on how to setup tomcat as a windows service.
See [http://commons.apache.org/daemon/procrun.html](http://commons.apache.org/daemon/procrun.html) for full documentation on the `tomcat5.exe` program.

**setenv.bat**

The `setenv.bat` command is used to modify or to set environment variables for the Tomcat application server. These settings only apply when using the `catalina.bat` or the `startup.bat` methods for starting the Tomcat application server.

Tomcat uses the following important environment variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATALINA_HOME</td>
<td>May point at your Catalina build directory.</td>
</tr>
<tr>
<td>CATALINA_BASE</td>
<td>(Optional) Base directory for resolving dynamic portions of a Catalina installation. If not present, resolves to the same directory that CATALINA_HOME points to.</td>
</tr>
<tr>
<td>CATALINA_OPTS</td>
<td>(Optional) Java runtime options used when the start, or run command is executed.</td>
</tr>
<tr>
<td>CATALINA_TMPDIR</td>
<td>(Optional) Directory path location of temporary directory the JVM should use (java.io.tmpdir). Defaults to <code>%CATALINA_BASE%\temp</code>.</td>
</tr>
<tr>
<td>JAVA_HOME</td>
<td>Must point at your Java Development Kit installation. Required to run the with the debug argument.</td>
</tr>
<tr>
<td>JRE_HOME</td>
<td>Must point at your Java Runtime installation. Defaults to JAVA_HOME if empty.</td>
</tr>
<tr>
<td>JAVA_OPTS</td>
<td>(Optional) Java runtime options used when the <code>start</code>, <code>stop</code>, or <code>run</code> command is executed.</td>
</tr>
<tr>
<td>JSSE_HOME</td>
<td>(Optional) May point at your Java Secure Sockets Extension (JSSE) installation, whose JAR files will be added to the system class path used to start Tomcat.</td>
</tr>
<tr>
<td>JPDA_TRANSPORT</td>
<td>(Optional) JPDA transport used when the <code>jpda</code> start command is executed. The default is <code>dt_shmem</code>.</td>
</tr>
<tr>
<td>JPDA_ADDRESS</td>
<td>(Optional) Java runtime options used when the <code>jpda start</code> command is executed. The default is <code>dbconn</code>.</td>
</tr>
<tr>
<td>JPDA_SUSPEND</td>
<td>(Optional) Java runtime options used when the <code>jpda</code> start command is executed. Specifies whether JVM should suspend execution immediately after startup. Default is <code>n</code>.</td>
</tr>
<tr>
<td>JPDA_OPTS</td>
<td>(Optional) Java runtime options used when the <code>jpda</code> start command is executed. If used, <code>JPDA_TRANSPORT</code>, <code>JPDA_ADDRESS</code>, and <code>JPDA_SUSPEND</code> are ignored. Thus, all required <code>jpda</code> options MUST be specified. The default is: <code>-Xdebug -Xrunjdwp:transport=%JPDA_TRANSPORT%, address=%JPDA_ADDRESS%, server=y, suspend=%JPDA_SUSPEND%</code></td>
</tr>
</tbody>
</table>

**StarTeam Defaults**

The following are the StarTeam Web Server defaults:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPDA_TRANSPORT</td>
<td>dt_socket</td>
</tr>
<tr>
<td>JPDA_ADDRESS</td>
<td>8000</td>
</tr>
<tr>
<td>JPDA_SUSPEND</td>
<td>y</td>
</tr>
</tbody>
</table>
### Variable Description

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAVA_OPTS</td>
<td>JAVA_OPTS=-Xmx4096M -Dcom.borland.configdir=&quot;%CATALINA_HOME%\shared\lib&quot; -Djava.library.path=&quot;%CATALINA_HOME%\shared\lib&quot;</td>
</tr>
<tr>
<td>JRE_HOME</td>
<td>C:\Program Files\Micro Focus\StarTeam 16 Web Server\jre</td>
</tr>
</tbody>
</table>

---

### StarTeamService.bat

The StarTeamService32.bat or the StarTeamService64.bat script is installed with the StarTeam Web Server to install the product as a service. The install script first calls the `service.bat` install option. This will install the StarTeam Web Server application as a Microsoft Windows service.

The StarTeamService32.bat or StarTeamService64.bat script then calls the `tomcat5.exe` service utility to update the service parameters.

The default update call is:

```
tomcat5.exe
//US//Tomcat5 ++JvmOptions
-Dcom.borland.starteam.web.configdir="%CATALINA_HOME%\shared\BorlandStarTeam";
-Djava.library.path="%CATALINA_HOME%\shared\lib"
--JvmMx 1024 --Startup auto --JavaHome "C:\Program Files\Borland\Java\Sun1.6.0_29"
```

The following are the parameters that are altered and their meaning:

- **Note**: Parameters may be different depending on 32- or 64-bit operating systems.

  - Update service parameters for service name Tomcat5: //US//Tomcat5
  - Update Java Virtual Machine options: Sets a Java System Property named `com.borland.starteam.web.configdir` used by the StarTeam Web Server application code.
  - Modify the `java.library.path` Java System Property to be the `shared\lib` directory. This is where StarTeam libraries are installed.
  - Update the Java Maximum Memory usage. The defaults are quite small: --JvmMx 1024.
  - Update the Service startup mode to be 'auto'. The StarTeam Web Server will automatically start whenever the computer starts: --Startup auto
  - Update a different `JAVA_HOME` than defined by `JAVA_HOME` environment variable: --JavaHome "C:\Program Files\Borland\Java\Sun1.6.0_29"

---

### service.bat

Apache Tomcat provides the `service.bat`. It is used to manually install Tomcat as a service.
Administrator privileges are required to run this script.

⚠️ **Note:** On Microsoft Windows Vista or any other operating system with User Account Control (UAC) you must either disable UAC or right-click on `cmd.exe` and select **Run as administrator** in order to run this script. If UAC is enabled, being logged on with an Administrator account is not sufficient.

**Script Options**

**Install**
Install the service using Tomcat5 as service name. Service is installed using default settings.

**Remove**
Remove the service from the system.

**Name**
(Optional) If the second argument is present it is considered to be a new service name.

**Default Service Name** tomcat5

**Default Display Name** Apache Tomcat

**Tomcat5w.exe**

Tomcat5w is a GUI application for monitoring and configuring Tomcat services. Users double-click the `%CATALINA_HOME%\bin\tomcat5w.exe` executable to verify or modify service parameters.

**Command line options**

//ES// Edit service configuration. This is the default operation. It is called if no option is provided, but the executable is renamed to `servicenameW.exe`.

//MS// Monitor service. Put the icon in the system try.

**Tomcat5.exe**

Tomcat5.exe is a application that allows Microsoft Windows users to wrap Java applications as a Microsoft Windows service. The service can be set to automatically start when the machine boots and will continue to run with no user logged on to the machine.

**Tomcat5.exe command line arguments**

Each command line directive is in the form of `//XX[//ServiceName]`. If the `//ServiceName` parameter is omitted, then the service name is assumed to be the name of the file. For example, if the application is renamed as `TestService.exe`, the default service name is `TestService`.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>//TS</td>
<td>Runs the service as a console application. This is the default operation. It is called if no option is provided.</td>
</tr>
<tr>
<td>//RS</td>
<td>Runs the service. It is called only from <code>ServiceManager</code>.</td>
</tr>
<tr>
<td>//SS</td>
<td>Stops the service.</td>
</tr>
<tr>
<td>//US</td>
<td>Updates service parameters.</td>
</tr>
<tr>
<td>//IS</td>
<td>Installs service.</td>
</tr>
<tr>
<td>//DS</td>
<td>Deletes service and stops the service first if it is currently running.</td>
</tr>
<tr>
<td>//PP[/seconds]</td>
<td>Pause. Default is 60 seconds.</td>
</tr>
<tr>
<td>//VS</td>
<td>Version. Print version and exit (since version 1.0.3).</td>
</tr>
</tbody>
</table>
Command Line Parameters

Each command parameter is prefixed with --. If an environment variable exists with the same name as command line parameter but prefixed with PR_ it will take precedence.

If a parameter is repeated, the last value takes precedence. However, some parameters can take multiple values, for example StartParams andJvmOption. If these parameters are prefixed with ++, the value is appended to the existing value.

Only multi-valued parameters support the parameter ++ prefix. They are indicated in the table below by ++. If ++ is used for a parameter that does not support multiple values, then it is treated the same as --. No error is reported.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--Description</td>
<td>Service name description (maximum 1024 characters).</td>
</tr>
<tr>
<td>--DisplayName</td>
<td>Default: ServiceName</td>
</tr>
<tr>
<td></td>
<td>Service display name</td>
</tr>
<tr>
<td>--Install</td>
<td>Default: tomcat5.exe. //RS//ServiceName.</td>
</tr>
<tr>
<td></td>
<td>Install image</td>
</tr>
<tr>
<td>--Startup</td>
<td>Default: manual</td>
</tr>
<tr>
<td></td>
<td>Service startup mode can be either auto or manual.</td>
</tr>
<tr>
<td>--Type</td>
<td>Service type can be interactive to allow the service to interact with the desktop. Use this option only with Local system accounts.</td>
</tr>
<tr>
<td>++DependsOn</td>
<td>List of services that this service depends on</td>
</tr>
<tr>
<td></td>
<td>Dependent services are separated using either # or ; characters.</td>
</tr>
<tr>
<td>++Environment</td>
<td>List of environment variables that will be provided to the service in the form key=value. They are separated using either # or ; characters. If you need to embed either # or ; character within a value, put them inside single quotes.</td>
</tr>
<tr>
<td>--User</td>
<td>User account used for running executable. It is used only for StartMode Java or exe and enables running applications as a service under an account without the LogonAsService privilege.</td>
</tr>
<tr>
<td>--Password</td>
<td>Password for user account set by --User parameter</td>
</tr>
<tr>
<td>--ServiceUser</td>
<td>Specifies the name of the account under which the service should run. Use an account name in the form DomainName\UserName. The service process will be logged on as this user. If the account belongs to the built-in domain, you can specify \Username.</td>
</tr>
<tr>
<td>--ServicePassword</td>
<td>Password for user account set by --ServiceUser parameter</td>
</tr>
<tr>
<td>--LibraryPath</td>
<td>Directory added to the search path used to locate the DLLs for the JVM</td>
</tr>
<tr>
<td></td>
<td>This directory is added both in front of the PATH environment variable and as a parameter to the SetDLLDirectory function.</td>
</tr>
<tr>
<td>--JavaHome</td>
<td>Default: JAVA_HOME</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>--Jvm</td>
<td>Set a different JAVA_HOME than defined using JAVA_HOME environment variable. Default: auto</td>
</tr>
<tr>
<td></td>
<td>Use either auto to find the JVM from the Microsoft Windows registry or specify the full path to the jvm.dll. You can use environment variable expansion.</td>
</tr>
<tr>
<td>++JvmOptions</td>
<td>List of options in the form of -D or -X that will be passed to the JVM. The options are separated using either # or ; characters. If you need to embed either # or ; character put them inside single quotes. This is not used in exe mode.</td>
</tr>
<tr>
<td>--Classpath</td>
<td>Set the Java classpath. This is not used in exe mode.</td>
</tr>
<tr>
<td>--JvmMs</td>
<td>Initial memory pool size in MB. This is not used in exe mode.</td>
</tr>
<tr>
<td>--JvmMx</td>
<td>Maximum memory pool size in MB. This is not used in exe mode.</td>
</tr>
<tr>
<td>--JvmSs</td>
<td>Thread stack size in KB. This is not used in exe mode.</td>
</tr>
<tr>
<td>--StartMode</td>
<td>One of jvm, Java or exe. The modes are:</td>
</tr>
<tr>
<td></td>
<td>• * jvm - starts Java in-process. It depends on jvm.dll, see --Jvm.</td>
</tr>
<tr>
<td></td>
<td>• * Java - This is the same as exe, but automatically uses the default Java executable. For example, %JAVA_HOME%\bin\java.exe. Make sure JAVA_HOME is set correctly. Or use JavaHome to provide the correct location. If neither is set, tomcat5 tries to find the default JDK, not the JRE, from the Microsoft Windows registry.</td>
</tr>
<tr>
<td></td>
<td>• * exe - runs the image as a separate process.</td>
</tr>
<tr>
<td>--StartImage</td>
<td>Executable to run. This only applies to exe mode.</td>
</tr>
<tr>
<td>--StartPath</td>
<td>Working path for the start image executable.</td>
</tr>
<tr>
<td>--StartClass</td>
<td>Class that contains the startup method. Applies to the jvm and Java modes. It is not used in exe mode.</td>
</tr>
<tr>
<td>--StartMethod</td>
<td>Default: main</td>
</tr>
<tr>
<td></td>
<td>Name of method to be called when the service is started. It must be static void and have argument (String args[]). Only applies to jvm mode - in Java mode, the main method is always used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In jvm mode, the start method should not return until the stop method has been called.</td>
</tr>
<tr>
<td>++StartParams</td>
<td>List of parameters that will be passed to either StartImage or StartClass. Parameters are separated using either # or ; character.</td>
</tr>
<tr>
<td>--StopMode</td>
<td>One of jvm, Java or exe. See --StartMode for further details.</td>
</tr>
<tr>
<td>--StopImage</td>
<td>Executable that will be run on Stop service signal. This only applies to exe mode.</td>
</tr>
<tr>
<td>--StopPath</td>
<td>Working path for the stop image executable. This does not apply to jvm mode.</td>
</tr>
<tr>
<td>--StopClass</td>
<td>Class that will be used on Stop service signal. Applies to the jvm and Java modes.</td>
</tr>
<tr>
<td>--StopMethod</td>
<td>Default: main</td>
</tr>
<tr>
<td></td>
<td>Name of method to be called when service is stopped.</td>
</tr>
</tbody>
</table>
### Table of Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>++StopParams</td>
<td>List of parameters that will be passed to either StopImage or StopClass. Parameters are separated using either # or ; character.</td>
</tr>
<tr>
<td>--StopTimeout: Default</td>
<td>No Timeout. This parameter defines the timeout in seconds that tomcat5 waits for service to exit gracefully.</td>
</tr>
<tr>
<td>--LogPath: Default</td>
<td>%SystemRoot%\System32\LogFiles\Apache Defines the path for logging and creates the directory if necessary.</td>
</tr>
<tr>
<td>--LogPrefix: Default</td>
<td>commons-daemon Defines the service log filename prefix. The log file is created in the LogPath directory with .YEAR-MONTH-DAY.log suffix.</td>
</tr>
<tr>
<td>--LogLevel</td>
<td>Default: Info Defines the logging level and can be either Error, Info, Warn or Debug.</td>
</tr>
<tr>
<td>--LogJniMessages</td>
<td>Default: 0 Set this non-zero (e.g. 1) to capture JVM jni debug messages in the tomcat5 log file. This is not needed if stdout/stderr redirection is being used. This only applies to jvm mode.</td>
</tr>
<tr>
<td>--StdOutput</td>
<td>Redirected stdout filename. If named, auto file is created inside LogPath with the name service-stdout.YEAR-MONTH-DAY.log.</td>
</tr>
<tr>
<td>--StdError</td>
<td>Redirected stderr filename. If named, auto file is created in the LogPath directory with the name service-stderr.YEAR-MONTH-DAY.log.</td>
</tr>
<tr>
<td>--PidFile</td>
<td>Defines the file name for storing the running process id. The actual file is created in the LogPath directory.</td>
</tr>
</tbody>
</table>

---

### Enabling SSL Using a Valid Certificate

You must have a valid certificate available in order to enable Secure Socket Layer (SSL).

1. **Edit the** `<Install Directory>/apache-tomcat-5.5.27/conf/server.xml` **file in the following ways.**

   a) **Comment out the following xml block to disable the standard http access:**

   ```xml
   <Connector port="8080" maxHttpHeaderSize="8192"
           maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
           enableLookups="false" redirectPort="8443" acceptCount="100"
           connectionTimeout="20000" disableUploadTimeout="true" />
   ``

   b) **Uncomment the following xml block to enable https access and add the attributes:**

   ```xml
   <Connector port="8443" maxHttpHeaderSize="8192"
              maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
              enableLookups="false" disableUploadTimeout="true"
              acceptCount="100" scheme="https" secure="true" />
   ```
Changing the Memory Allocated to the StarTeam Web Server

The number of memory the StarTeam Web Server can consume while running directly affects the amount of StarTeam views that can be supported on the StarTeam Web Server. To increase the memory provided to the StarTeam Web Server in order to support larger StarTeam configurations, the Administrator should perform the following steps before starting the StarTeam Web Server.

1. Navigate to the file setenv.bat located in /apache-tomcat-5.5.33/bin in the installation folder.
2. Increase the JAVA_OPTS=-Xmxvalue. value is the maximum size, in bytes, of the memory allocation pool. This value must be a multiple of 1024 greater than 2MB. You can append the letter k or K to indicate kilobytes, or m or M to indicate megabytes. For example, the value can appears as -Xmx83886080, -Xmx81920k, or -Xmx80m.

Setting the Log Output Level

The logging level that the StarTeam Web Server uses when updating the log files in the directory /apache-tomcat-5.5.33/logs is specified in the file /apache-tomcat-5.5.33/shared/classes/logging.properties in the installation folder. The following levels can be set in the file.

- OFF
- SEVERE
- WARNING
- INFO (default)
- CONFIG
- FINE
- FINER
- FINEST
- ALL

Running Apache Tomcat Native

The StarTeam Web Server does not ship with the library tcnative-1.dll for running Apache Tomcat Native. Testing of the StarTeam Web Server on the supported platform did not show any benefit to running the StarTeam Web Server with native enabled. If you wish to run the StarTeam Web Server with native enabled, the 64-bit library tcnative-1.dll can be downloaded from the Apache Software Foundation web site at http://tomcat.apache.org/. Place the file in the installation folder /apache-tomcat-5.5.33/shared/lib, and restart the StarTeam Web Server to pick up the change.

Note: When downloading the file tcnative-1.dll, please be sure to download the version of the file that matches your 64-bit architecture (AMD64 or Intel IA64) and Internet Protocol (IPv4 or IPv6).
Specifying Item Details for the StarTeam Web Client

The records in the StarTeam Web Client Item Table display a subset of the item property values defined by the selected filter. Embedded item details can be used to reveal item properties not shown in the Item Table. The default embedded item details for each item type are as follows.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Embedded Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Task Name, Notes</td>
</tr>
<tr>
<td>Requirement</td>
<td>Name, Description</td>
</tr>
<tr>
<td>CR</td>
<td>Synopsis, Description, Fix</td>
</tr>
<tr>
<td>File</td>
<td>Description</td>
</tr>
<tr>
<td>Topic</td>
<td>Title, Description</td>
</tr>
</tbody>
</table>

Administrators can also create custom html details templates and place them in the installation folder in \apache-tomcat-7.0.47\shared\StarTeam. If a custom html details template is found for the current type, that template will be used to render the embedded details. The html details template format supported by the StarTeam Web Client is the same format supported by the StarTeam Cross-Platform Client. Refer to the StarTeam Cross-Platform Client Help for more information.

The following are the required names for details templates:

- file.details.html
- changerequest.details.html
- requirement.details.html
- task.details.html
- topic.details.html

Creating a Custom Details Template

This section contains a sample of the details template that you can make for any item type viewed from the StarTeam Web Client. This example is for Change Requests.

1. Create the file changerequest.details.html in the installation folder in \apache-tomcat-5.5.33\shared\BorlandStarTeam\. 
2. Edit the file in a text editor.
3. Type the following code content:

```html
<table>
<tr>
<td align=left valign=top><b>CR ~ChangeNumber~~ (~DotNotation~~): ~Synopsis~</b></td>
</tr>
</table>
<br>
<table border=1>
<tr>
<td width=200 align=center><b>Timestamps</b></td>
<td width=200 align=center><b>Entered</b></td>
<td width=200 align=center><b>Resolved</b></td>
<td width=200 align=center><b>LastModified</b></td>
<td width=200 align=center><b>Closed</b></td>
<td width=200 align=center><b>Verified</b></td>
</tr>
<tr>
<td width=200 align=right><b>By:</b></td>
<td width=200 align=left>~~EnteredBy~~</td>
<td width=200 align=left>~~ResolvedBy~~</td>
<td width=200 align=left>~~LastModifiedBy~~</td>
<td width=200 align=left>~~ClosedBy~~</td>
<td width=200 align=left>~~VerifiedBy~~</td>
</tr>
</table>
```
4. Save the custom details template file.
5. Restart StarTeam Web Server.
6. View the items table for Change Requests.
7. Expand the details of the Change Request to view the custom details.

**Accessing the StarTeam Web Client**

To access the StarTeam Web Client, open a supported browser and enter the following URL in the address bar:

http://hostname:port/StarTeam

**hostname** Name of the computer where the StarTeam Web Server is running.

**port** TCP/IP port number used by the StarTeam Web Server.

The StarTeam Web Client is localized for several regions. If it does not detect your locale, try one of the following:

http://yourserver/StarTeam?locale=de
http://yourserver/StarTeam?locale=fr
http://yourserver/StarTeam?locale=ja
http://yourserver/StarTeam?locale=pt
http://yourserver/StarTeam?locale=zh
StarTeam Layout Designer Installation

This chapter explains how to install the Layout Designer. To learn how to use the Layout Designer, refer to the online help or click Start > StarTeam > StarTeam Layout Designer > Documentation.

The Layout Designer provides the ability to customize forms within the application. Custom property-editor forms can be used for any item-type to show custom properties, hide default properties that are not of interest to your organization, or rearrange the interface to more closely meet your organization's requirements.

For example, you can design a Change Request Properties dialog box that has custom fields on its first (or perhaps only) tab. You usually install the Layout Designer on workstations of administrators who will design custom property editors.

Only in the StarTeam Web Client, Property editors designed with Layout Designer can be used with the custom workflow rules created with StarTeam Workflow Designer (for StarTeam Enterprise Advantage). In the StarTeam Cross-Platform Client, Layout Designer forms only arrange properties for the user's convenience. APEs are written to support the workflow rules. For more information about APEs, see the Workflow Extensions Guide that installs with StarTeam Workflow Designer.

StarTeam Layout Designer System Requirements

The Layout Designer can be installed on Microsoft Windows systems that support the Java Runtime Environment (JRE) 1.8.0_51. The system requirements are listed below:

**Software**

**Operating Systems (32-bit)**
- Microsoft Windows 8
- Microsoft Windows XP Professional SP3
- Microsoft Windows Vista SP1
- Red Hat Enterprise Linux (WS) 5.1

**Hardware**

**Processor**
32-bit dual core

**RAM**
2 GB minimum

**Hard disk space**
200 MB to install the application. Also, sufficient disk space is required for your working files. The amount will vary depending on your use of the product.

**Display**

**Required**
SVGA, high color mode, 1024x768

**Recommended**
1280x1024 or more

**Mac Models**
- MacBook (Early 2015).
- MacBook (Late 2008 Aluminum, or Early 2009 or newer).
- MacBook Pro (Mid/Late 2007 or newer).
- MacBook Air (Late 2008 or newer).
- Mac mini (Early 2009 or newer).
- iMac (Mid 2007 or newer).
- Mac Pro (Early 2008 or newer).
Installing the Layout Designer

To install the Layout Designer on Microsoft Windows follow the steps below.
To install Layout Designer on Linux, extract the downloaded tar.gz file.

**Note:** Before you install the Layout Designer, verify that the StarFlow Extensions project exists on the server on which the form will be developed and used.

1. Log on to the computer as the administrator or as a user with administrative privileges.
2. Navigate to the directory that contains the downloaded files.
3. Run the downloaded installer.
4. Select a language from the list, and then click **OK**.
5. On the **Introduction** page, read the information, and click **Next**.
6. On the **License Agreement** page, read the agreement. If you agree with the license agreement, click **I accept...**. If you do not accept the license agreement, you cannot install the product.
7. On the **Choose Install Folder** page, browse for the location to be used as the installation folder. The default installation path is `C:\Program Files\Borland\StarTeam Layout Designer`.
8. In the **Choose Shortcut Folder** dialog box, use the default setting (that is, keep the Other option button set to `C:\Documents and Settings\All Users\Start Menu\Programs\Borland StarTeam \StarTeam Layout Designer`).
9. On the **Pre-installation Summary** page, review the settings and click **Previous** one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click **Next** or **Install**.
10. On the **Install Complete** page, click **Done**.
StarTeam Workflow Extensions Installation

This chapter explains how to install the following StarTeam Workflow Extensions components:

- Workflow Extensions
- Workflow Designer
- Notification Agent

These components are for StarTeam Enterprise Advantage only. See the StarTeam Workflow Extensions Guide for complete information about how to configure and use these Workflow Extensions.

**Note:** This product is only available in English.

Workflow Extensions

Workflow is a comprehensive term to explain a process by which members of an organization complete complex tasks. Whether your organization uses formalized or ad hoc workflows, there is a process or pattern by which work is accomplished. One employee begins a task and passes it along to someone else for review. That person gives the project to yet a third person to finalize and then it goes back to person number two for final review, and so on. Workflow software can automate workflow by providing automatic notification of responsibility, by presenting only appropriate options at each step in the process, and by assuring that items are acted upon in a timely manner.

The products, tools, and features Workflow Extensions provides to set up and maintain workflow processes are described in the following sections.

Extensions

StarTeam Extensions include:

- Alternate Property Editors (APEs), forms written in Java, replace the standard properties dialog boxes that come with each component of the application.
- A workflow engine that reads the appropriate `.Workflow.xml` file and populates the APEs.
- A toolbar that can be used with the StarTeam Cross-Platform Client to start applications that add new features to the application.
- Various other utilities and libraries written in Java.

Workflow Designer

You must use Workflow Designer to develop custom workflows. Workflow Designer outputs `.xml` files that formalize the steps in a workflow, specifies who will be notified about each step and about exceptions, and so on. Each file is named `item_type.Workflow.xml` and can be used for an entire project or individual views within that project. The StarTeam Extensions workflow engine and StarTeam Notification Agent read from these files.

Workflow Designer can be installed separately on any workstation.

Notification Agent

The StarTeam Notification Agent monitors server configurations to determine who needs to be notified about work to be performed and about exceptions that occur in the workflow process. It must be installed and set up separately. It is usually installed on the computer that runs the StarTeam Server, but it can be
installed anywhere. When the StarTeam Notification Agent is not on the same computer as the StarTeam Server, the two computers’ clocks must be synchronized. The StarTeam Notification Agent’s time cannot be ahead of the StarTeam Server’s time.

When changing the enumerated values for fields used to control notification (for example, when updating the workflow for a project or view), restart the Notification Agent so that it updates its cache.

StarTeam Workflow Extensions System Requirements

<table>
<thead>
<tr>
<th>Extensions and the Workflow Designer</th>
<th>They have the same system requirements as the StarTeam Cross-Platform Client.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Agent</td>
<td>Has the same system requirements as the StarTeam Server.</td>
</tr>
<tr>
<td></td>
<td>We recommend installing the StarTeam Server prior to installing the StarTeam Notification Agent.</td>
</tr>
</tbody>
</table>

Extensions Installation Strategies

Files from StarTeam Extensions need to be installed and then checked in to the StarFlow Extensions project in each server configuration that uses alternate property editors (APEs) and workflows. If the StarTeam Server configuration does not already have a StarFlow Extensions project, you need to add one and all users need to have read access to the files in it. Administrators can have read/write access.

The default installation folder is C:\Program Files\Micro Focus\StarFlow Extensions, but we recommend copying the runtime files to a different folder for each server configuration. For example, you might use C:\config_name\StarFlow Extensions. In this way, you can ensure that each configuration’s StarFlow Extensions project has different working folders.

Even if you currently run only one server configuration, it is wise to plan ahead. This also ensures that, when you upgrade or reinstall for some other reason, you are unlikely to overwrite any StarTeam Extensions files that you are using.

Note: If you are using the default installation folder for any server configuration’s StarFlow Extensions project, we recommend that you check in everything you need that is not current prior to reinstalling or upgrading StarTeam Extensions files.

Installing Extensions

To install Extensions on Linux or systems that support Java, extract Extensions-14.0-LINUX.tar.gz or Extensions-14.0-UNIX.tar.gz.

To install Extensions on Microsoft Windows:

1. Run the downloaded installer.
2. On the Introduction page, read the information, and click Next.
3. On the License Agreement page, read the agreement. If you agree with the license agreement, click I accept... If you do not accept the license agreement, you cannot install the product.
4. On the Choose Install Folder page, browse for the location to be used as the installation folder. The default installation location is C:\Program Files\Micro Focus\StarFlow Extensions.
5. Click Next.
6. On the Choose Install Set page, choose your preferred options:
**Runtime**

Installs the files that are critical to each server configuration that uses workflow, APE forms, and/or custom tools. The Runtime should be installed on the same computer as the StarTeam Server. The Runtime consists of the StarFlow Extensions folder and two subfolders:

- The **Client** folder contains the files that are normally installed with one or more of the clients as well as with StarTeam Extensions. If a user is having problems with an APE, give that user the latest files from the Client folder in the StarFlow Extensions project. It may solve the problem. `starteam-extensions.jar` provides the Locator functionality (the retrieving of workflow and APE files) in conjunction with `Locator.exe`. The `starteamextensions.jar` file is installed with both the StarTeam Cross-Platform Client and the Microsoft Visual Studio integration. The Locator files are installed only with the Microsoft Visual Studio integration.
- The **Projects** folder contains a variety of .jar, .xml, and .dll files used by StarTeam Extensions.

Although the Runtime includes a custom toolbar that can be used with the StarTeam Cross-Platform Client, if you will be writing applications for the toolbar or adding buttons to the toolbar, you should seek assistance from Micro Focus Technical Support.

**Samples**

The Samples can be installed on any computer for your convenience. You do not need to copy these to each server configuration’s StarFlow Extensions folder, nor do you need to check them in.

If you decide to use some of the sample APE forms, as they are or after some modification, you would copy the `item_type.Workflow.xml`, `name.propertyeditor.xml`, and `name.jar` files to a server configuration’s StarFlow Extensions\Projects folder or an appropriate subfolder of the Projects folder. Then you would check these files in to the StarFlow Extensions project. `item_type` is a type of StarTeam item such as `ChangeRequest` or `Requirement`.

If you decide to use some of the sample tools, as they are or after some modification, you must also copy the `name.tool.xml` and the `name.jar` files to the Projects folder. See the *Workflow Extensions Guide* for more information.

**API Documentation**

Adds the `Documentation` subfolder to the installation folder. The Documentation can be installed on any computer for your convenience. You do not need to copy this folder to each server configuration’s StarFlow Extensions folder, nor do you need to check its files in. These online documents (.html files) explain the APIs for the APEs and the custom toolbar.

7. Click Next.

8. On the **Choose Shortcut Folder** page, use the default settings. Keep the Other option button set to C: \Documents and Settings\All Users\Start Menu\Programs\StarTeam\StarTeam Extensions.

9. Click Next.

10. On the **Pre-installation Summary** page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click Next or Install.

11. On the **Install Complete** page, click Done. After installing Extensions Runtime:

   - Copy the StarFlow Extensions folder and its subfolders (Client, Projects, and Utilities) to a unique location for each server configuration.
   - Use the StarFlow Extensions folder (in its new location) as the root folder for the StarFlow Extensions project that you create for each server configuration.
- Add the files in these folders to the StarFlow Extensions project, except for PDFs and readmes.

If you are already using StarTeam Extensions, check in these files as new revisions of existing files and add any new files.

**Installing Workflow Designer**

You must use Workflow Designer to develop custom workflows. Workflow Designer outputs .xml files that formalize the steps in a workflow, specifies who will be notified about each step and about exceptions, and so on. Each file is named $item_type.Workflow.xml$ and can be used for an entire project or individual views within that project. $item_type$ is a type of StarTeam item such as Change Request or Requirement. The StarTeam Extensions workflow engine and StarTeam Notification Agent read from these files.

Workflow Designer can be installed separately on any workstation.

To install Workflow Designer on Microsoft Windows:

1. Run the downloaded installer. To install on Linux, extract the downloaded tar.gz file.
2. On the **Introduction** page, read the information, and click **Next**.
3. On the **License Agreement** page, read the agreement. If you agree with the license agreement, click **I accept**... If you do not accept the license agreement, you cannot install the product.
4. On the **Choose Install Folder** page, browse for the location to be used as the installation folder. The default is C:\Program Files\Micro Focus\StarTeam Workflow Designer.
5. On the **Choose Shortcut Folder** page, use the default settings. Keep the **Other** option button set to C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus\StarTeam Workflow Designer).
6. On the **Pre-installation Summary** page, review the settings and click **Previous** one or more times if you want to change the installation options. Then return to the **Pre-installation Summary** page, and click **Next** or **Install**.
7. On the **Install Complete** page, click **Done**.

**Installing the Notification Agent**

The Notification Agent monitors server configurations to determine who needs to be notified about work to be performed and about exceptions that occur in the workflow process.

You must install and configure Notification Agent separately. It is usually installed on the computer that runs the StarTeam Server, but can be installed anywhere. When Notification Agent is not on the same computer as the Server, the two computers clocks must be synchronized. Notification Agent's time cannot be ahead of the Server's time. When both are installed on the same computer and run as services, Notification Agent must be run as a dependent service and be shut down first. See *Running Notification Agent as a Service* in the *Workflow Extensions User's Guide* for more information.

To install the Notification Agent on Microsoft Windows:

1. Run the downloaded installer.
2. On the **Introduction** page, read the information, and click **Next**.
3. On the **License Agreement** page, read the agreement. If you agree with the license agreement, click **I accept**... If you do not accept the license agreement, you cannot install the product.
4. On the **Choose Install Folder** page, browse for the location to be used as the installation folder. The default is C:\Program Files\Micro Focus\StarTeam Notification Agent.
5. On the **Choose Shortcut Folder** page, use the default settings. Keep the **Other** option button set to C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus\StarTeam Notification Agent).
6. On the Pre-installation Summary page, review the settings and click Previous one or more times if you want to change the installation options. Then return to the Pre-installation Summary page, and click Next or Install.

7. On the Install Complete page, click Done.
Installing StarTeam Visual Studio Plugin

**Important:** If you plan to install the StarTeam Visual Studio Plugin as a replacement for a previous release of this integration, you must first uninstall the pre-existing integration. This release is not an upgrade installation. It is a replacement installation.

1. Close all running applications after saving all modified files.
2. Launch the executable (.exe) file.
3. Follow the installation instructions provided by the install wizard.

Installing StarTeam Visual Studio Plugin Help in Microsoft Visual Studio 2010

Prior to installing the integration executable:

2. Choose **Help > Manage Help Settings**. The **Set Local Content Location** dialog opens.
3. Set the default library location.
4. Choose **Help > Manage Help Settings**. The **Help Library Manager** opens.
5. Click **Choose online or local help**.
6. Click **I want to use local help**.

Installing StarTeam Visual Studio Plugin Help in Microsoft Visual Studio 2012

Prior to installing the integration executable:

2. Choose **Help > Add and Remove Help Content**. The **Add and Remove Content** dialog opens with the **Manage Content** tab selected.
3. Ensure the default library location is set in the Local store path.
StarTeam Eclipse Plugin Installation

Topics in this section will show you how to install, uninstall, and disable your StarTeam Eclipse Plugin.

Installing the StarTeam Eclipse Plugin

You must have supported Eclipse version installed before proceeding with the installation of the StarTeam Eclipse Plugin. Once the Eclipse IDE is installed, the StarTeam Eclipse Plugin can be installed by downloading the executable file to run the Install Anywhere wizard.

Note: When installing or uninstalling on a non-Microsoft Windows platform, you must specify which installed Java VM to use as a parameter. This is because Java VM for non-Microsoft Windows operating systems is not bundled with the installer. Add the LAX_VM parameter to the installer or uninstaller and specify the path to your VM. For example: .//StarTeamEC.bin LAX_VM/usr/java/latest/jre/bin/java.

Note: For a ZIP file installation, unzip the file and then use the following directions. Specify the local location where you unzipped the file.

1. Close all running applications after saving all modified files.
2. Choose Help > Install New Software... The Install dialog box appears.
3. Click Add button. The Add Site dialog appears.
4. Enter the name.
5. Enter the following value in the Location field: http://altd.borland.com/update/eclipse4.3.
6. Click OK. The new site is displayed in the Install table.
7. Select StarTeam plugin and click Next. The Install Details page appears.
8. Click Next. The Feature License page appears.
9. Click the license selection and click Next.
10. Click Finish.

Tip: When you start using the product, Link with Selection overrides the Connect to StarTeam Server setting Never. If you click Link with Selection, StarTeam assumes you want to automatically connect to the StarTeam Server and refresh your view when you select a shared folder or item in a view such as the Change Request, Topic, Task, or Requirement view.

Uninstalling the StarTeam Eclipse Plugin

Before installing this release, it is recommended that you disable or uninstall StarTeam Eclipse Plugin. We recommend this step to avoid confusion between the menu options offered between the two clients.

Note: When installing or uninstalling on a non-Microsoft Windows platform, you must specify which installed Java VM to use as a parameter. This is because Java VM for non-Microsoft Windows operating systems is not bundled with the installer. Add the LAX_VM parameter to the installer or uninstaller and specify the path to your VM. For example: .//StarTeamEC.bin LAX_VM/usr/java/latest/jre/bin/java.

1. Run the StarTeam Edition <version> Eclipse Client uninstall program.
2. Follow the on-screen instructions provided by the wizard.
Disabling StarTeam Eclipse Plugin

1. Click Help > Software Updates > Manage Configuration from the Eclipse main menu. The Product Configuration dialog box opens.
2. Select <Drive Letter>:\Program Files\Borland\StarTeam <version> Eclipse Client \eclipse from the list on the left of the dialog box.
3. Select Disable from the Available Tasks list.
4. In the resulting dialog box, click OK to accept the changes.
5. Restart Eclipse.

💡 Tip: You can later re-enable StarTeam Eclipse Plugin by following the steps above and choosing Enable from the Available Tasks list in the Product Configuration dialog box.
Datamart Installation

This section explains how to install Datamart Extractor and Datamart Synchronizer. Datamart Extractor is typically installed on a dedicated machine, not the same machine where StarTeam Server is installed, or where the extracted database is.

Note: Datamart Extractor and Synchronizer are only supported on Microsoft Windows.

1. Close all running Microsoft Windows applications.
2. Run the downloaded installer.
3. Click Install Datamart.
4. In the Introduction page, read the information, and click Next. The License Agreement page opens.
5. Read the agreement. Click I accept.... and then Next. The Choose Install Folder page opens.
6. Enter or browse to the location you want to use as the installation folder (the default location is C:\Program Files\Micro Focus\Datamart).
7. Click Next. The Choose Shortcut Folder page opens.
8. Click Other to select the default setting (set to C:\Documents and Settings\All Users\Start Menu\Programs\Micro Focus\Datamart).
9. Click Next. The Pre-Installation Summary page opens.
10. Review the settings and click Install. (If you need to change a setting, click Previous one or more times and make any necessary changes. Then return and click Install.) The Install Complete page opens.
11. Click Yes, then click Done. You may be prompted to restart your system. Datamart is installed in the specified folder, and the StarTeam_Datamart_Extractor_InstallLog.log file in that folder documents all of the events that occurred during the installation process.

StarTeam Quality Center Synchronizer Installation

To install the Synchronizer, run the file ST_QC_Synchronizer.exe and follow the onscreen directions. ST_QC_Synchronizer.exe is a self-extracting executable that, by default, creates a folder named StarTeam Synchronizer in your Temp folder. It also adds files like setup.exe, which automatically installs the integration files and runs the self-extracting executable StarTeam-runtime.exe. StarTeam-runtime.exe installs the StarTeam SDK, which enables the integration to access the StarTeam Web Server.

If you are using the StarTeam Web Server for Microsoft Windows and installing over a previous version of the Synchronizer, the installer renames the following files to preserve any changes you might have made to them:

- BugSync.ini becomes BugSync.000.
- run.bat becomes run.000.
- run-again.bat becomes run-again.000.
These installation notes provide instructions for installing TeamInspector on a Microsoft Windows or a Linux host. It is recommended that you turn off all anti-virus software and close all applications before installation for best results. See the Release Notes for any known issues with the installation process.

Prerequisites

In preparation for the installation, review the following prerequisite guidelines:

1. TeamInspector runs in an existing build environment:
   - The SCM systems you are using with your builds must be installed, set up, and available.
   - The build tools you are using for your builds must be installed on your build servers and configured for your build executions.
   - Any test and analyzer tools you intend to use must be installed and configured for your builds.

2. You can use an Apache Derby database to store the TeamInspector data. Oracle 10g and SQL Server 2005 are also supported. The database you intend to use for the TeamInspector data repository must be set up and ready for use before you start the installation. You can download Derby from the Apache DB Project download site if you do not have a database application already installed to use for TeamInspector. Instructions for installing Apache Derby are provided in the next section.

   If you are upgrading TeamInspector and using Derby for the new version, you must run the migration script before starting the TeamInspector installation. See the section Upgrading a TeamInspector Installation for details about migrating data from your existing installation to the current installation.

3. If you are installing TeamInspector on a remote job server, the database connection information is required by the job service on every system on which TeamInspector is installed.

4. TeamInspector uses the Apache FTP services and automatically sets a default port of 21 to use for this service. If you anticipate a conflict with this port setting, you can change it on the Configuration page when you log on to TeamInspector after setup is complete.

5. You must satisfy the following requirements for the software configuration management (SCM) systems that you intend to use with TeamInspector:
   - If you are using Subversion, the SVNKit toolkit must be installed on the TeamInspector servers and the SVNKit JAR files must be extracted and accessible to TeamInspector. To access the SVNKit JAR files, use the settings in the TeamInspector env-settings.conf file. For more information about configuring these requirements, see Configuring Subversion Settings in the online help.
   - If you are using a Perforce SCM system with your builds, the Perforce Command Line Client (P4 client) must be installed on all the servers (master server and job servers) on which TeamInspector is installed in your build environment. The P4 client must be available to TeamInspector through the system path. The path can be specified in the env-settings.conf file, located in the conf directory. For more information about configuring these settings, see Configuring Perforce Settings in the online help. See the Release Notes for more information about this requirement.
   - If you are using an IBM Rational ClearCase SCM system with your builds, the ClearCase Remote Client must be installed on all systems on which you install TeamInspector, and you must make the
TeamAPI jar files available to TeamInspector. For more information about configuring the settings for a ClearCase SCM system, see Configuring ClearCase Settings in the online help.

- If you are using a StarTeam SCM system, the StarTeam SDK must be installed on all systems on which you install TeamInspector and the SDK JAR files must be accessible to TeamInspector. You can configure the location of the JAR files by using the settings in the env-settings.conf file in TeamInspector to interact with your StarTeam SCM system. For more information about configuring these requirements, see Configuring StarTeam Settings. See the Release Notes for more information about this requirement.

Installing and Creating a Derby Database

Use these instructions if you want to download and install the latest version of Apache Derby to set up the TeamInspector data repository. If you already have Derby installed outside of your TeamInspector installation, or are using Oracle or Microsoft SQL Server for the data repository, you can skip these instructions.

2. Extract the files into the directory that you have created for the Derby database. For example: C:\Derby.
3. Set the DERBY_HOME system variable to the location of your Derby installation. For example: C:\Derby\db-derby-10.4.2.0-bin.
4. Add the Derby executable path (for example, %DERBY_HOME%\bin) to your PATH statement.

   Note: If you are upgrading an existing TeamInspector installation, skip the remaining steps and go to the Upgrading a TeamInspector Installation section.

5. Run the Derby ij tool to create a database for TeamInspector to use:

   ij

6. Create a database and specify the administrative user account for TeamInspector to use to connect to the database, using the following syntax as an example:

   ij> connect 'jdbc:derby:<full path database name>;create=true;territory=en_US;collation=TERRITORY_BASED;user=<admin user name>;password=<admin user password>';

7. After the database is created, specify the Derby "Builtin" authentication and grant full access to the user account you created in the above step, using the following syntax as an example:

   ij> call SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.connection.requireAuthentication','true');
   ij> call SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.authentication.provider','BUILTIN');
   ij> call SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.user.<admin user name>', '<admin user password>');
   ij> call SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.database.fullAccessusers', '<admin user name>');

8. Exit the ij tool:

   ij> quit;

9. Run the following setup script from your Derby bin directory to enable remote hosts to connect to your TeamInspector database:

   setNetworkServerCP

10. Start the Derby network server:
StartNetworkServer -p <port_number> -h <hostname>

**Note:** Port number is the connection port for your Derby server. Derby uses 1527 as the default port assignment. If you specify `localhost` for the hostname, only TeamInspector on the local server can connect to the database, restricting any other TeamInspector server from using the database.

**Note:** Any time the Derby Network Server is restarted, the TeamInspector services must also be restarted. If you are performing an upgrade, you will need to restart the Derby Network Server after running the migrate script. See the upgrade instructions for further details.

## What to Expect During the Installation Process

During installation, TeamInspector performs the following tasks:

- Creates a default location for the installation directory (if none is specified).
- Installs and initializes the Master Services: master service and web service (TeamInspector installs a version of Apache Tomcat for its use).
- Installs and starts the job service (installed and started along with the Master Services if all components in the Full Installation Set are selected).
- Presents a summary of your installation selections for your review.
- Prompts for information to establish the connection to the database host that you intend to use for the TeamInspector data repository.
- Copies the installation files and completes the installation process.

**Note:** If any of the services fail to start during initialization, use the cycleservices command to restart services. If running TeamInspector on a Linux system, run the cycleServices.sh command and then refresh the environment variables after restarting the services. The database that you are using for the TeamInspector repository must be running before starting the TeamInspector installation. For example, if using Derby, the Derby Network Server must be started.

## Installing on Microsoft Windows

1. Go to the directory where you extracted the download file.
2. Click TeamInspector.exe to start the installation wizard.
3. Click Next in the Introduction screen.
4. Click OK to confirm a new install.
5. View the license agreement. You must accept the license agreement to continue.
6. Specify an installation directory by using the Browse button, or click Next to accept the default directory.
7. Choose an installation set. Select Full to install all the TeamInspector services on the local host. Make sure both the Master Service and the Job Service is checked for the Full install. Select Custom to install the Master Services and the Job Service separately (for example, when installing the job service on a remote build server).
8. Review the installation summary and then continue following the prompts.
9. In the Database Connection screen, enter the database server information to specify the type and location of the database that is to be used for the TeamInspector data repository. For example, if you intend to use a Derby database, enter the appropriate values for the server host, port number, and database location. You must enter the fully qualified path, including the database name, to the host system.
• If you are using Microsoft SQL Server, select the **Microsoft SQL Server** option and enter the server name, database name, the database user name and the password. You must also enter either the port number of the database service or the database instance name.

• If you are using Oracle, select the **Oracle** option and enter the server name, system ID (SID), database user name and the password. The port number is optional.

10. Click **Next** to continue.

11. When the **Install Complete** screen appears, click **Done** to complete the installation.

12. Go to the **Configuration** section to begin configuring TeamInspector.

### Installing on Linux

1. Log on to the system as root user.
2. In the command-line shell, change to the directory in which you downloaded and extracted the installation file.
3. At the prompt, type `. /teaminspector.bin` to start the installation wizard.
4. Click **Next** in the Introduction screen and view the license agreement. You must accept the license agreement to continue.
5. Specify an installation directory by using the **Browse** button, or click **Next** to accept the default directory.
6. Choose an installation set. Select **Full** to install all the TeamInspector services on the local host. Make sure both the **Master Service** and the **Job Service** is checked for the **Full** install. Select **Custom** to install the Master Services and the Job Service separately (for example, when installing the job service on a remote build server).
7. Review the installation summary and then continue following the prompts.
8. In the **Database Connection** screen, enter the database server information to specify the type and location of the database that is to be used for the TeamInspector data repository. For example, if you intend to use a Derby database, enter the appropriate values for the server host, port number, and database location. You must enter the fully qualified path, including the database name, to the host system.

• If you are using Microsoft SQL Server, select the **Microsoft SQL Server** option and enter the server name, database name, the database user name and the password. You must also enter either the port number of the database service or the database instance name.

• If you are using Oracle, select the **Oracle** option and enter the server name, system ID (SID), database user name and the password. The port number is optional.

9. Click **Next**.

10. Restart your system or refresh the system environment to update the environment variables.

11. Go to the **Configuration** section to begin configuring TeamInspector.

### Upgrading an Installation

If you are upgrading from an earlier version to the current version, use the following information to complete a successful installation:

• TeamInspector automatically installs to the same installation path as your current installation.

• User interface settings, such as customized views, filters, and other options, are persisted during an upgrade or reinstallation. To clear these settings, remove the TeamInspector cookie (localhost) in your browser settings.

• If you are upgrading TeamInspector and plan to use Derby to store TeamInspector data, use the one-time migration script provided by TeamInspector to move the existing TeamInspector repository (tidb database) from the current location within TeamInspector (default location is **%TEAM_INSPECTOR_HOME**).
to the specified new location in your Derby installation. You must run the migration script before starting the TeamInspector installation. The migration script is currently provided for Microsoft Windows-hosted installations only. See Upgrading Your Installation Using the Derby Migration Utility in the next section for further instructions. Make sure the Derby Network Server is started on the database host before starting the TeamInspector installation to ensure that the connection to the data repository gets established during installation.

**Note:** If you are upgrading your TeamInspector installation on a Linux host, contact a support representative for assistance in migrating your TeamInspector data before starting the installation.

- If you are upgrading TeamInspector and plan to use an Oracle or a Microsoft SQL Server database to store data, you must first uninstall TeamInspector and then perform a new installation. Your database must already be set up and running before starting the TeamInspector installation so that you can specify the database or instance to use with TeamInspector.

### Upgrading Your Installation Using the Derby Migration Utility

To upgrade an existing installation on a Microsoft Windows host, use the migration utility to move the existing `tidb` database to your Derby installation and preserve your existing data:

1. Make sure you have the Derby database application installed and the database you intend to use for TeamInspector created. If you need installation instructions, see steps 1-4 in Installing and Creating a Derby Database to use with TeamInspector above.

2. Make a backup copy of the `tidb` database located in the TeamInspector installation directory by copying the entire `tidb` folder in `TEAMINSPECTOR_HOME\data` to a location outside of the TeamInspector installation path. TeamInspector removes the database previously installed for the TeamInspector data-store repository and requires an external database to store TeamInspector data.

3. Run the migration script provided in the top level directory of your extracted installation files using the following example syntax:

   ```
migrate-derby.bat  \[<new Team Inspector database drive>:<new Team Inspector database path and name>]
   ```

   For example:

   ```
migrate-derby.bat c:\Derby\data
   ```

   The new directory path specified in the script argument must exist before running the script. TeamInspector does not create the directory.

   **Note:** If you want to move the database to a remote server (other than the TeamInspector server), you must first map the drive of the remote server you intend to specify in the migration script argument and make sure that the mapped drive has write privileges.

4. Run the setup script from your Derby bin directory to enable remote hosts to connect to your TeamInspector database.

   ```
   setNetworkServerCP
   ```

5. Start the Derby Network Server for your Derby installation, if not already started:

   ```
   startNetworkServer -p <port number> -h <Derby server>
   ```

   Where `port number` is the connection port for your Derby server. Derby uses 1527 as the default port assignment. `Derby server` is the server address or server hostname where Derby resides.

   **Note:** If you specify `localhost` for the Derby hostname, only TeamInspector on the local server can connect to the database, restricting any other TeamInspector server from using the database.

   If you start the Derby server from the command-line, the command-line window must remain active. Alternatively, you can start it as a service. The following link describes several methods for creating a `DerbyWindowsService` and provides an example for using the Java Service Wrapper (jsw) to create the service: [http://wiki.apache.org/db-derby/DerbyWindowsService](http://wiki.apache.org/db-derby/DerbyWindowsService)
6. Start the TeamInspector installation by going to the directory in which you downloaded and extracted the product files and run the executable: `TeamInspector.exe`. When the installation program starts, follow the prompts in the installation wizard. When the prompt for the Database Connection information is presented, update the values to point to your Derby database installation and the database that you have created to use with TeamInspector.

7. After the installation program has completed, locate the `env-settings.conf` file in the `conf` directory of your installation and update the file to specify your SCM settings. TeamInspector does not change your settings in the `env-settings.conf` file on an upgrade, and instead provides the settings required in this version in a default file, `env-settings.conf.default`. To configure your SCM systems for use with TeamInspector, update your `env-settings.conf` file by copying the appropriate SCM sections from the `env-settings.conf.default` file and following the instructions in that file to uncomment and update the settings for your environment.

8. TeamInspector preserves your existing configuration settings on an upgrade; no further configuration is needed. You can launch TeamInspector and view the online help if you need additional information about getting started or using TeamInspector.

### Configuring TeamInspector

Before you can use TeamInspector, the following tasks are required to configure TeamInspector and begin setting up the environment.

1. Set up LDAP authentication for TeamInspector users by modifying the `configuration.properties` file (located in the `conf` directory), and specifying the appropriate values for the following LDAP settings:

   - **ldap_server**: Name or address of the LDAP server in your environment containing the user entries against which your TeamInspector users will be validated.
   - **ldap_port**: Port number to use to connect to the LDAP server.
   - **ldap_server_dn**: Base object in the distinguished name hierarchy, such as a domain name.
   - **ldap_manager_dn**: LDAP user name to use for binding to the LDAP server.
   - **ldap_manager_password**: Password for the LDAP user bind account.
   - **ldap_user_search_filter**: Search string that will be used to locate user entries on the LDAP server during authentication, or leave the default entry if applicable (if you are using an LDAP system that supports Windows Active Directory).
   - **ldap_user_search_timeout_in_millis**: You can accept the default value of 10000 milliseconds (10 seconds) or enter a new value that is more appropriate for your environment. You must enter the value in milliseconds.

   After updating these entries, save the file and restart the TeamInspector services. See **Configuring LDAP Authentication** in the online help for more detailed information.

   **Note**: You must restart your TeamInspector services after modifying any configuration file or settings in TeamInspector.

2. If configuring on a Linux host, to customize your environment variable settings for TeamInspector, edit the `env-settings.conf` file, located in the `conf` directory. This file enables you to specify variables that are used exclusively by TeamInspector. The file provides sample entries that you can use to specify environment variables such as path statements that are used for build operations and required settings for configuring your SCM systems for use with TeamInspector.

3. Log on to TeamInspector using the TeamInspector Administrator account: `tiadmin/tiadmin`
**Note:** This is a super user account. We recommend changing the account password after completing these configuration steps. The password can be changed from the command line only. See *Changing the TeamInspector Admin Password* in the online help for instructions.

4. Create an Administrator user account using your LDAP credentials, or the LDAP credentials of the user who will be the TeamInspector administrator. You can use this account to perform administrative tasks, such as setting up projects which is required to create the build environment. You can also use this account to set up the TeamInspector users. See *Setting Up Users* in the online help for additional information.

5. Additional configuration is required to support the SCM systems that you plan to use for your builds and inspections in TeamInspector. See *Configuring SCM Environment Settings* in the online help for these requirements.

6. After you have completed these configuration tasks, you can log on and set up your TeamInspector build environment. For additional information about the setup tasks, see the *Getting Started* topics in the online help.

**Launching the Dashboard**

To launch the dashboard and log in, do one of the following:

- If logging on to TeamInspector on a remote server, enter the following URL:
  
  http://{machine hostname}:{port}/teaminspector

  Your machine’s hostname is the name of the TeamInspector server where the master service is installed. Use the default port number of 9080, unless you have assigned another port number to use for TeamInspector. See the *Known Issues* in the *Release Notes* for information about possible port conflicts.

- If logging on at the server on which the TeamInspector master service is installed, enter the following URL:

  http://localhost:9080/teaminspector

  **Note:** You must initially log on with the TeamInspector administrator account (tiadmin). After creating a user or users with administrative privileges, those users or the tiadmin user can configure TeamInspector.

**Uninstallation Instructions**

1. Log on to the server using the root user account or administrative account used to install TeamInspector.

2. Navigate to the Uninstall.TeamInspector directory in your TeamInspector installation.

3. Run the uninstall executable file:


4. When the uninstall wizard completes the tasks of removing the installation files, click **Done**. If you intend to reinstall TeamInspector, restart your system before starting the installation.

  **Note:** The uninstall program removes all TeamInspector components that are installed on the server. A partial uninstall, for example removing only the job service component, is not supported. The TeamInspector installer removes the TeamInspector database schema, but does not remove the database user name (siadmin) created by TeamInspector to access the database.
Troubleshooting Tips

Problems Accessing TeamInspector Services

TeamInspector initializes all services required to run the product during the installation process. These services include: master service, web service (Apache Tomcat service), and job service. For various reasons one or more of the services might fail to start at the time of initialization.

If you experience a problem when you start TeamInspector, such as an inability to access the user interface, perform tasks, view data, or run builds, verify that all the services are started on the servers on which TeamInspector is installed.

To start all the services, run the cycleServices command at the TeamInspector master server command-line. Run the command on any remote build servers on which the TeamInspector job service is installed, if the job service failed to start.

If you want more information about which services failed to start during initialization, view the wrapper logs. TeamInspector maintains a wrapper log for each service to record initialization events. For more information about these logs, see TeamInspector Log Files in the online help.

Upgrading an Installation on Linux

On a Linux server, if you run the TeamInspector installer a second or subsequent time from the same terminal session in which the initial installation was run, TeamInspector attempts another new installation, with unpredictable results. For example, if you want to run the installer to perform an upgrade and are in the session in which TeamInspector was installed earlier, TeamInspector starts a new installation and will fail to migrate any existing data created since the first installation. You might also experience a problem with installation if multiple users are logged on with the root account while you are installing TeamInspector.

The following tips serve as a guide to avoiding these installation issues:

• Ensure that you log on as root user to perform the installation.
• Before starting the installation, ensure that no other root users are logged on to the same session.
• Always log off your Linux session after installing TeamInspector.
• If you do not log off after installation, you must force a refresh of your environment variables to properly set the environment for TeamInspector.

Port Conflicts

The TeamInspector product uses port numbers in the 9000 series. For example, the TeamInspector web interface runs within Apache Tomcat and uses port number 9080 as the default port. If you encounter problems connecting to or using TeamInspector, verify that you do not have a port conflict.

You can change the port that TeamInspector uses for the web dashboard by modifying the server.xml file in the TeamInspector/tomcat/conf installation directory. Open this file and search for the entry port="9080". Change this to a port that is not in use, and is greater than 1024, and then restart the Apache Tomcat TeamInspector service. This service also uses port 9005 for local shutdown support.

During the installation process, TeamInspector sets a default port value of 21 for the FTP services it uses in remote build environments. Ensure that this port is not already in use in your environment. If a port conflict exists, you will experience problems retrieving the artifacts from TeamInspector builds that occur on remote build servers.

You can change the FTP port setting on the Configuration page in the TeamInspector Dashboard.
Reinstalling After Uninstalling
If you remove the product installation and the uninstall procedure does not complete successfully, it could result in problems when reinstalling. Use the following tips to ensure a successful uninstall procedure:

- On a Microsoft Windows server, restart your system after uninstalling to ensure that the installation is completely removed before reinstalling TeamInspector.
- On a Linux server, log off the terminal session after uninstalling or update your environment before reinstalling TeamInspector.

**Note:** Make sure you log on as root user to run the installation and uninstallation programs on Linux.

Removing a Job Service installation
If you have installed only the TeamInspector job service on a server, and run the uninstall program to remove the job service installation, the TeamInspector uninstall program might fail to remove all folders in the installation directory.

If you observe folders remaining in the TeamInspector installation directory after uninstalling the job service, manually remove the folders.
Configuring Microsoft SQL Server/Express Databases

This chapter explains how to create a new server configuration to use Microsoft SQL Server or Microsoft SQL Server Express. StarTeam Server stores everything except for file archives and server startup information in the database of your choice.

You can use the Microsoft Windows version of StarTeam Server with the supported Microsoft databases listed in Supported Databases.

This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with StarTeam Server and explains how to use them. For detailed information on Microsoft SQL Server performance tuning, consult your Microsoft SQL Server documentation.

Terminology

When this guide uses the terms "instance" and "database", it uses Microsoft terminology. When you install Microsoft SQL Server on a computer, you can install up to 16 instances of it. Each instance can manage a number of different databases. Each StarTeam Server configuration uses its own database. When you perform a typical installation of the StarTeam Server, you install one instance of Microsoft SQL Server Express.

Logging Onto Databases

It is highly recommended that you use a dedicated user account to run or log onto the databases used with StarTeam Server configurations. System administrator accounts usually have unlimited privileges. Any anomalies or errors that occur while you are logged in as the system administrator may result in unrecoverable damage to databases and other databases managed by the same database server.

Understanding the Encoding Differences

StarTeam Server sends data encoded as UTF-8. Microsoft SQL Server and Microsoft SQL Server Express do not support UTF-8 at the database level. They support nchar, nvarchar, and ntext to store fixed format Unicode data (UTF-16).

- UTF-8 is a variable length character set in which the characters can expand from one to six bytes depending on the language.
- UTF-16 is a fixed length encoding mechanism in which every character expands to two bytes. UTF-16 tends to use up more space than UTF-8 when applied to character sets in which one character always translates to one byte.

Because of how StarTeam Server encodes data, non-English data is human-readable from clients, but not from Microsoft SQL Server and Microsoft SQL Server Express.

Creating a Server Configuration (for an Existing Database)

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a StarTeam Server configuration using a previously created Microsoft SQL Server or Microsoft SQL Server Express database.

Database names should:
• Begin with a letter.
• Contain letters and numbers only.
• Not contain spaces.
• Not be a SQL reserved word such as create, delete, if, then, else, or goto.

Important: The Server Administration database options may fail to run for databases with names that do not follow these guidelines.

To create a server configuration using an existing database:

1. Start the Server Administration tool. Click Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
2. Click Server > New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the Configuration Name field. If you want the server configuration to have the same name as the database (a nice convention, especially if you have several server configurations), you must follow the database naming conventions explained at the beginning of this section.
   b) Type or click Browse to specify the Repository Path location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The Repository Path is also the location for the default hive.
   c) Select Microsoft SQL Server/SSE (the default) from the Database Type list.
   d) Uncheck the option to Create new StarTeam database, so that StarTeam Server will not automatically create the database for it.
   e) Create an initial hive for the Native-II vault by doing one of the following:
      - Accept the default settings
        Leave the Default option selected and proceed to the next step. With the default settings, StarTeam Server:
        • Creates an initial hive named DefaultHive.
        • Creates subfolders on the repository path named Archives and Cache to be used by the DefaultHive.
        • Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
        • Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
        • Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.
      - Specify custom values
        Select the Custom option and change any of the hive settings.
   f) Click Next, and enter the Database Server name, Database name, Database login name, and password in the appropriate text boxes.
   g) Optionally, if you are using a port other than the default, check Edit Database Port and type the port number in the text field.
   h) Click Verify Connection to test the connection. If the connection fails, review and change your settings.
   i) Click Finish. This action re-displays the Server Administration tool, which shows your new server configuration as a child of the Local node.

Note: In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your starteam-server-configs.xml file. For more information about this file, see the Server Administration Tool Help.

4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server configuration on a given computer must have a unique endpoint so it is recommended that you edit the default endpoint. To change the endpoint:
a) Select the server configuration.
b) Click the Start with Override button (or click Actions > Start with Override from the main menu). The Start with Override dialog box opens.
c) Enter the endpoint that you want to use in the TCP/IP Endpoint field, and click OK.

5. Be sure to configure your new server configuration (for information, see the Server Administration Tool Help) and plan a backup schedule for it.

Using a Microsoft SQL Server Database

If you will be using a Microsoft SQL Server database, you must complete the following tasks:

1. Install Microsoft SQL Server.

   **Important:** When you install a Microsoft SQL Server database instance, it defaults to the collation for the locale set for the operating system. This locale setting should be used so long as it is correct for your team. Otherwise, when you automatically create a database from StarTeam Server, you cannot provide a database name, user name, or password in your language.

2. Install StarTeam Server.

3. Create and start a StarTeam Server configuration.

   • If you want to automatically create the database, see Creating and Starting a Server Configuration.
   • Otherwise, see Creating a Database Manually.

If you plan to use a supported version of Microsoft SQL Server, see Connecting to Microsoft SQL Server Databases.

**Caution:** Please note the following:

• Never modify the database contents other than through a StarTeam Server client or the Server Administration Tool. Direct database manipulation is unsupported.

• Never modify vault files other than through a StarTeam Server client or the Server Administration Tool.

Connecting to Microsoft SQL Server Databases

StarTeam Server requires Microsoft SQL Server authentication to connect to Microsoft SQL Server databases, rather than the default Microsoft Windows authentication. If you install Microsoft SQL Server using the default settings for security and authentication, StarTeam Server will experience problems connecting to the database.

To specify the security to use when connecting to Microsoft SQL Server:

1. Start the Microsoft SQL Server Installation Wizard.

2. Go to the **Authentication Mode** page of the wizard.

3. Select **Mixed Mode** (Windows Authentication and SQL Server And Windows option button (instead of the Windows Only option).

4. Type and retype the password to use.

5. Click Next to complete the rest of the wizard.

Creating and Starting a Server Configuration

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a StarTeam Server configuration and start it for the first time. It
assumes that you want StarTeam Server to automatically create a Microsoft SQL Server or Microsoft SQL Server Express database. If that is not the case, see *Creating a Database Manually*.

Database names should:

- Begin with a letter.
- Contain letters and numbers only.
- Not contain spaces.
- Not be a SQL reserved word such as `create`, `delete`, `if`, `then`, `else`, or `goto`.

**Important:** The **Server Administration database** options may fail to run for databases with names that do not follow these guidelines.

To create a server configuration using an existing database:

1. Start the **Server Administration** tool. Click **Start** > **Programs** > **Micro Focus** > **StarTeam Server <version>** > **StarTeam Server**. The **Server Administration** tool opens.
2. Click **Server** > **New Configuration**. The **New Configuration** dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the **Configuration Name** field. If you want the server configuration to have the same name as the database (a nice convention, especially if you have several server configurations), you must follow the database naming conventions explained at the beginning of this section.
   b) Type or click **Browse** to specify the **Repository Path** location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The **Repository Path** is also the location for the default hive.
   c) Select **Microsoft SQL Server/SSE** (the default) from the **Database Type** list.
   d) Check the option to **Create new StarTeam database**, so that StarTeam Server automatically creates the database.
   e) Create an initial hive for the Native-II vault by doing one of the following:
      - **Accept the default settings**
        Leave the **Default** option selected and proceed to the next step. With the default settings, StarTeam Server:
          - Creates an initial hive named **DefaultHive**.
          - Creates subfolders on the repository path named **Archives** and **Cache** to be used by the **DefaultHive**.
          - Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
          - Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
          - Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.
      - **Specify custom values**
        Select the **Custom** option and change any of the hive settings.
   f) Click **Next**.
4. Enter the server and database information:
5. Enter the information for creating the data files and transaction logs, and click **Finish**.

**Note:** We recommend keeping the data files and transaction log files on different physical drives under their own disk controllers.

The default settings are appropriate for your use if you have fewer than 15 users and expect to store 1GB or less data.
If you are very familiar with Microsoft SQL Server and Microsoft SQL Server Express databases, you may choose to make some changes by first clearing the **Use Default Configuration** check box and then altering sizes and locations for data files and log files.

Use at least 3 data files and at least 3 transaction log files when creating a database, because Microsoft SQL Server and Microsoft SQL Server Express databases use a proportional fill strategy. This way all the files tend to become full at about the same time.

To avoid fragmentation, make the data files as large as possible, based on the maximum amount of data expected in the database.

The **Server Administration** tool displays your new server configuration as a child of the **Local** node.

**Note:** In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your `starteam-server-configs.xml` file. For more information about this file, see the **Server Administration Tool Help**.

6. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server configuration on a given computer must have a unique endpoint so it is recommended that you edit the default endpoint. To change the endpoint:
   a) Select the server configuration.
   b) Click the **Start with Override** button (or click **Actions > Start with Override** from the main menu). The **Start with Override** dialog box opens.
   c) Enter the endpoint that you want to use in the **TCP/IP Endpoint** field, and click **OK**.

7. Be sure to configure your new server configuration (for information, see the **Server Administration Tool Help** and plan a backup schedule for it.

---

**Windows Authentication Support for SQL Server**

The StarTeam Server database administrator should follow these steps to set up Windows authentication for SQL Server:

1. Create a domain service for StarTeam admin. For example: `service.starteamadmin`
2. Login to the StarTeam Server machine as an administrator and add that account to the administrator group.
3. Shutdown the StarTeam Server.
4. Login to SQL Server database machine and add the service account to SQL Server and change the db ownership to this account using the following script. The following script adds login `service.starteamadmin` to SQL Server.

```
Login as sa
Use master
GO
Create LOGIN [<domain name>\service.starteamadmin] FROM WINDOWS WITH DEFAULT_DATABASE=<starteam database name>
GO
Use <starteam database name>
GO
Exec sp_changedbowner [<domain name>\server.starteamadmin]
GO
```

Replace `<starteam database name>` with the StarTeam database name and `<domain name>` with the domain name.

5. Login back to StarTeam Server Production machine using the StarTeam service account.
   a) Go to Server Administration and open the configuration properties.
   b) Click on the **Database Connection** tab.
   c) Check the box **Use Windows Authentication** then click **Verify** to verify database connection.
d) Click OK.
e) Click the menu option Actions > Set to run as service.
f) Uncheck the localsystem account and define the service using StarTeam service account.

6. Make sure the user account settings are set to Never Notify.
7. Start the server.

Guidelines for Data Files and Transaction Logs

Based on the number of users, we suggest the following guidelines for data files and transaction logs. Your needs may be different from those shown in the following tables.

<table>
<thead>
<tr>
<th>Number of Users</th>
<th>Number of Data Files</th>
<th>Size of Each Data File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 15</td>
<td>3</td>
<td>50 MB</td>
</tr>
<tr>
<td>Between 15 and 50</td>
<td>3</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 51 and 100</td>
<td>5</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 101 and 300</td>
<td>7</td>
<td>500 MB</td>
</tr>
<tr>
<td>&gt;300</td>
<td>7</td>
<td>800 MB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of Users</th>
<th>Number of Log Files</th>
<th>Size of Each Log File*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 15</td>
<td>3</td>
<td>50 MB</td>
</tr>
<tr>
<td>Between 15 and 50</td>
<td>3</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 51 and 100</td>
<td>5</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 101 and 300</td>
<td>5</td>
<td>500 MB</td>
</tr>
<tr>
<td>&gt;300</td>
<td>6</td>
<td>500 MB</td>
</tr>
</tbody>
</table>

* The transaction log file sizes are relevant only if the transaction log backup is performed frequently.

Transaction log backups are essential. After a transaction is backed up, Microsoft SQL Server and Microsoft SQL Server Express databases automatically truncate the inactive portion of the transaction log. This inactive portion contains completed transactions and is no longer used during the recovery process. The basic advantage comes with the fact that Microsoft SQL Server reuses this truncated, inactive space in the transaction log instead of allowing the transaction log to continue to grow and use more space. This is a huge plus from a performance standpoint.

Allowing files to grow automatically can cause fragmentation of those files if a large number of files share the same disk. Therefore, it is recommended that files or file groups be created on as many different available local physical disks as possible. Place objects that compete heavily for space in different file groups.

Running SQL Scripts for Microsoft Databases

StarTeam Server comes with some SQL scripts written specifically for use with your database. These scripts help you maintain and tune StarTeam Server databases. You run some SQL scripts after installation, some on a weekly basis for database performance maintenance, and some scripts are run for you automatically by StarTeam Server.

The SQL scripts for Microsoft SQL Server and Microsoft SQL Server Express databases that you may run are located in the Borland\Hub <version>\DBScripts\Sqlserver_Scripts folder.
Note: The Sqlserver_Scripts folder contains several subfolders: Create_Stored_Procedures, Drop_Stored_Procedures, Install, Preinstall, Generic, and DW (for Data Warehouse). The scripts in these subfolders are run by StarTeam Server as needed. Never execute any of them directly from an external database user interface, such as SQL Query Editor.

The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency depending on the StarTeam Server usage at your facility. Run scripts at times when the server is least used, such as overnight or on weekends.

In addition to running these scripts, you should also run a Purge option from the Server Administration tool to remove deleted views from the database. We recommend purging the database after you have deleted one or more views from a project. See the Server Administration Tool Help for information on the Purge option.

<table>
<thead>
<tr>
<th>StarTeam Server Script Name</th>
<th>Run Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>starteam_sqlserver_dbcc.sql</td>
<td>Weekly</td>
</tr>
<tr>
<td>starteam_sqlserver_dbcc_reindex.sql</td>
<td>Twice a week (minimum)</td>
</tr>
<tr>
<td>starteam_sqlserver_dbcc_showc.sql</td>
<td>Twice a week (minimum)</td>
</tr>
<tr>
<td>starteam_sqlserver_dropall.sql</td>
<td>Only if necessary</td>
</tr>
</tbody>
</table>

Caution:
- Before running any of the StarTeam Server SQL scripts for a Microsoft SQL Server or Microsoft SQL Server Express database, ensure that the database compatibility mode is set correctly. For Microsoft SQL Server 2008-based configurations, set the database compatibility mode to 90.
- Be sure to backup your StarTeam Server database, as necessary, and verify these backups periodically. You should restore and test backups of your StarTeam Server project data on a test system. Restoring and testing your backups helps to ensure that your data is being backed up correctly.

To run a script for a Microsoft SQL Server or Microsoft SQL Server Express database:

1. Install SQL Server Management Studio or SQL Server Management Studio Express from Microsoft. Enter the result of your step here (optional).
2. Click Start > Microsoft SQL Server [or Microsoft SQL Server Express] > SQL Server Manager Studio [or SQL Server Manager Studio Express].
3. Design a new query or open an existing one in SQL Server Manager Studio.
4. Click Query > Connection > Connect to connect to the server that contains the StarTeam database you want to access.
5. Select the appropriate StarTeam Server database.
6. Open the tuning script, by choosing File > Open > foldername\classname.
7. Execute the script, by clicking the Execute button on the toolbar or by pressing F5.

SQL Scripts for Microsoft SQL Server and SSE Databases

starteam_sqlserver_dbcc.sql
Run: weekly.
This script rebuilds the database indexes and performs a consistency check on the database objects. This script builds the indexes and updates the statistics in the database distribution pages.

`starteam_sqlserver_dbcc_reindex.sql`
Run: at least twice a week.
This script rebuilds all the indexes in the database. It is extremely important to run this script routinely.

`starteam_sqlserver_dbcc_showcontig.sql`
Run: at least twice a week.
This script gives information on database fragmentation.

`starteam_sqlserver_dropall.sql`
Run: only if necessary.

**Caution:** Running this script deletes all StarTeam Server tables and the data they contain from the database. Use this script with extreme caution.

One use case example is if you migrate a StarTeam Server configuration to another database, you might use this script to remove tables from the original database. Another example is if you mistakenly add the StarTeam Server tables to a tablespace other than the StarTeam Server tablespace, use this script to remove them.

---

**Microsoft SQL Server Security**

SQL Server uses a standard security model that involves the following entities and concepts:

- **Securable** Represents a resource or target object that requires securing, such as a database view.
- **Principal** Represents a user who requests access to a resource.
- **Permission** Access type that is associated with securable. Permissions can be granted to or revoked from principals. For example, **Update** is a permission that is associated with a table (securable) named `R`. If **Update** on `R` is granted to a user (principal) named `U`, then `U` receives **Update** access on `R`.

Further, Microsoft SQL Server supports the following security principals at different levels:

- **Windows-level principals** Control access to SQL Server instances for Windows Local Login and Windows Network Domain Login.
- **SQL Server-level principals** Control access to Microsoft SQL Server instances for SQL Server Login.
- **Database-level principals** Control access to database instances for database users.

To access a Microsoft SQL Server instance, use a Microsoft Windows user name or a Microsoft SQL Server user name that was previously created in that server instance. After you log on, the user name represents you as your security principal at the server level.

If you try to use a specific database in the server, Microsoft SQL Server searches the appropriate database for any previous user who has been mapped to your user name. If Microsoft SQL Server locates such a user, the corresponding user name represents you as your security principal at the server level.
Creating a Database Manually

Despite the fact that StarTeam Server has automated Microsoft SQL Server and Microsoft SQL Server Express database creation, you may prefer to create your own. This makes more sense for Microsoft SQL Server because there are good tools for database creation.

It is very important that you use the directions in the following procedure.

Database names should:

• Begin with a letter.
• Contain letters and numbers only.
• Not contain spaces.
• Not be a SQL reserved word such as `create`, `delete`, `if`, `then`, `else`, or `goto`.

**Important:** The **Server Administration database** options may fail to run for databases with names that do not follow these guidelines.

To create your own Microsoft SQL Server or Microsoft SQL Server Express database:

1. Install Microsoft SQL Server or Microsoft SQL Server Express. If you plan to use a supported version of Microsoft SQL Server, be sure to review the section **Connecting to Microsoft SQL Server Databases**.
2. Install StarTeam Server. See the section **StarTeam Server for Windows Installation**.
3. Create a StarTeam Server database. Contact your database administrator about the specifics. Be sure that:
   • The database is owned by a StarTeam user.
   • The default database for the StarTeam user is the StarTeam database.
   • The database will fit the expected growth patterns for storing your StarTeam data. See **Guidelines for Data Files and Transaction Logs**.
   • The name of the database follows the conventions explained earlier in this section.
   • To create or upgrade the StarTeam database, the Microsoft SQL Server instance must have one of the following collations:
     • Latin1_General_CI_AI
     • SQL_Latin1_General_CP1_CI_AS
   On a Japanese double-byte operating system, where the default collation for the Microsoft SQL Server installation is not supported by StarTeam, you must use a named instance with one of the supported collations.

   **Note:** Microsoft SQL Server’s multi-instance feature supports the use of multiple instances in different locales on the same database server.
4. Create and start a StarTeam Server configuration. See **Creating a Server Configuration (for an Existing Database)**.

Understanding Collation

The physical storage of character strings in the supported versions of Microsoft SQL Server and Microsoft SQL Server Express databases is controlled by collations. A collation specifies the bit patterns that represent each character and the rules by which characters are sorted and compared.

Microsoft SQL Server supports objects that have different collations being stored in a single database. Separate Microsoft SQL Server collations can be specified down to the level of columns. Each column in a table can be assigned different collations.
In a computer, characters are represented by different patterns of bits being either ON or OFF. A program that uses one byte (eight bits) to store each character can represent up to 256 different characters. A program that uses two bytes (16 bits) can represent up to 65,536 characters.

Single-byte code pages are definitions of the characters mapped to each of the 256 bit patterns possible in a byte. Code pages define bit patterns for uppercase and lowercase characters, digits, symbols, and special characters such as !, @, #, or %. Each European language, such as German or Spanish, has its own single-byte code page. Although the bit patterns used to represent the Latin alphabet characters A through Z are the same for all the code pages, the bit patterns used to represent accented characters (such as é and à) vary from one code page to the next. If data is exchanged between computers running different code pages, all character data must be converted from the code page of the sending computer to the code page of the receiving computer. If the source data has extended characters that are not defined in the code page of the receiving computer, data is lost. When a database serves clients from many different countries, it is difficult to pick a code page for the database that contains all the extended characters required by all the client computers. Also, a lot of processing time is spent doing the constant conversions from one code page to another.

Single-byte character sets are also inadequate to store all the characters used by many languages. For example, some Asian languages have thousands of characters, so they must use two bytes per character. Double-byte character sets have been defined for these languages. Still, each of these languages have their own code page, and there are difficulties in transferring data from a computer running one double-byte code page to a computer running another.

For information about synchronizing collation settings with another Windows locale, see the following Microsoft site: http://msdn2.microsoft.com/en-us/library/aa176553.aspx.

How Is the Default Collation Selected?

Microsoft SQL Server Setup chooses the Windows collation that supports the Windows locale of the computer on which the instance of Microsoft SQL Server is being installed. If the computer is using the US English locale, the instance’s default collation is Latin1_General_CI_AS.

Important: On a Japanese double-byte operating system, where the default collation for the Microsoft SQL Server installation is not supported by StarTeam, you must use a named instance with one of the following supported collations.

- Latin1_General_CI_AI
- SQL_Latin1_General_CP1_CI_AS

The multi-instance feature of supported Microsoft SQL Server versions supports the use of multiple instances in different locales on the same database server.

Backing up Microsoft SQL Server Databases

This section outlines the backup options available to DBAs and makes recommendations for backing up the databases used by the server configurations. Be aware that these are just recommendations. Any finalized disaster recovery plan must be created by your organization in consultation with its IT infrastructure staff.

An application backup consists of backing up both the database and the application archive files and you have a choice between online and offline backups. If all of your archive files are in Native-II format, you can back up a server configuration online, without shutting it down or locking it. If your have a pre-2005 StarTeam Server release, you must convert older archives from Native-I to Native-II format prior to performing an online backup. Regardless of the StarTeam Server release, you must also set up your database for an online backup.

For server configuration online backups, it is essential to take full database and transaction log backups. The entire database can be recreated from a database backup in one step by restoring the database. The
restore process overwrites the existing database or creates the database if it does not exist. The restored
database will match the state of the database at the time the backup completed, minus any uncommitted
transactions. Uncommitted transactions are rolled back when the database is recovered.

Based on the resource requirements, the DBA can also choose the recovery model for the database. The
recovery model balances logging overhead against the criticality of fully recovering the data. The recovery
models supported by Microsoft SQL Server are:

**Full**
- The data is critical and must be recoverable to the point of failure. All data modifications are
  logged. All SQL Server recovery options are available.

**Bulk-logged**
- Certain bulk operations, such as bulk copy operations, `SELECT INTO`, and text processing,
can be replayed if necessary, so these operations are not fully logged. You can recover only
to the end the last database or log backup.

**Simple**
- All data modifications made since the last backup are not available. This type of recovery
scenario has the lowest logging overhead, but cannot recover past the end of the last
backup.

Microsoft SQL Server supports the following types of backups:

**Full database backup**
- A full database backup creates a duplicate of the data that is in the database. This is a single operation,
  usually scheduled at regular intervals. Full database backups are self-contained. Full backups provide a
  snapshot of the database. Most of the recovery options require a full backup to be present.
  
  We strongly recommends the use of full backups.

**Differential backup**
- A differential database backup records only the data that has changed since the last database backup.
  Frequent differential backups are recommended to reduce backup times. Making frequent backups
decreases the risk of losing data.

  Differential backups restore the data that they contain to the database. Differential backups cannot be used
to recover the database to a point in time.

  The availability of a differential backup minimizes the time it takes to roll forward transaction log backups
  when restoring a database.

**Transaction log backup**
- The transaction log is a serial record of all the transactions that have been performed against the database
  since the transaction log was last backed up. With transaction log backups, you can recover the database
to a specific point in time or to the point of failure.

  When restoring a transaction log backup, Microsoft SQL Server rolls forward all the changes recorded in
  the transaction log. When Microsoft SQL Server reaches the end of the transaction log, it has re-created
  the exact state of the database at the time of the backup operation.

  If the database is recovered, Microsoft SQL Server then rolls back all transactions that were incomplete
  when the backup operation started. Transaction log backups generally use fewer resources than database
  backups. As a result, you can create them more frequently than database backups. Frequent backups
decrease the risk of losing data. For high volume Online Transaction Processing (OLTP) environments, it is
desirable to create transaction log backups more frequently.

  Transaction log backups can only be used with Full and bulk-logged recovery models. The transaction log
  cannot be backed up during a full database backup or a differential database backup. However, the
  transaction log can be backed up while a file backup is running.

  Never backup a transaction log before a database backup is created because the transaction log contains
  the changes made to the database after the last backup was created.
Never truncate the transaction log manually because it breaks the backup chain. If a transaction log has been truncated, take a full database backup to start a new backup chain.

**File backups**

A file or file group backup consists of the backing up of individual data files (or the files in the file group). A file-based recovery model increases the speed of recovery by allowing you to restore only the damaged files without restoring the rest of the database. For example, suppose a database is comprised of several files located physically on different disks and one disk fails. Only the file on the failed disk needs to be restored and rebuilt using the transaction log backup.

File backup and restore operations must be used in conjunction with transaction log backups. For this reason, file backups can only be used with the full recovery and bulk-logged recovery models.

**Recommendations**

We recommend that you:

- Use the full recovery model.
- Perform a full database backup once every day. For full database sizes greater than 3 GB, it is okay to perform full backups on alternate days. If you perform full backups on alternate days, we strongly recommend that you create daily differential backups.
- Create daily transaction log backups after the completion of the full or differential backup. In addition to this, schedule a transaction log backup every 4 hours. Never truncate a transaction log manually.
- In case of a disaster, create a backup of the currently active transaction log. If active transaction log backup is not available (for example, because a media failure for the drive hosting the transaction logs and drive is not being mirrored), the database cannot be recovered past the last available transaction log backup. This would hamper a point-in-time recovery beyond the last available transaction log backup.
- Label the backup media correctly.
- Keep backup copies in offsite locations.
**Configuring Oracle Databases**

This chapter explains how to create a new server configuration and Oracle schema user for use with StarTeam Server. StarTeam Server stores everything except for file archives and server startup information in the schema user.

This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with StarTeam Server and explains how to use them.

When you create a server configuration, StarTeam Server can automatically create the tablespace and schema user. However, if you prefer, you can create the tablespace and schema user manually.

**Note:** All of the tablespaces created using StarTeam Server automatically create locally-managed tablespaces. All tablespaces created by StarTeam Server use AUTOALLOCATE. StarTeam Server supports Oracle Universal Installer for client. Consult with your database administrator for more information.

**Terminology**

When this chapter uses the terms "database instance" and "schema user", it uses Oracle terminology. Each database instance can manage a number of different schema users. Each StarTeam Server configuration has its own schema user. Elsewhere in the documentation you will find the terminology common to the other databases that StarTeam Server supports. For example, when you install Microsoft SQL Server on a computer, you can run several instances of it. Each instance can manage a number of different databases. Therefore, when you see the term “database” in other parts of these manuals, think “schema user”.

**Logging Onto Schema Users**

It is highly recommended that you use a dedicated StarTeam Server user account to run or log onto StarTeam Server schema users. System administrator accounts usually have unlimited privileges. Any anomalies or errors that occur while logged in as the system administrator may result in unrecoverable damage to the StarTeam Server schema users and other schema users managed by the same database.

**Using an Oracle Schema User**

If you will be using an Oracle schema user, you must complete the following tasks:

1. Install Oracle Server. Most customers install StarTeam Server and Oracle Server on separate computers.
2. Install Oracle Client on the computer on which you plan to install StarTeam Server.
3. Establish connectivity between Oracle Client and Oracle Server. See **Verifying Connectivity Between Client and Server**.
4. Install Oracle Enterprise Manager.
5. Install StarTeam Server. For more information, see the section **StarTeam Server for Windows Installation**.
6. Make sure that the NLS_LANG setting for Oracle Client and the character set specified for Oracle Server are correct. For more information, see **Using NLS_LANG Correctly** and **Database Character Set and StarTeam Server**.
7. Create a StarTeam Server configuration. For more information, see **Creating and Starting a Server Configuration with an Oracle Schema User** (about automatically created schema users) and **Creating the Oracle Schema User Manually**.
Caution: Please note the following:

• Never modify the database contents other than through a StarTeam Server client or the Server Administration Tool. Direct database manipulation is unsupported.
• Never modify vault files other than through a StarTeam Server client or the Server Administration Tool.

Verifying Connectivity Between Client and Server

If Oracle Client and Oracle Server are located on different computers (as recommended), verify that Oracle Client can connect with the Oracle database instance. This ensures that a StarTeam Server configuration can access the Oracle schema user.

To verify the connection between Oracle Client and Oracle Server:

1. Using Oracle Client on the StarTeam Server computer, set up Oracle connectivity.
2. Use Net Configuration Assistant to establish the connectivity between the computers on which Oracle Client and Server are installed.
3. Test the database connectivity through SQL*Plus or SQL*Worksheet.

Creating a Server Configuration for an Oracle Schema User

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a StarTeam Server configuration and start it for the first time.

Before you begin, you need to know:

• The Oracle Database Server name and either the Oracle Service name or SID.
• The system password.
• The logon name and password for the schema user.

1. Start the Server Administration tool. Click Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
2. Click Server > New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the Configuration Name field.
   b) Type or click Browse to specify the Repository Path location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The Repository Path is also the location for the default hive.
   c) Select Oracle from the Database Type list.
   d) Uncheck the option to Create new StarTeam database, so that StarTeam Server will not automatically create the database for it.
   e) Create an initial hive for the Native-II vault by doing one of the following:

   Accept the default settings
   Leave the Default option selected and proceed to the next step. With the default settings, StarTeam Server:
   • Creates an initial hive named DefaultHive.
   • Creates subfolders on the repository path named Archives and Cache to be used by the DefaultHive.
   • Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.

Specify custom values
Select the Custom option and change any of the hive settings.

f) Click Next, and enter the **Database Server name**, **Database name**, **Database login name**, and password in the appropriate text boxes.
g) Optionally, if you are using a port other than the default, check **Edit Database Port** and type the port number in the text field.
h) Type the login name and password for the schema user in the appropriate field.
i) Select either Service Name or SID and provide the information in the appropriate field.
j) Click **Verify Connection** to test the connection. If the connection fails, review and change your settings.
k) Click **Finish**.

This action re-displays the **Server Administration** tool, which shows your new server configuration as a child of the **Local** node.

**Note:** In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your **starteam-server-configs.xml** file. For more information about this file, see the **Server Administration Tool Help**.

### Installing Oracle Client


1. Select **See All for Windows 32 bit or Windows x64** to display downloads specific to that OS.
2. Install the driver that matches the version of StarTeam Server that you plan to use (32 or 64 bit).
3. Choose **Oracle Database 11g Release 2 Client**.
4. During the Oracle Client installation, there are various options. StarTeam Server only requires the **Instant Client**. Most Oracle installation packages (Universal Installer, SQL Developer) install the appropriate Oracle drivers on a given system. If you have already installed these products, it is likely that no other Oracle driver related installation is necessary.

### Using NLS_LANG Correctly

StarTeam Server converts data that is stored in the database to UTF-8 format. Your database character set should be defined such that it will not conflict with this nor with other StarTeam Server requirements. For more information, see [Defining NLS_LANG in the Windows Registry](http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html).

NLS_LANG represents the Oracle Client character set. The Oracle Client character set is defined by the third part of the NLS_LANG parameter and must be set to a value that Server uses.

After setting NLS_LANG correctly, Oracle Client correctly translates any symbols to the character code values of the database character set when storing data into the database or retrieving data from the database. NLS_LANG is specified in the following format.

```
NLS_LANG = language_territory.characterset
```

**language** Specifies the language used for Oracle messages, day names, and month names.
territory  Specifications the monetary and numeric formats, territory, and conventions for calculating week and day numbers.

characterset  Controls the character set used by Oracle Client. (Normally it matches your Microsoft Windows code page.)

NLS_LANG Definition Overview

The ODBC installation supports multiple Oracle homes. Each ODBC driver is uniquely identified by the name of the Oracle home in which it is installed. Applications using Oracle ODBC drivers use the value of NLS_LANG for making decisions related to character set conversion. The character set portion of the NLS_LANG setting must be AMERICAN_AMERICA.WE8MSWIN1252. If your StarTeam database was previously Oracle 8i, then you use AMERICAN_AMERICA.WE8ISO8859P1.

The ODBC driver installation uses the value of the Windows code page (ACP) and defines the value of NLS_LANG in the registry. The value of NLS_LANG should be verified for accuracy. Be sure to check for the NLS_LANG environment variable because it will override the registry setting. You may choose to delete the variable. For more information, see Defining the NLS_LANG as an Environment Variable.

You can define NLS_LANG for the Oracle Client in either of the following ways:

**In the Registry**

Oracle Client and Server support the concept of multiple Oracle homes. What this means is that you can have multiple sets of Oracle binaries on the same computer. When you have multiple Oracle homes on the same computer, you have multiple registry entries for each home. NLS_LANG should be defined for each home.

As an environment variable

Although the Registry is the primary repository for environment settings, it is not the only place where environment parameters can be set. You can set the NLS_LANG as a System or User Environment Variable in the System properties.

**Caution:** If NLS_LANG is defined as an environment variable, it will be used for all Oracle homes. This option should be used with caution, especially for cases where there are multiple Oracle homes on the computer and some Oracle homes have different NLS_LANG settings. It may be best to delete it.

Defining NLS_LANG in the Microsoft Windows Registry

**Note:** If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII and must be changed to a value that Server uses.

To change the NLS_LANG setting using the Microsoft Windows Registry Editor:

1. Click Start > Run. The Run dialog box opens.
2. Type regedit, and then click OK.
3. Edit the following registry entry: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\homeID where homeID is the unique name identifying the Oracle home.

Defining the NLS_LANG as an Environment Variable

**Note:** If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII and must be changed to a value that Server uses.

**Note:** To create or modify this setting for LINUX, define the value of NLS_LANG in the .profile or .cshrc file. Contact your LINUX Admin to learn how to set environment variables.

To create or modify the NLS_LANG environment variable’s setting on Microsoft Windows:
1. Right-click the **My Computer** icon on your desktop, and then choose **Properties** from the context menu.
2. Select the **Advanced** tab.
3. Click **Environment Variables**. The **Environment Variables** dialog box opens.
4. Select **NLS_LANG** and define an appropriate value.

**Database Character Set and StarTeam Server**

StarTeam Server stores UTF-8 data in Oracle schema users. StarTeam Server does not use the Oracle conversion mechanism. It performs the conversion to UTF-8 itself.

⚠️ **Caution:** Because StarTeam Server does the conversion, it is very important to prevent Oracle Client from also converting the data. A double conversion will result in garbage.

Oracle software does the conversion only when the Oracle Client's character set (specified by **NLS_LANG**) does not match the database instance's character set. Therefore, it is very important that the client and server's settings match. StarTeam Server configurations require that Oracle database instances use the **WE8MSWIN1252** character set. If your StarTeam Server database was previously Oracle 8i, then Oracle database instances use the **WE8ISO8859P1** character set.

The **Server Administration** tool does not allow you to create a new StarTeam Server server configuration unless the underlying database instance's character set is the correct character set. When StarTeam Server starts, it also ensures that the database character set matches the characters set portion of **NLS_LANG**.

Due to the numeric setting differences between different languages and territories, StarTeam Server also does not start unless **AMERICAN_AMERICA** (the US numeric setting) is the setting for the **language_territory** portion of **NLS_LANG**. Failure to do so causes exceptions for StarTeam Server. This does not mean that numbers and so on will be displayed incorrectly. For example, in Germany and other countries, a decimal point is represented as a comma. Such numbers will still display correctly.

**Creating and Starting a Server Configuration with an Oracle Schema User**

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a StarTeam Server configuration and start it for the first time. It assumes that you want StarTeam Server to automatically create the Oracle tablespace and a schema user named StarTeam. If that is not the case, see **Overview of Creating the Oracle Schema User Manually**.

For new configurations, you must know the Oracle Database Server name and either the Oracle Service name or SID.

1. Start the **Server Administration** tool. Click **Start** > **Programs** > **Micro Focus** > **StarTeam Server <version>** > **StarTeam Server**. The **Server Administration** tool opens.
2. Click **Server** > **New Configuration**. The **New Configuration** dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the **Configuration Name** field.
   b) Type or click **Browse** to specify the **Repository Path** location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The **Repository Path** is also the location for the default hive.
   c) Select **Oracle** from the **Database Type** list.
   d) Check the option to **Create new StarTeam database**, so that StarTeam Server automatically creates the tablespace and schema user for the schema user.
e) Create an initial hive for the Native-II vault by doing one of the following:

Accept the default settings

Leave the Default option selected and proceed to the next step. With the default settings, StarTeam Server:

- Creates an initial hive named DefaultHive.
- Creates subfolders on the repository path named Archives and Cache to be used by the DefaultHive.
- Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
- Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
- Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.

Specify custom values

Select the Custom option and change any of the hive settings.

f) Click Next. The Create an Oracle Schema User page of the wizard opens.

g) Type the Oracle Server name or SID in the appropriate field.

h) Optionally, if you are using a port other than the default, check Edit Database Port and type the port number in the text field.

i) Enter the database system password in the System password field.

j) Click Verify Connection to test the connection. If the connection fails, review and change your settings.

k) To keep the name of the server configuration and the schema user the same, both the New schema user name field default to the name you provided earlier for the server configuration. Change these names if you prefer to use different values.

l) Enter and confirm a password for the schema user name.

m) Click Next. The Create a Tablespace for StarTeam Schema page of the wizard opens.

n) The tablespace name defaults to the name of your server configuration. Change this name if you prefer to use a different value.

o) If you have fewer than 15 users and expect to store 1 GB or less of data, the default settings are appropriate for your use. If you are very familiar with Oracle schema users, you may choose to alter the names, sizes, and locations of the data files. For more information, see Guidelines for Data Files.

To avoid fragmentation, make the data files as large as possible, based on the maximum amount of data expected in the database. Use at least three data files when creating a tablespace because:

- There is a size limit of 2 GB per data file.
- Fewer files can result in slow response times when insert activity is heavy.

p) Click Finish.

This action re-displays the Server Administration tool, which shows your new server configuration as a child of the Local node.

Note: In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your starteam-server-configs.xml file. For more information about this file, see the Server Administration Tool Help.

4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server configuration on a given computer must have a unique endpoint so it is recommended that you edit the default endpoint. To change the endpoint:

a) Select the server configuration.

b) Click the Start with Override button (or click Actions > Start with Override from the main menu). The Start with Override dialog box opens.

c) Enter the endpoint that you want to use in the TCP/IP Endpoint field, and click OK.
5. Be sure to configure your new server configuration (for information, see the Server Administration Tool Help) and plan a backup schedule for it.

**Guidelines for Data Files**

We suggest the following guidelines for the number of data files and their sizes, based on the number of users. Your needs may be different than those shown in the table below.

<table>
<thead>
<tr>
<th>Number of Users</th>
<th>Number of Data Files</th>
<th>Size of Each Data File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 15</td>
<td>3</td>
<td>50 MB</td>
</tr>
<tr>
<td>Between 15 and 50</td>
<td>3</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 51 and 100</td>
<td>5</td>
<td>300 MB</td>
</tr>
<tr>
<td>Between 101 and 300</td>
<td>7</td>
<td>500 MB</td>
</tr>
<tr>
<td>&gt;300</td>
<td>7</td>
<td>800 MB</td>
</tr>
</tbody>
</table>

**Running SQL Scripts for Oracle Schema Users**

StarTeam Server comes with some SQL scripts written specifically for use with your database. These scripts help you maintain and tune StarTeam Server databases. You run some SQL scripts after installation, some on a weekly basis for database performance maintenance, and some scripts are run for you automatically by StarTeam Server.

The SQL scripts for Oracle schema users that you may run are located in the Micro Focus\StarTeam Server <version>\DBScripts\Oracle_Scripts folder.

**Note:** The Oracle_Scripts folder contains several subfolders: Create_Stored_Procedures, Drop_Stored_Procedures, Install, Preinstall, Generic, and DW (for Data Warehouse). The scripts in these subfolders are run by StarTeam Server as needed. Never execute any of them directly from an external database user interface, such as SQL*Plus or SQL *Worksheet.

The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency depending on the StarTeam Server usage at your facility. Run scripts at times when the server is least used, such as overnight or on weekends.

In addition to running these scripts, you should also run a Purge option from the Server Administration tool to remove deleted views from the database. We recommend purging the database after you have deleted one or more views from a project. See the Server Administration Tool Help for information on the Purge option.

<table>
<thead>
<tr>
<th>StarTeam Script Name</th>
<th>Run Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>starteam_oracle_compute_stats.sql</td>
<td>Weekly</td>
</tr>
<tr>
<td>starteam_oracle_dropall.sql</td>
<td>Only if necessary</td>
</tr>
<tr>
<td>starteam_oracle_rebuild_indexes.sql</td>
<td>Weekly</td>
</tr>
</tbody>
</table>

**Caution:** Be sure to backup your StarTeam Server schema user, as necessary, and verify these backups periodically. You should restore and test backups of your StarTeam Server project data on a test system. Restoring and testing your backups helps to ensure that your data is being backed up correctly.

To run a SQL script for Oracle schema users:
1. Go to the command prompt.
2. Change directories to the directory containing the StarTeam Server SQL scripts for Oracle schema users.
3. At the command prompt, type: `sqlplus username/password@servicename`
   - **username**: The StarTeam Server Oracle Schema User Name.
   - **password**: The StarTeam Server Oracle Schema Password.
   - **servicename**: The Net Service Name created using Oracle Net 8 Easy Config.
4. Execute the script.
   For example, to execute the `starteam_oracle_compute_stats.sql` script, type `@starteam_oracle_compute_stats.sql` and press Enter.

**StarTeam Server SQL Scripts for Oracle Schema Users**

- **starteam_oracle_compute_stats.sql**
  - **Run**: weekly.
  - The `starteam_oracle_compute_stats.sql` script updates the statistics in the database distribution page for all tables in the database. This data enables the query optimizer to choose the right index for a given query.

- **starteam_oracle_dropall.sql**
  - **Run**: only if necessary.
  - **Caution**: Running this script deletes all StarTeam Server tables and the data they contain from the database. This script can be executed from either Sql*Plus or SQL*Worksheet. Use this script with extreme caution.

  One use case example is if you migrate a StarTeam Server configuration to another database, you might use `starteam_oracle_dropall.sql` to remove tables from the original database. Another example is if you mistakenly add the StarTeam Server tables to a tablespace other than the StarTeam Server tablespace, use the `starteam_oracle_dropall.sql` script to remove them.

- **starteam_oracle_rebuild_indexes.sql**
  - **Run**: weekly.
  - The `starteam_oracle_rebuild_indexes.sql` script rebuilds the database indexes and configures the storage parameters for the index tablespace. The script assumes that the indexes are located in a tablespace named INDX. If your index tablespace uses a different name, edit `starteam_oracle_rebuild_indexes.sql` to reflect the correct tablespace name. Run the `starteam_oracle_rebuild_indexes.sql` script weekly to enhance database data retrieval.

**Creating the Oracle Schema User Manually**

This section explains how to manually create an Oracle tablespace and schema user for StarTeam Server. It also provides an overview of the tuning and maintenance SQL scripts that are provided with StarTeam Server, and explains how to use them. For detailed information on Oracle performance tuning, consult your Oracle documentation.
To configure an Oracle database instance:

1. Complete the procedures described in *Using an Oracle Schema User*.
2. Create a StarTeam Server tablespace.
3. Create a StarTeam Server schema user.
4. To ensure that StarTeam Server can create labels and perform other operations successfully, make sure that the schema user has the following Oracle privileges. They must be explicitly defined rather than relegated to roles. For more information, see *Granting Oracle Privileges*.
   - Create procedure
   - Create sequence
   - Create session
   - Create table
   - Create trigger
   - Create type
   - Create view
   - Unlimited tablespace
   - Create any context
   - Drop any context
5. Create the server configuration. For more information, see *Creating a Server Configuration for an Oracle Schema User*.

**Backing Up Oracle Databases**

This section outlines the backup options available to DBAs and makes recommendations for backing up the databases used by the server configurations. Be aware that these are just recommendations. Any finalized disaster recovery plan must be created by your organization in consultation with its IT infrastructure staff.

An application backup consists of backing up both the database and the application archive files and you have a choice between online and offline backups. If all of your archive files are in Native-II format, you can back up a server configuration online, without shutting it down or locking it. If you have a pre-2005 StarTeam Server release, you must convert older archives from Native-I to Native-II format prior to performing an online backup. Regardless of the StarTeam Server release, you must also set up your database for an online backup.

An online or hot backup is a backup performed while the database is online and available for read/write operations. Except for Oracle exports, you can only perform online backups when running in ARCHIVELOG mode. An offline or cold backup is a backup performed while the database is offline and unavailable to its users.

Typically an Oracle DBA uses one or more of the following options to back up an Oracle database.

**Logical Backups (Export/Import)**

Oracle exports are “logical” database backups (not physical) as they extract data and logical definitions from the database into a file. Other backup strategies normally back up the physical data files. One of the advantages of exports is that you can selectively re-import tables. However, you cannot roll forward from a restored export file. To completely restore a database from an export file, you almost need to recreate the entire database. Logical backups takes a snapshot of the database schema as it was at a particular time.

**Offline/Cold Backups**

A backup performed when the database is shut down is known as an offline or cold backup. You must copy the data files, control file and online redo log files using an OS copy utility. This is considered a complete backup of the database. Any changes made after this backup are unrecoverable if the database is running...
in NOARCHIVELOG mode. All transactions are recorded in online redo log files whether the database is archiving or not. When redo logs are archived (ARCHIVELOG mode), Oracle allows you to apply these transactions after restoring files that were damaged (assuming that an active redo log file was not among the files damaged).

Whenever the schema of the database is changed, such as when you add a new data file, rename a file, or create or drop a tablespace, you must shut down the database and copy at least the control file and the newly added data file. A complete backup of the database is preferred.

Before performing a cold backup, it is essential to get a list of all the Oracle files that need to be backed up. Running the following queries will provide a list of all the files.

```
select name from sys.v_$datafile;
sselect member from sys.v_$logfile;
sselect name from sys.v_$controlfile;
```

Shut down the database from SQL*Plus or Server Manager. Back up all the files to secondary storage (for example, tapes). Ensure that you back up all data files, all control files, and all log files. When completed, restart your database.

**Note:** If your database is in ARCHIVELOG mode, you can still use archived log files to roll forward from an offline backup. If you cannot take your database down for an offline backup at a convenient time, switch your database into ARCHIVELOG mode and perform an online backups.

**Online/Hot Backups**

A backup performed when the database instance is running is known as online or hot backup. Online backups are very important at customer sites where a database instance must operate 24-hours per day and offline backups are not feasible. During the duration of an online backup, the database remains available for both reading and updating. For this kind of backup, the database must be in ARCHIVELOG mode. Only data files and current control files need to be backed up. Unlike offline backups, the unit of a online backup is a tablespace, and any or all tablespaces can be backed up whenever needed. Different data files can be backed up at different times.

To perform an online backup, you switch the tablespace into “backup mode” before copying the files as shown in the following example:

```
ALTER TABLESPACE xyz BEGIN BACKUP;
! cp xyfFile1 /backupDir/
ALTER TABLESPACE xyz END BACKUP;
```

It is better to backup individual tablespaces than to put all tablespaces in backup mode at the same time. Backing them up separately incurs less overhead. After completing the tablespace backups, it is important to back up the control files as shown in the following example.

```
ALTER SYSTEM SWITCH LOGFILE; --Force log switch to update control file headers
ALTER DATABASE BACKUP CONTROLFILE TO '/directory_name/control.dbf';
```

The frequency of online backups is inversely proportional to the time taken for recovery in case of a media failure. The older your backup, the more redo log files need to be applied, and the recovery times increases. Backup strategies should be tested before being used to protect a production database.

We strongly recommend that you run online backups at times when the database is least accessed, during non-peak hours. Oracle writes complete database blocks instead of the normal deltas to redo log files while in backup mode. This leads to excessive database archiving and could lock up the database.

**RMAN Backups**

Recovery Manager (RMAN) is an Oracle tool that lets the DBA back up and recover Oracle databases. RMAN lets you perform full backups (with the database online or offline), incremental backups on the block level, and backups of online redo logs and control files. The SYSDBA privilege is required to run RMAN on a database. The other benefits of RMAN backups are that you can:
• Keep track of all backup and recovery operations performed against the database.
• Manage centralized backup and recovery procedures for the enterprise.
• Identify corrupt blocks.
• Back up only those blocks that actually contain data. This can lead to significant savings in backup space requirements.
• Have support for incremental backups. Incremental backups back up only those blocks that have changed since a previous backup. This helps with the disk space usage and reduces the backup times significantly. The Oracle 10g feature called “block change training” provides significant improvement for incremental backups. Contact your DBA about how to implement this feature.

The following examples of RMAN backup and restore are extremely simplistic and are included on to illustrate basic concepts. By default, Oracle uses the database control files to store information about backups. Normally, you prefer to set up an RMAN catalog database to store RMAN metadata. Read the Oracle Backup and Recovery Guide before implementing any RMAN backups.

```sql
rman target sys/*** nocatalog
run {
  allocate channel t1 type disk;
  backup
    format '/app/oracle/db_backup/%d_%t_s%s_p%p'
    ( database );
  release channel t1;
}
```

Example RMAN restore:
```sql
rman target sys/*** nocatalog
run {
  allocate channel t1 type disk;
  restore tablespace users;
  recover tablespace users;
  release channel t1;
}
```

Export/Import Data Pump

Oracle introduced the export/import data pump in the 10g release. The import pump is twenty times faster than the conventional import utility. Export/Import data pump utilities are “logical” database backups (not physical) as they extract data and logical definitions from the database into a file. Export/Import data pump utilities do not fit into 24/7 model because they do not offer roll-forward capabilities. Export data pump provides a snapshot of the database schema as it was at a particular time.

Recommendations

We strongly recommend the use of RMAN backups if your enterprise wants to run a StarTeam Server instance in a 24/7 environment. RMAN has evolved over the last few years and Oracle continues to add features that make disaster recovery easier, more reliable, and faster.

Oracle Database Tuning

This section provides the basic information needed to create an Oracle schema for StarTeam Server. We recommend using the Server Administration tool to create the schema, but if you prefer to create your own, follow the guidelines provided in this section.

The most efficient way to tune your Oracle database is to start with the recommended database settings and monitor the instance using the advisories. In addition to that, we recommend the use of Automatic Workload Repository (AWR) to collect performance statistics, including wait events used to identify performance problems. A detailed description of AWR is beyond the scope of this document. Please refer to your Oracle 10g performance tuning guide for more information.
**Recommended Initialization Parameters**

The following two tables recommend Oracle parameter settings for use with StarTeam Server databases.

**Table 1: Common Database Configuration Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatible</td>
<td>10gR2: 10.2.0</td>
</tr>
<tr>
<td></td>
<td>11g: 11.1.0.0.0</td>
</tr>
<tr>
<td>Cursor_sharing</td>
<td>10gR2: Force</td>
</tr>
<tr>
<td></td>
<td>11g: Force</td>
</tr>
<tr>
<td>Log_checkpoint_interval</td>
<td>Greater than the redo log size</td>
</tr>
<tr>
<td>Log_checkpoint_timeout</td>
<td>0</td>
</tr>
<tr>
<td>Workarea_size_policy</td>
<td>Auto</td>
</tr>
<tr>
<td>Db_block_size</td>
<td>16384 (16k)</td>
</tr>
<tr>
<td>Db_file_multi_block_read_count</td>
<td>16</td>
</tr>
<tr>
<td>Optimizer_mode</td>
<td>first_rows</td>
</tr>
<tr>
<td>Timed_statistics</td>
<td>True</td>
</tr>
<tr>
<td>Open_cursors</td>
<td>400</td>
</tr>
<tr>
<td>Undo_management</td>
<td>Auto</td>
</tr>
<tr>
<td>Undo_tablespace</td>
<td>(Name of the undo tablespace)</td>
</tr>
<tr>
<td>Undo_retention</td>
<td>28800</td>
</tr>
<tr>
<td>Processes</td>
<td>250</td>
</tr>
<tr>
<td>Statistics_level</td>
<td>Typical</td>
</tr>
</tbody>
</table>

**Table 2: Database parameters based on total memory**

<table>
<thead>
<tr>
<th>Total Memory</th>
<th>Recommended 10gR2 Settings</th>
<th>Recommended 11g Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 GB</td>
<td>SGA_TARGET = (Total Physical Memory * 80%) * 60%. We assume that 20% of the total memory will be used by the OS. Statistics level should be TYPICAL or ALL. LOG_BUFFER = 524288. PGA_AGGRGATE_TARGET = (Total Physical Memory * 80%) * 30%. 30% of the non-OS available memory. This is the starting value. This may need to be adjusted upwards.</td>
<td>MEMORY_TARGET = Total Physical Memory * 75%. We assume that 20% of the total memory will be used by the OS. The Oracle instance should be running on a dedicated machine. Statistics level should be TYPICAL or ALL. LOG_BUFFER = 524288.</td>
</tr>
<tr>
<td>2 GB</td>
<td>SGA_TARGET = (Total Physical Memory * 80%) * 60%. We assume that 20% of the total memory will be used by the OS.</td>
<td>MEMORY_TARGET = Total Physical Memory * 75%. We assume that 20% of the total memory will be used by the OS.</td>
</tr>
<tr>
<td>Total Memory</td>
<td>Recommended 10gR2 Settings</td>
<td>Recommended 11g Settings</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td></td>
<td>Statistics level should be TYPICAL or ALL.</td>
<td>The Oracle instance should be running on a dedicated machine.</td>
</tr>
<tr>
<td></td>
<td>LOG_BUFFER = 1048576.</td>
<td>Statistics level should be TYPICAL or ALL.</td>
</tr>
<tr>
<td></td>
<td>PGA_AGGREGATE_TARGET = (Total Physical Memory * 80%) * 30%.</td>
<td>LOG_BUFFER = 1048576.</td>
</tr>
<tr>
<td>We assume that 20% of the total memory will be used by the OS. This is the starting value. This may need to be adjusted upwards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 GB</td>
<td>SGA_TARGET = (Total Physical Memory * 80%) * 60%.</td>
<td>MEMORY_TARGET = Total Physical Memory * 75%.</td>
</tr>
<tr>
<td>We assume that 20% of the total memory will be used by the OS.</td>
<td>We assume that 20% of the total memory will be used by the OS.</td>
<td></td>
</tr>
<tr>
<td>Statistics level should be TYPICAL or ALL.</td>
<td>The Oracle instance should be running on a dedicated machine.</td>
<td></td>
</tr>
<tr>
<td>LOG_BUFFER = 1048576.</td>
<td>Statistics level should be TYPICAL or ALL.</td>
<td></td>
</tr>
<tr>
<td>PGA_AGGREGATE_TARGET = (Total Physical Memory * 80%) * 30%.</td>
<td>LOG_BUFFER = 1048576.</td>
<td></td>
</tr>
<tr>
<td>We assume that 20% of the total memory will be used by the OS. This is the starting value. This may need to be adjusted upwards.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tuning Oracle 10gR2 Databases

This section provides information about tuning Oracle 10g databases.

#### Automatic Shared Memory Management

Oracle 10g utilizes Automatic Shared Memory Management (ASMM) of individual SGA components like shared pool, java pool, large pool and db cache. You do not need to estimate when setting the size of SGA components. In fact, there is no need to set any parameters defining SGA size.

All you have to do is to set a new parameter called `SGA_TARGET`. The parameter `SGA_TARGET` takes a value which indicates the maximum size of SGA required for your instance.

Consider that you set `SGA_TARGET` to say 800MB. This indicates that maximum size to which SGA can grow is 800MB. All the SGA components like shared pool, buffer cache, large pool, java pool will be allocated from this 800M maximum SGA. Oracle will automatically calculate the initial size of these components and resizes it as per the requirement without any manual intervention.

You do not have to explicitly define values for shared pool, buffer cache, large pool and java pool if you set `SGA_TARGET`. The `SGA_TARGET` will be limited by the `SGA_MAX_SIZE` value. The `SGA_MAX_SIZE` cannot be modified dynamically. If `SGA_MAX_SIZE` is not set, both the parameters have the same value and it will be not possible to increase the size of `SGA_TARGET` dynamically.

#### Automatic Segment Space Management

The Automatic Segment Space Management (ASSM) feature allows Oracle to use bitmaps to manage the free space within segments. The bitmap describes the status of each data block within a segment with respect to the amount of space in the block available for inserting rows. The current status of the space available in a data block is reflected in the bitmap allowing Oracle to manage free space automatically with ASSM.

ASSM tablespaces automate freelist management and remove the ability to specify `PCTUSED`, `FREELISTS`, and `FREELIST GROUPS` storage parameters for individual tables and indexes created in ASSM tablespaces. The values for parameters `PCTUSED` and `FREELISTS` are ignored and Oracle...
automatically manages the space for these tables and indexes inside the tablespace using bitmaps. 
PCTFREE can still be specified and is used with ASSM.

**Tuning Oracle 11g Databases**

This section provides information about tuning Oracle 11g databases.

**Automatic Memory Management (AMM)**

Beginning with version 11g, the Oracle database can automatically manage the SGA memory and the instance PGA memory. You only need to designate the total memory size to be used by the instance, and the Oracle database will dynamically exchange memory between the SGA and the instance PGA as needed to meet processing demands. This capability is referred to as automatic memory management. With this memory management method, the database also dynamically tunes the sizes of the individual SGA components and the sizes of the individual PGAs.

AMM is implemented using `MEMORY_TARGET` and `MEMORY_MAX_TARGET` parameters. Use of `MEMORY_MAX_TARGET` is optional. When `MEMORY_MAX_TARGET` is not set, Oracle automatically sets `MEMORY_MAX_TARGET` to the value of `MEMORY_TARGET`.

To switch to AMM, define the value of `MEMORY_TARGET` in the `spfile`. It is important to ensure that the values of `SGA_TARGET` and `PGA_AGGREGATE_TARGET` are set to 0. Customers upgrading to 11g instance must set the value of `SGA_TARGET` and `PGA_AGGREGATE_TARGET` to 0.
Configuring PostgreSQL Databases

The following information will help you use the PostgreSQL database with StarTeam Server:

- It is installed in the `pgsql` folder under the StarTeam Server folder.
- The service name is `PostgreSQL-9.3_ST`.
- The superuser login name is `postgres`.
- The following StarTeam Server functionality is not available for PostgreSQL: Online Purge, Maintenance Scheduler, and the Import/Export Manager.

When connecting to a PostgreSQL database server on Microsoft Windows, the Microsoft Windows path should include the path to the PostgreSQL `bin` directory. If the path to the PostgreSQL libraries is not set correctly, a message similar to the following one will appear:

Libpq.dll: The specified module could not be found.
pq.dll: The specified module could not be found.
DBMS API Library loading fails. This library is a part of DBMS client installation, not SQLAPI++.
Make sure DBMS client is installed and this required library is available for dynamic loading.

When connecting to a PostgreSQL database server on Microsoft Windows, the Microsoft Windows system path should include the path to the PostgreSQL bin directory. For example, for a default installation, add this to the System PATH variable: `C:\Program Files\PostgreSQL\9.3\bin`.

**Important:** When a new database is created, all the default PostgreSQL settings (for example, file location and size) are used except for server encoding. This setting must be UTF-8.

Creating a Server Configuration (for an Existing Database)

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a StarTeam Server configuration using a previously created PostgreSQL database.

Database names should:

- Begin with a letter.
- Contain letters and numbers only.
- Not contain spaces.
- Not be a SQL reserved word such as `create`, `delete`, `if`, `then`, `else`, or `goto`.

**Important:** The Server Administration database options may fail to run for databases with names that do not follow these guidelines.

1. Start the Server Administration tool. Click Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
2. Click Server > New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the Configuration Name field. If you want the server configuration to have the same name as the database (a nice convention, especially if you have several server configurations), you must follow the database naming conventions explained at the beginning of this section.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The Repository Path is also the location for the default hive.

c) Select PostgreSQL from the Database Type list.

d) Uncheck the option to Create new StarTeam database, so that StarTeam Server will not automatically create the database for it.

e) Create an initial hive for the Native-II vault by doing one of the following:

Accept the default settings

- Leave the Default option selected and proceed to the next step. With the default settings, StarTeam Server:
  - Creates an initial hive named DefaultHive.
  - Creates subfolders on the repository path named Archives and Cache to be used by the DefaultHive.
  - Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
  - Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
  - Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.

Specify custom values

- Select the Custom option and change any of the hive settings.

f) Click Next, and enter the Database Server name, Database name, Database login name, and password in the appropriate text boxes.

g) Optionally, if you are using a port other than the default, check Edit Database Port and type the port number in the text field.

h) Click Verify Connection to test the connection. If the connection fails, review and change your settings.

i) Click Finish. This action re-displays the Server Administration tool, which shows your new server configuration as a child of the Local node.

**Note:** In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your starteam-server-configs.xml file. For more information about this file, see the Server Administration Tool Help.

j) Optionally, if you are using a port other than the default, check Edit Database Port and type the port number in the text field.

k) Click Verify Connection to test the connection. If the connection fails, review and change your settings.

l) Click Finish. This action re-displays the Server Administration tool, which shows your new server configuration as a child of the Local node.

**Note:** In addition to creating the server configuration, StarTeam Server adds information about the new server configuration to your starteam-server-configs.xml file. For more information about this file, see the Server Administration Tool Help.

4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server configuration on a given computer must have a unique endpoint so it is recommended that you edit the default endpoint. To change the endpoint:

a) Select the server configuration.

b) Click the Start with Override button (or click Actions > Start with Override from the main menu). The Start with Override dialog box opens.

c) Enter the endpoint that you want to use in the TCP/IP Endpoint field, and click OK.

5. Be sure to configure your new server configuration (for information, see the Server Administration Tool Help) and plan a backup schedule for it.
Creating and Starting a Server Configuration

The first time you start a new server configuration, StarTeam Server creates all tables in the database you specify. This section explains how to create a server configuration and start it for the first time. It assumes that you want the server to automatically create a PostgreSQL database. If that is not the case, see Creating a Database Manually.

Database names should:

- Begin with a letter.
- Contain letters and numbers only.
- Not contain spaces.
- Not be a SQL reserved word such as create, delete, if, then, else, or goto.

**Important:** The Server Administration database options may fail to run for databases with names that do not follow these guidelines.

1. Start the Server Administration tool. Click Start > Programs > Micro Focus > StarTeam Server <version> > StarTeam Server. The Server Administration tool opens.
2. Click Server > New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
   a) Type the name of the configuration in the Configuration Name field. If you want the server configuration to have the same name as the database (a nice convention, especially if you have several server configurations), you must follow the database naming conventions explained at the beginning of this section.
   b) Type or click Browse to specify the Repository Path location to be used to store log files and other information. If the repository path that you enter does not exist, the application creates it for you. The Repository Path is also the location for the default hive.
   c) Select PostgreSQL from the Database Type list.
   d) Check the option to Create new StarTeam database, so that StarTeam Server automatically creates the database.
   e) Create an initial hive for the Native-II vault by doing one of the following:
      - Accept the default settings: Leave the Default option selected and proceed to the next step. With the default settings, StarTeam Server:
        - Creates an initial hive named DefaultHive.
        - Creates subfolders on the repository path named Archives and Cache to be used by the DefaultHive.
        - Stipulates that the maximum cache size is 20% of the space currently available on the drive on which the cache is located.
        - Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
        - Uses the default setting of 95% for the storage threshold, the point at which this drive is considered full.
      - Specify custom values: Select the Custom option and change any of the hive settings.
   f) Click Next to create the PostgreSQL database.
4. Enter the server and database information:
   a) Enter the name in the Database Server name field.
   b) Type or click Browse to specify the names of the computer and the database on your network that should be used.
c) Enter the password for the system administrator in the Database Server name field. The initial default system administrator password is postgres.

d) Click Verify Connection to test the connection. If the connection fails, review and change your settings.

e) Click Next.

5. Enter the information for creating the data files and transaction logs, and click Finish.

   Note: We recommend keeping the data files and transaction log files on different physical drives under their own disk controllers.

   The default settings are appropriate for your use if you have fewer than 15 users and expect to store 1GB or less data.

6. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server configuration on a given computer must have a unique endpoint so it is recommended that you edit the default endpoint. To change the endpoint:

   a) Select the server configuration.

   b) Click the Start with Override button (or click Actions > Start with Override from the main menu). The Start with Override dialog box opens.

   c) Enter the endpoint that you want to use in the TCP/IP Endpoint field, and click OK.

7. Be sure to configure your new server configuration (for information, see the Server Administration Tool Help) and plan a backup schedule for it.

---

SQL Scripts for PostgreSQL Databases

StarTeam Server comes with some SQL scripts written specifically for use with your database. These scripts help you maintain and tune StarTeam Server databases. You run some SQL scripts after installation, some on a weekly basis for database performance maintenance, and some scripts are run for you automatically by StarTeam Server.

The SQL scripts for PostgreSQL databases that you may run are located in the Micro Focus\StarTeam Server <version>\DBScripts\postgresql_Scripts folder.

`starteam_postgresql_dropall.sql`

Run: only if necessary.

Caution: Running this script deletes all StarTeam Server tables and the data they contain from the database. Use this script with extreme caution.

One use case example is if you migrate a StarTeam Server configuration to another database, you might use this script to remove tables from the original database. Another example is if you mistakenly add the StarTeam Server tables to a tablespace other than the StarTeam Server tablespace, use this script to remove them.

---

Creating a Database Manually

Despite the fact that StarTeam Server has automated PostgreSQL server database creation, you may prefer to create your own. This makes more sense for PostgreSQL Server because there are good tools for database creation.

Database names should:

- Begin with a letter.
- Contain letters and numbers only.
- Not contain spaces.
• Not be a SQL reserved word such as create, delete, if, then, else, or goto.

⚠️ Important: The Server Administration database options may fail to run for databases with names that do not follow these guidelines.

To create your own PostgreSQL Server database:

1. Install PostgreSQL Server.
2. Install StarTeam Server. See the section StarTeam Server for Windows Installation.
3. Create a StarTeam Server database. Contact your database administrator about the specifics. Be sure that:
   • The database is owned by a StarTeam Server user.
   • The name of the database follows the conventions explained earlier in this section.
   • The template for the database is template0.
   • The encoding for the database should be: UTF-8. This refers to the physical storage of character strings in the database.
4. Create and start a server configuration. See Creating a Server Configuration (for an Existing Database)

Backups

We recommend using the pg_dump utility for backing up a PostgreSQL database. It makes consistent backups even if the database is being used concurrently. pg_dump does not block other users accessing the database (readers or writers). The most flexible output file formats is the directory format (-Fd). This format is compressed by default.
Configuring Federated Tracing

All cross-server traces can now be stored in a single federated tracing server configuration. This makes them more accessible for clients. The StarTeam Server configuration file, server-config-options.xml, contains a read-only string value named FederatedTraceConfiguration. Its value is the GUID of the configuration that stores all cross server traces on a multi configuration environment. To configure a Federated Tracing Environment:

1. Select the server to use as the federated server.
2. Open the server's starteam-server-configs.xml file, and copy the Server-GUID. Create a new entry in the .xml file called FederatedTraceServer and paste the value of the GUID. For example:
   
   ```xml
   <option name="ServerGuid" value="5dc8dd87-6cac-4bf1-819a-398de19a3d23"/>
   <option name="FederatedTraceServer" value="5dc8dd87-6cac-4bf1-819a-398de19a3d23"/>
   ```
3. For every other server configuration, edit the starteam-server-configs.xml file adding, the option name and value. For example:
   
   ```xml
   <option name="FederatedTraceServer" value="5dc8dd87-6cac-4bf1-819a-398de19a3d23"/>
   ```
4. To transfer existing traces, start up all the configurations and, as StarTeam Administrator, run the command line script:
   
   ```
   stcmd{Ex} transfer-traces -s "username:password@sourceConfig:sourcePort" -t "username:password@targetConfig:targetPort"
   ```
   
   If the username and password are the same (for example, in an LDAP environment, then the target username and password may be omitted). Run this script once for each configuration, targeting the federated trace configuration. The effect is to transfer all cross server traces over to the federated trace configuration.
5. On each client desktop/laptop, add a new Server entry for the Federated Trace configuration.
6. Users and groups must be provided with access rights to the federated trace configuration. These rights can be granularly distributed on a per project basis (the project in question representing the source and target server configurations whose traces are being captured). The rights must include read and write of traces, and the rights to see the project and its root view.
7. Launch the StarTeam Cross-Platform Client.

When you use the client to create new cross server traces or query existing traces, it automatically checks to ensure that you are logged into the Federated Trace configuration. If you are not logged in, you will be prompted with a login dialog box, and a hidden connection will be established for your client (You will not see a StarTeam View Window with Items Pane for the Federated Trace configuration). Evidently, to create a cross server trace, you need both configurations across which you are creating the trace to be open. However, to view cross server traces, it is sufficient that only one configuration be open. Since the traces are stored in the Federated Trace configuration, and you are logged in on demand, they will always be visible from either end point.
StarTeam Backups

StarTeam allows you to perform backups in a completely online manner, without shutting down or locking a server configuration.

What to Backup

When performing a backup, you need to include all of the following:

| Application Configuration File | The `starteamserver-configs.xml` file needs to be backed up. It is located in the folder in which you installed StarTeam Server. |
| Database Files | Backup the database. Each server configuration has one database (or, in the case of Oracle, one schema user). |
| Server Configuration Directory | In the `starteamserver-configs.xml`, locate the value of the `RepositoryPath` option. Include everything in that directory. For example: |

```xml
<option name="RepositoryPath" value="c:\my\server-config\directory-name"/>
```

In the example, back up everything in `c:\my\server-config\directory-name`.

All of these should be backed up at the same time, preferably on the same media.

⚠️ Important: The server configuration directory should not be backed up until after the database backup completes. These two backups should not be done simultaneously. This guarantees that everything referenced in the database appears in the server configuration in the right data location.

Restoring Data

There may be a few scenarios when you need to restore data. In the event that:

- **The database is lost**
  The administrator must restore the last full backup of the database and apply the redo logs (Oracle) or apply incremental backups (Microsoft SQL Server) to roll forward the database to the vault time.

- **The vault is lost**
  It is very important to take a backup of the database in its current state, including the transaction logs (redo logs), before performing any restoring.

- **The vault (or both the vault and database) are lost**
  The server administrator must restore both the database and the vault from the last backup. After restoring the online database backup, the database has to be rolled forward to the vault backup time.

⚠️ Note: If you do not have transaction logs (redo logs) available, this can cause data loss and limit your disaster recovery capabilities.

1. Reload the database from the last backup.
2. Simultaneously, reload the repository information (server configuration directory) from the last backup. If the full and incremental backups were used, then you can reload the last full backup, and in parallel, reload all subsequent incremental backups.
3. Restore the `starteam-server-configs.xml` file.
4. Start the server configuration.

5. Test the server configuration.

You can test the server configuration by performing all of your regular operations, such as checking-out various current and historical configurations of your main projects, running your build process, and so on.

When all loads are complete, the repository is ready to use. It is okay if the archive or attachment folders have “future” files not represented in the database. StarTeam ignores the “future” files and, if those file revisions are eventually added again, StarTeam overwrites the existing files.

Database Backups Overview

This section outlines the backup options available to DBAs and makes recommendations for backing up the databases used by the server configurations. Be aware that these are just recommendations. Any finalized disaster recovery plan must be created by your organization in consultation with its IT infrastructure staff.

**Note:** An application backup consists of backing up both the database and the application archive files.

Microsoft SQL Server Database Backups

For server configuration online backups, it is essential to take full database and transaction log backups.

Microsoft SQL Server Backup Types and Recovery Models

Microsoft SQL Server supports the following types of backups:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full database backup</strong></td>
<td>A full database backup contains the full copy of the database as it was at the time when the backup was initiated. Full backups provide a snapshot of the database. Most of the recovery options require a full backup to be available.</td>
</tr>
<tr>
<td><strong>Differential backup</strong></td>
<td>A differential database backup records only the data that has changed since the last full database backup. Scheduling frequent differential backups is a good idea because the backups are smaller and they complete quickly. A differential backup without a prior full backup is useless.</td>
</tr>
<tr>
<td><strong>Transaction log backup</strong></td>
<td>A transaction log backup includes all the transactions since the last transaction log backup. Transaction log backups enable recovery up to the last committed transaction.</td>
</tr>
<tr>
<td><strong>A file or file group backup</strong></td>
<td>A file or file group backup consists of backing up individual data files (or the files in the file group). The files in a database can be backed up and restored individually.</td>
</tr>
</tbody>
</table>

The entire database can be recreated from a database backup in one step by restoring the database. The restore process overwrites the existing database or creates the database if it does not exist. The restored database will match the state of the database at the time the backup completed, minus any uncommitted transactions. Uncommitted transactions are rolled back when the database is recovered.

Based on the resource requirements, the DBA can also choose the recovery model for the database. The recovery model balances logging overhead against the criticality of fully recovering the data.

The recovery models supported by Microsoft SQL Server are:

<table>
<thead>
<tr>
<th>Recovery Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full</strong></td>
<td>The data is critical and must be recoverable to the point of failure. All data modifications are logged. All Microsoft SQL Server recovery options are available.</td>
</tr>
</tbody>
</table>
Bulk-logged

Certain bulk operations, such as bulk copy operations, `SELECT INTO`, and text processing, can be replayed if necessary, so these operations are not fully logged. You can recover only to the end the last database or log backup.

Simple

All data modifications made since the last backup are not available. This type of recovery scenario has the lowest logging overhead, but cannot recover past the end of the last backup.

Recovering to a point-in-time (for example, a time before unwanted data was entered) requires either full or bulk-logged recovery models.

Microsoft SQL Server Full Database Backups

A full database backup creates a duplicate of the data that is in the database. This is a single operation, usually scheduled at regular intervals. Full database backups are self-contained. Full backups provide a snapshot of the database. Most of the recovery options require a full backup to be present.

We strongly recommend the use of full backups.

Microsoft SQL Server Differential Database Backups

A differential database backup records only the data that has changed since the last database backup. Frequent differential backups are recommended to reduce backup times. Making frequent backups decreases the risk of losing data.

Differential backups restore the data that they contain to the database. Differential backups cannot be used to recover the database to a point in time.

The availability of a differential backup minimizes the time it takes to roll forward transaction log backups when restoring a database.

Microsoft SQL Server Transaction Log Backups

The transaction log is a serial record of all the transactions that have been performed against the database since the transaction log was last backed up. With transaction log backups, you can recover the database to a specific point in time or to the point of failure.

When restoring a transaction log backup, Microsoft SQL Server rolls forward all the changes recorded in the transaction log. When Microsoft SQL Server reaches the end of the transaction log, it has recreated the exact state of the database at the time of the backup operation.

If the database is recovered, Microsoft SQL Server then rolls back all transactions that were incomplete when the backup operation started.

Transaction log backups generally use fewer resources than database backups. As a result, you can create them more frequently than database backups. Frequent backups decrease the risk of losing data. For high volume Online Transaction Processing (OLTP) environments, it is desirable to create transaction log backups more frequently. Transaction log backups can only be used with Full and bulk-logged recovery models.

The transaction log cannot be backed up during a full database backup or a differential database backup. However, the transaction log can be backed up while a file backup is running.

Never backup a transaction log before a database backup is created because the transaction log contains the changes made to the database after the last backup was created.

Never truncate the transaction log manually because it breaks the backup chain. If a transaction log has been truncated, take a full database backup to start a new backup chain.

Microsoft SQL Server File Backups

A file or file group backup consists of the backing up of individual data files (or the files in the file group). A file-based recovery model increases the speed of recovery by allowing you to restore only the damaged
files without restoring the rest of the database. For example, suppose a database is comprised of several files located physically on different disks and one disk fails. Only the file on the failed disk needs to be restored and rebuilt using the transaction log backup.

File backup and restore operations must be used in conjunction with transaction log backups. For this reason, file backups can only be used with the full recovery and bulk-logged recovery models.

Microsoft SQL Server Database Backup Recommendations

We recommend that you:

• Use the full recovery model.
• Perform a full database backup once every day. For full database sizes greater than 3 GB, it is okay to perform full backups on alternate days. If you perform full backups on alternate days, we strongly recommend that you create daily differential backups.
• Create daily transaction log backups after the completion of the full or differential backup. In addition to this, schedule a transaction log backup every 4 hours. Never truncate a transaction log manually.
• In case of a disaster, create a backup of the currently active transaction log. If active transaction log backup is not available (for example, because a media failure for the drive hosting the transaction logs and drive is not being mirrored), the database cannot be recovered past the last available transaction log backup. This would hamper a point-in-time recovery beyond the last available transaction log backup.

Oracle Database Backups

An online or hot backup is a backup performed while the database is online and available for read/write operations. Except for Oracle exports, you can only perform online backups when running in ARCHIVELOG mode. An offline or cold backup is a backup performed while the database is offline and unavailable to its users.

The remainder of this topic explains the types of backups supported by Oracle and provides recommendations about performing Oracle backups.

Oracle Backup Types

Typically an Oracle DBA uses one or more of the following options to back up an Oracle database.

Export/Import

Exports are logical database backups that extract logical definitions and data from the database to a file. Export backups are cross-platform and can be easily moved from one operating system to the other.

Cold or Offline Backups

These backups require shutting down the database instance and copying all the data, log, and control files.

Hot or Online Backups

These backups are taken when the database is available and running in ARCHIVELOG mode. To perform a backup of this type, the tablespaces need to be in backup mode and all the data files associated with the tablespace must be backed up. It is essential to backup the control files and archived redo log files.

RMAN Backups

While the database is offline or online, DBAs can use the RMAN utility to back up the database.

Export/Import Data Pump

Export pump and import pump are new for Oracle 10g. Expdp and Impdp are cross-platform and can be easily moved from one operating system to the other.

Oracle Logical Database Backups

Oracle exports are logical database backups (not physical) as they extract data and logical definitions from the database into a file. Other backup strategies normally back up the physical data files. One of the
advantages of exports is that you can selectively re-import tables. However, you cannot roll forward from a restored export file. To completely restore a database from an export file, you almost need to recreate the entire database. Logical backups takes a snapshot of the database schema as it was at a particular time.

Oracle Offline/Cold Database Backups

A backup performed when the database is shut down is known as an offline or cold backup. You must copy the data files, control file and online redo log files using an OS copy utility. This is a considered a complete backup of the database. Any changes made after this backup are unrecoverable if the database is running in NOARCHIVELOG mode. All transactions are recorded in online redo log files whether the database is archiving or not. When redo logs are archived (ARCHIVELOG mode), Oracle allows you to apply these transactions after restoring files that were damaged (assuming that an active redo log file was not among the files damaged).

Whenever the schema of the database is changed, such as when you add a new data file, rename a file, or create or drop a tablespace is created, you must shut down the database and copy at least the control file and the newly added data file. A complete backup of the database is preferred.

Before performing a cold backup, it is essential to get a list of all the Oracle files that need to be backed up. Running the following queries will provide a list of all the files.

```sql
select name from sys.v_$datafile;
select member from sys.v_$logfile;
select name from sys.v_$controlfile;
```

Shut down the database from SQL*Plus or Server Manager. Back up all the files to secondary storage (for example, tapes). Ensure that you back up all data files, all control files, and all log files. When completed, restart your database.

**Note:** If your database is in ARCHIVELOG mode, you can still use archived log files to roll forward from an offline backup. If you cannot take your database down for an offline backup at a convenient time, switch your database into ARCHIVELOG mode and perform an online backups.

Oracle Online/Hot Database Backups

A backup performed when the database instance is running is known as online or hot backup. Online backups are very important at customer sites where a database instance must operate 24-hours per day and offline backups are not feasible. During the duration of an online backup, the database remains available for both reading and updating. For this kind of backup, the database must be in ARCHIVELOG mode. Only data files and current control file need to be backed up. Unlike offline backups, the unit of a online backup is a tablespace, and any or all tablespaces can be backed up whenever needed. Different data files can be backed up at different times.

To perform an online backup, you switch the tablespace into “backup mode” before copying the files as shown in the following example.

```sql
ALTER TABLESPACE xyz BEGIN BACKUP;
! cp xyffile1 /backupDir/
ALTER TABLESPACE xyz END BACKUP;
```

It is better to backup individual tablespaces than to put all tablespaces in backup mode at the same time. Backing them up separately incurs less overhead. After completing the tablespace backups, it is important to back up the control files as shown in the following example.

```sql
ALTER SYSTEM SWITCH LOGFILE; -- Force log switch to update control file headers
ALTER DATABASE BACKUP CONTROLFILE TO '/<directory name>/control.dbf';
```

The frequency of online backups is inversely proportional to the time taken for recovery in case of a media failure. The older your backup, the more redo log files need to be applied, and the recovery times increases. Backup strategies should be tested before being used to protect a production database.
We strongly recommend that you run online backups at times when the database is least accessed, during non-peak hours. Oracle writes complete database blocks instead of the normal deltas to redo log files while in backup mode. This leads to excessive database archiving and even database freezes.

**Oracle RMAN Database Backups**

Recovery Manager (RMAN) is an Oracle tool that lets the DBA back up and recover Oracle databases. RMAN lets you perform full backups (with the database online or offline), incremental backups on the block level, and backups of online redo logs and control files.

The SYSDBA privilege is required to run RMAN on a database. The other benefits of RMAN backups are that you can:

- Keep track of all backup and recovery operations performed against the database.
- Manage centralized backup and recovery procedures for the enterprise.
- Identify corrupt blocks.
- Back up only those blocks that actually contain data. This can lead to significant savings in backup space requirements.
- Have support for incremental backups. Incremental backups back up only those blocks that have changed since a previous backup. This helps with the disk space usage and reduces the backup times significantly. Oracle 10g has introduced a new feature called “block change training”. This feature provides significant improvement for incremental backups. Contact your DBA about how to implement this feature.

The following examples of RMAN backup and restore are extremely simplistic and are included on to illustrate basic concepts. By default, Oracle uses the database control files to store information about backups. Normally, you will prefer to set up an RMAN catalog database to store RMAN metadata. Read the Oracle Backup and Recovery Guide before implementing any RMAN backups.

```sql
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
backup format '/app/oracle/db_backup/%d_t%t_s%s_p%p' (database);
release channel t1;
}
```

Example RMAN restore:

```sql
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
restore tablespace users;
recover tablespace users;
release channel t1;
}
```

**Oracle Export/Import Data Pump**

Oracle introduced the export/import data pump in the 10g release. The import pump is twenty times faster than the conventional import utility. Export/Import data pump utilities are logical database backups (not physical) as they extract data and logical definitions from the database into a file. Export/Import data pump utilities do not fit into 24/7 model because they do not offer roll-forward capabilities. Export data pump provides a snapshot of the database schema as it was at a particular time.

**Oracle Database Backup Recommendations**

We strongly recommend the use of RMAN backups if your enterprise wants to run a StarTeam instance in a 24/7 environment. RMAN has evolved over the last few years and Oracle Corporation continues to add features that make disaster recovery easier, more reliable, and faster.

**PostgreSQL Database Backups**

Backups can be one of the most critical aspects of administering any database, and PostgreSQL is no exception. While the PostgreSQL database is very versatile and resilient, problems can happen. A power
failure could occur corrupting the database or the hard-drive could fail. You could also have problems with users, authorized or unauthorized, changing or destroying data.

PostgreSQL database provides easy backup and restore utilities. There are two different types of backups you can use:

⚠️ **Important:** The following information is provided to point you in the right direction only. Please refer to the PostgreSQL database documentation for full procedures.

- **SQL text backups**
  - SQL text backups allow you to backup your entire server including user and passwords but you cannot restore a single database or just the users unless you edit the file. Both of these files are created using the same `pg_dump` command depending on the options you specify. Both are restored using different commands. Another thing to consider is that binary backups can be restored using `pgAdmin`.

- **Binary backups**
  - Binary backups are convenient and let you do a couple different things when you re-load them, however, they are limited to backing up a single database and do not include users and passwords.

Use the following commands to manage your PostgreSQL databases.

<table>
<thead>
<tr>
<th>Command</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup</strong></td>
<td><code>pg_dump -U postgres -h &lt;hostname&gt; -p 5432 -F c -f Atlas.backup &lt;Database Name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>• <code>&lt;Hostname&gt;</code> is the name of the database machine.</td>
</tr>
<tr>
<td></td>
<td>• <code>&lt;Database Name&gt;</code> is the name of the ST database.</td>
</tr>
<tr>
<td></td>
<td>• <code>-F c</code> would create a compressed binary backup</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td><code>createdb -U postgres -h &lt;New Hostname&gt; -p 5432 &lt;New Db Name&gt;</code></td>
</tr>
<tr>
<td><strong>Restore</strong></td>
<td><code>pg_restore -U postgres -h &lt;New Hostname&gt; -p 5432 -d &lt;New Db Name&gt; Atlas.backup</code></td>
</tr>
</tbody>
</table>
Data Locations and Repositories

As part of creating a new server configuration, StarTeam Server creates a number of folders for storing log files, archive files, and so on. This section explains the location and purpose of the files and folders that make up the StarTeam Server vaults and repositories.

Repositories

The following figure shows the server configuration whose repository path starts with a drive letter (not shown in figure) and ends with the folder name **MyConfiguration**.

The name of the server configuration may also be **MyConfiguration**.

The repository path is a general location for initial storage of a variety of objects, most of which can be moved to new locations later, independent of one another.

Native-II Vault Folders

For server configurations, the repository path is also the initial home of several folders used by the Native-II Vault to store archive files and information about them:

**Default Hive**

If you accepted all the defaults when you created the server configuration or if you started an upgraded server configuration without first creating a hive, StarTeam Server automatically creates the folder **DefaultHive**. It is a subfolder of the repository path and is created when you start the server configuration for the first time.

Whether the initial hive is called **DefaultHive** or not, you will have at least one hive for each server configuration. You may have several hives. Each hive has an archive and cache path. An easy, but not mandatory, naming convention is the one illustrated in the above figure. The name of the hive becomes the name of a folder with two subfolders: **Archives** and **Cache**. However, you can place these paths anywhere. They do not need to be on the same drive or volume.

The **DefaultHive** subfolders have the following purposes:

**Archives**  This folder stores file revisions in archive files, which may be compressed.

**Cache**  This folder stores uncompressed versions of archive files. It has two subfolders **Temp** and **Deltas**. Temp is used for files that are being added to StarTeam...
Server and for new file revisions that are being checked in. Deltas stores the differences between working files and tip revisions when a user asks that transmissions over slow connections be optimized.

You can use the Hive Manager to change an individual hive’s archive path or cache path. Such changes should be done only when that hive must be moved. For example, you might move a hive as a result of a drive failure. You would also need to copy the contents of the hive’s archive path to the new location.

The archive path for any hive must be included in a backup. A hive’s cache path does not need to be included.

HiveIndex If you started a StarTeam Server configuration, it has at least one hive. The HiveIndex folder stores the hive-index.xml file, which contains the properties for each hive used by the server configuration.

You can change the path to the HiveIndex folder by changing the repository path in the starteam-server-configs.xml file. You would make this change only when necessary, for example, because of a drive failure.

The HiveIndex folder must be included in a backup.

Archive and Cache Path Structure

Every hive’s archive path and cache path has the same structure. This structure is similar to that used by StarTeam clients to store file status records. The files located in the archive and cache are organized into subfolders. This makes browsing and managing the files easier. The name of the subfolders in which a file revision is stored is based on the initial characters in the archive file’s name. For example, suppose a file revision’s contents has an MD5 value of 01fc3c4ac5e0e92cc707f30fb73a0726. Assuming the user specified an archive path of C:\DefaultHive\Archives the archives path for this revision would be one of the following, depending on whether or not the archive file was compressed:

C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726
C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726.gz

The archive path for each hive (for example C:\DefaultHive\Archives) must be included in a backup.

Log Files and Folders

The repository path folder becomes the home of the following related objects:

**Server log files** A new server log file is created each time you start the server configuration. See the Server Administration tool help for more information.

**.dmp files** These are any .dmp files created when you use server diagnostics to create .DMP files for errors and unexpected conditions encountered by the server. Usually, you have no .DMP files or trace files unless a technical support representative is working with you on a problem. See the Server Administration tool help for more information.

**Notifications folder** When a StarTeam Server configuration starts for the first time, the contents of the Notifications folder in the installation directory are copied to the repository for the server configuration in a corresponding Notifications folder.

**Trace folder** The Trace folder stores the files that are created when and if you use server diagnostics to trace server commands. See the Server Administration tool help for more information.
These objects do not have to remain in the repository path. You can change the path to all of the above by changing the Log Path using the **Server Administration** tool.

These folders do not have to be included in a backup.
Installing and Configuring Supporting Software

This section provides information about software that you use in conjunction with StarTeam:

- Synchronizing workstation clocks
- Adobe Acrobat Reader
- Java runtime environment

Synchronizing Workstation Clocks

The computers that run application clients and the StarTeam Server must have their dates and times synchronized. Many features of the application depend on calculations involving times and dates. In particular, labels, configurations, and promotion states are all governed by time and date calculations.

**Important:** If the client and StarTeam Server are not kept synchronized, a number of operations (such as checkout, file status displays, or label creation) might fail or produce inaccurate results.

Therefore, you should use whatever service your network server supports for synchronizing all workstation clocks. For example, Windows network users can execute the following command to synchronize their workstation time with the computer on which the StarTeam Server is installed:

```
net time \server_name /set /yes
```

In this example, you would replace `server_name` with the machine name or IP address of the network computer running the StarTeam Server.

Adobe Acrobat Reader

The primary documentation for the product line is delivered in Adobe’s Portable Document Format (.pdf), and can be viewed with Adobe’s free Acrobat Reader.

You can download the latest version of the Acrobat Reader from Adobe’s web site at http://www.adobe.com.

Java Runtime Environment

The application client and server installation programs automatically install a Java Virtual Machine on your computer if the required version is not already installed.

Java requires a minimum of 256 colors to start any AWT or Swing-based graphical user interface. When you try to start the StarTeam Server from the Microsoft Windows Start menu on a computer with too few colors, you see a DOS box briefly display on the screen.

The StarTeam Cross-Platform Client installer runs the Oracle tzupdater program on the Java Runtime Environment (JRE) installed with this release (see system requirements for the version number). The `tzupdater` program changes the JRE in order to provide better DST (Daylight Savings Time) information for Eastern, Mountain, and Hawaiian time zones. It also deletes three JRE files from the `lib/zi` folder (if they are there): EST, HST, MST.
Index

A
accessing products 7
Adobe Acrobat Reader 133
archive path structure 131

B
backup
files 123
restore 123
backups
database 124
Oracle database 126
PostgreSQL 128
SQL Server database 124
bit versions 11

C
cache path structure 131
contact information 12
creating a database manually 99
Customer Care 12

D
data locations 130
database support 16
Datamart
  installation 80
documentation 11
downloads 12

e
terprise advantage license products 10
enterprise license products 7
Extensions 72

F
federated tracing 122

G
granting Oracle privileges 23

I
included in this guide 7
installation roadmap 13
installing and configuring supporting software 133
installing StarTeam integrations 54
installing the Oracle client 105
installing the StarTeam Server on Linux 33
introduction 7

J
JRE 133

L
Layout Designer
  about 70
  installing 71
log files and folders 131

M
Microsoft SQL Server
  addressing orphaned users 23
  backups 100
  compatibility level for 2008 24
  configuring 91
  connecting to a database 93
  creating a database manually 99
  creating a server connection for existing database 91
  creating and starting a server configuration 93
  data file and transaction log guidelines 96
  database upgrade paths 22
  orphaned users 22
  running SQL scripts 96
  security 98
  setting default collation 100
  SQL scripts 97
  understanding collation 99
  using 93
migrating StarTeam Server 2008 for Windows to Linux 35
MPX
  about 37
  components 37
  configuration
    ActiveMQ MPX 47
    ActiveMQ MPX and StarTeamMPX together 47
    ActiveMQ MPX only 47
    StarTeamMPX 48
  generating transmitter XML files 38
Microsoft Windows installation 37
system requirements 39
MPX Cache Agent
  after installation 43
  before installing 42
  installation 41
  uninstall 44
  upgrading 41
MPX Cache Agent for Linux
  installation 45
MPX for Linux
  installation 44
MPX Message Broker
installation 40
upgrading 40
MPX Message Broker for Linux
installation 44

N
native-II vault folders 130
Notification Agent
installation 75

O
Oracle
back ups 111
configuring 103
creating a server configuration for Oracle schema user 104
creating and starting a server configuration with an Oracle schema user 107
creating the schema user manually 110
database backups 126
database character set and StarTeam Server 107
database tuning 113
define NLS_LANG as environment variable 106
define NLS_LANG in Windows registry 106
guidelines for data files 109
installing the client 105
NLS_LANG definition overview 106
recommended initialization parameters 114
running SQL scripts for Oracle schema users 109
SQL scripts for Oracle schema users 110
tuning 10gR2 databases 115
tuning 11g databases 116
using a schema user 103
using NLS_LANG 105
verifying client-server connectivity 104

P
PostgreSQL
backups 121
create server configuration for existing database 117
creating a database manually 120
creating and starting a server configuration 119
database backup 128
running SQL scripts 120
Product Support 12
product updates. 11

R
repositories 130
restore
configuration 123
roadmap for server administrators 13
roadmap for the StarTeam Cross-Platform Client 13
roadmap for upgrading 13

S
search
Apache Tomcat 28
SELinux 36
serial number 12
server administration
Linux 35
silent install for StarTeam Cross-Platform Client 53
SQL Server database
backups 124
StarTeam Cross-Platform Client
additional customization when installing 54
automating installations 53
before installing 51
installation 50, 51
installing on Linux or Solaris 52
installing on Windows 52
setting up default personal options 51
silent install 53
system requirements 50
uninstalling 54
StarTeam Eclipse Plugin
disabling 79
installation 78
installing 78
uninstalling 78
StarTeam Layout Designer
system requirements 70
StarTeam Quality Center Synchronizer
installation 81
StarTeam Server
Adobe Acrobat 17
database on a different computer 18
database server system requirements 18
JRE 17
large memory support 18
Linux system requirements 19, 33
Microsoft SQL Server Express on the same computer 18
operating systems support 16
system requirements 15
virus scanning software 17
web browser support 17
StarTeam Server for Microsoft Windows
about 15
changes to server fields 25
database requirements for upgrading 22
evaluating 28
installation 15, 25
licensing 29
load server configuration sample data 27
Microsoft SQL Server database upgrade paths 22
new installation tasks 27
orphaned users in Microsoft SQL Server 22
post-installation tasks for an upgrade 28
pre-installation requirements for new installation 19
preparing for an upgrade 20
setting database compatibility level Microsoft SQL Server 2008 24
understanding licensing 29
uninstalling 32
upgrade process overview 20
upgrade requirements 21
upgrading 20
upgrading server configurations 24
using a license server 30
using licensing 29
StarTeam Server on Linux
installation 33
installing 34
migrating StarTeam Server 2008 for Windows to Linux 35
pre-installation setup 33
SELinux 36
server administration 35
StarTeam Visual Studio Plugin
installation 77
installing 77
installing integration help in Visual Studio 2010 77
installing integration help in Visual Studio 2012 77
StarTeam Web Client
accessing 69
item detail specification for the 68
system requirements 56
StarTeam Web Server
adding a StarTeam Server configuration 59
Apache Tomcat
running native 67
change user name and password 58
changing the memory allocation to the web server 67
configuring component access 59
creating a custom details template to view in the StarTeam Web Client 68
enabling SSL using a valid certificate 66
installation and configuration 56
installing 57
log output level 67
logging on 58
performance and scalability 56
removing a StarTeam Server configuration 60
service.bat 62
setenv.bat 61
setting up as a service 60
startteamservice.bat 62
system requirements 56
tomcat5.exe 63
tomcat5w.exe 63
StarTeam Workflow Extensions
about 72
about the installation 72
Extensions 72
extensions installation strategies 73
installing Extensions 73
installing the Notification Agent 75
installing Workflow Designer 75
Notification Agent 72
system requirements 73
Workflow Designer 72
startup order for MPX components 46, 57
SupportLine 12
synchronizing workstation clocks 133
system requirements
MPX 39
StarTeam Cross-Platform Client 50
StarTeam Layout Designer 70
StarTeam Server 15
StarTeam Web Client 56
StarTeam Web Server 56
StarTeam Workflow Extensions 73

T

TeamInspector
configuration 87
installation and configuration 82
installation upgrade 85
installing and creating Derby database 83
installing on Linux 85
installing on Windows 84
launching the dashboard 88
prerequisites 82
troubleshooting 89
uninstalling 88
upgrading using derby migration utility 86
what to expect during installation 84

U

unicode character sets
StarTeam Server 15–19, 33
uninstall 44
upgrading 13

W

WebSync 12
Windows authentication for SQL Server 95
Workflow Designer 72
works order number 12